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RAD-IT Help 
Version 9.2 – 11/20/2023 

 
This information in the online help format or as a document provides help on the use of the Regional 
Architecture Development for Intelligent Transportation (RAD-IT) software. RAD-IT is designed to 
integrate custom inputs with the database tools of the Architecture Reference for Cooperative and 
Intelligent Transportation (ARC-IT) so that users can develop custom regional ITS architectures in 
support of planning for ITS deployment. 
 

Support Services 
Our customer support team is standing by to offer friendly, responsive technical support to RAD-IT users. 
You can contact customer support via phone or email. To receive the best support, please have the 
following information ready before contacting us: 

• The version of RAD-IT that you are using (and whether it’s 32-bit or 64-bit), 
o Look at the splash screen when RAD-IT opens or open the File menu bar item and select 

‘About’ near the bottom of the navigation pane. 
• The version and name of your operating system, 

o On the Windows desktop click the Start button ( ), select Computer, then select 
System Properties on the navigation ribbon near the top of the screen to see your system 
version and name information. 

• A brief description of your problem or issue. 
 
Telephone (U.S.): (800) 260-1001 
Email: radit@iteris.com  
 

End User License Agreement? 
The RAD-IT software is provided by USDOT without fee and in an “as is” condition. There is no End 
User License Agreement (EULA) or Terms of Service associated with the RAD-IT software available on 
the ARC-IT website. Anyone interested in developing or maintaining a regional or project architecture is 
allowed and encouraged to download the software and use it.  
 
If you have further questions, please contact Cliff Heise at cdh@iteris.com or 703.623.6709. He is the 
Program Manager for the National ITS Architecture Program. 
 
 

What’s New 
With this release there are several new features as well as several problems fixed: 

- New “Service Readiness” output table that lists the relative readiness an architecture’s service 
packages for wide-spread deployment based on the collection of issues related to each of the 
flows in that service package.  NOTE: this can be a large complex output and may take a long 
time to generate. 

mailto:radit@iteris.com?subject=RAD-IT%20Help
mailto:cdh@iteris.com
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- RAD-IT Output Document Settings now support having multiple documents per RAD-IT file 
so you can have a document for your regional architecture as well as different documents for 
your project architectures. 

- The cursor will now indicate when outputs are being generated. This is most useful to know 
that the system is busy when building the larger complex tables  

- RAD-IT Document generation now recognizes when a template may be out-of-date or has 
some issues with the bookmarks used to generate the document and should be Restored using 
the Restore Template button on the Document Setup window. 

- RAD-IT now supports new class level physical objects and allows special level objects to 
inherit the characteristics of the higher-class level objects. For example, there is now a 
physical object called the “Vehicle” and another object called the “Light Vehicle Onboard 
Equipment (OBE)”.  As a user creates an element for a passenger car they will select the 
Light Vehicle OBE as the physical object or if they are defining an element for an equipped 
transit bus they will select the Transit Vehicle OBE. Under the covers, RAD-IT will also be 
mapping these elements to the new Vehicle object that will provide capabilities like basic 
safety, navigation, and information provision that any vehicle type will need. Conversion will 
automatically map the appropriate class-level object as needed for elements from older files. 

- Flow Alias is a way to show an alternative name for a flow on diagrams and in reports and 
outputs.  A new form with a button off the main menubar lets a user define and then apply an 
alias. Whenever the Alias is applied that alternative name will be used on diagrams. Both 
names will be listed on the Interfaces tab. 

- New Spell Check capability – gives the user the ability to manage a dictionary of what 
uniquely spelled words to include and which to ignore. Works across all data entry fields. 

- New capability on the Agreements tab to generate Joint agreements and map them to the 
elements that are jointly operated, owned, etc., by different stakeholders.  It also generates 
Joint agreements when the stakeholder involved is actually a Stakeholder Group. 

- New option on the Output Diagrams menu to Batch generate a diagram for each project 
architecture in your file. 

- Communications solutions will be retained when a user creates a user defined flow that is 
meant to replace an ARC-IT information flow. 

- Changes made to the Agreements AutoSelect function to support removing any agreements 
that are no longer needed based on the information flows defined in the current architecture. 
This also included several other usability enhancements, e.g., update the preview grid so that 
one can see the lengthy titles and descriptions of the agreements to be deleted. 

- Stakeholders are now automatically included in a Project when they are created at the same 
time a new element is created for that project. 

- The Batch Diagram output window in RAD-IT now indicates the number of diagrams that 
will be generated as a way to help with large architectures. If there are going to be too many 
diagrams, you may want to de-select some elements. 

- No longer get an error generating a Subsystem Diagram if your architecture included user 
defined subsystems. 

- A new output table lets you see a summary of statistics about your regional and project 
architectures. Look for the Architecture Summary Details table. 

- Use a Remote Access Device (new physical object in ARC-IT) to show when secure remote 
communications are being used by center and support system operators to access their 
center/support systems.  

- RAD-IT can now check to see if an update is available when the tool starts up or on demand. 
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- The columns on the Interfaces and Solutions tab can now be sorted more consistently. 
Clicking the top of a column will sort the table by that column and proceed to sort the others 
to the right of that column. 

- Diagrams can now include the coloring based on the class of the physical objects, similar to 
the colors used on the http://www.arc-it.net/ website, e.g. Blue for Vehicles, Orange for Field, 
etc. 

- Agreements can now be imported between RAD-IT and SET-IT. 
- There is a new Search button on the Needs tab to let you search for Needs to be included in 

your region/project. 
- The Autoselect button on the Services tab now includes options to maintain consistency with 

either the Planning tab or the Needs tab. 
 
As with each version you can open and migrate or convert architectures that were created in a previous 
version of Turbo or RAD-IT. The “Conversion” process as it is called will go through and update your 
architecture so that it works with the current features of RAD-IT. RAD-IT will produce a set of reports 
during conversion to tell you of objects that have been deprecated and replaced in the new version – 
usually due to an update to the ARC-IT reference databases. This report can be viewed / saved as a 
document or spreadsheet for analysis later on.  
 

Bugs Fixed 
This version corrects a number of defects in the previous versions including: 

- Issues related to conversion where Needs ended up having duplicate numbers 
- Errors during conversion for files with customized requirements 
- Issues related to physical object mapping on the Inventory tab for elements and the class-

level physical objects like vehicle or center. 
- Issues related to elements and the mappings to physical objects relative to certain service 

packages. 
- An error that some users experienced when creating a document output has been corrected 
- Error when generating the Flow Definitions output table no longer occurs. 
- Error when trying to Restore Defaults on the Output Web Page Setup File Locations form no 

longer occurs. 
- Fixed an issue with build in which user defined flows were being added to an architecture but 

were being set with a Not Applicable status. 
- Fixed an error that occurred when users imported certain architectures from one RAD-IT file 

to another. 
- ARC-IT Enterprise View data has been updated and imported so that default agreements are 

created on the Agreements tab based on the rules for how the stakeholders relate to one 
another in the selected service packages. For example, the owner of one system may need to 
have an information exchange agreement with the owner of another interfacing system. 

- Fixed the issue seen in larger architectures with long lists of project architectures or inventory 
elements where as soon as you clicked apply the screen would jump back up to the top of the 
list.  This saves some time when you just wanted to go to the next item in the list. 

- Fixed an issue in which user defined flows were being left out of some output tables. 
- Conversion not retaining connections between agreements and information flows shown on 

the Agreements tab. 
- Error generating a Subsystem diagram if your architecture had any user defined subsystems. 

http://www.arc-it.net/
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- Communications tab not selecting the correct communications solution or, in some cases, no 
solutions were being assigned, e.g., when a data distribution system (DDS) was being used as 
an intermediary or when the SU03 Data Distribution service package was included. 

o This also fixes an issue where older files used DDS for flows that are no longer 
eligible for data distribution based on the ARC-IT rules.  Review the Flow 
Conversion Details report to see how this affected your converted file. 

- Performance issue when working on the Interfaces tab for a project architecture.  For large 
complex project architectures it was taking 90 minutes to click to include or unincluded a 
flow.   

NOTE: It is still best to simplify the architecture as much as possible before getting to 
the Interfaces tab following the Tips and Guidelines for how to map elements to physical 
objects and include the appropriate elements in service package instances for your 
project. Then on the Interfaces tab a Moderate build setting will include the best set of 
flows to consider.  After the Build it should be simpler to edit the flows to include for 
your project. 

- Several fixes were made to the queries used during conversion to improve the accuracy of the 
converted architecture and prevent crashes seen during conversion of some older 
architectures. 
 

Be sure to upgrade for the latest features and better, more resilient performance. 
 
 
TIP: With database oriented tools like RAD-IT it is often best to run and save locally and then create 
backup files (zip) that can be saved/archived off to a network or cloud server for safe-keeping. 

 
NOTE:  The development of RAD-IT is continuing with new features being added frequently. When 
available you will want to download and install the new version in order to get the most up-to-date 
features. Be sure you exit RAD-IT and save your files before trying to uninstall RAD-IT and install the 
update.  
 
NOTE:  RAD-IT can only support 1 copy of RAD-IT on a machine at a time so if the installation script 
detects a version of RAD-IT on your machine it will uninstall it before installing the new version.  You 
will then be able to use the Convert feature to convert your older projects to match the schema and 
features of this new version. 
 
 

Known Issues 
There are a few issues based on different configurations or errors that happen on a sporadic basis that you 
may encounter. 
 

o Users of the 64-bit version of RAD-IT have noticed that Autoselect Agreements (one per 
stakeholder pair) can cause RAD-IT to crash in certain situations. The work-around is to make 
sure you have saved before using the Agreements tab and, try the operation again. If this persists 
try finding a machine with the 32-bit version of RAD-IT.  
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o Users may get an error generating outputs to Word or Excel that refers to ‘Interop’ in the error 

message. If this happens the solution is to close RAD-IT, go to the Control Panel and look for 
your Microsoft Office, click “Modify” and select a “Quick Repair”. Restart RAD-IT and it should 
generate outputs again. 
 
 

o If you are using a cloud-based or network based storage system like OneDrive or Drop Box that 
try to synchronize your local files over a network then you may get a message that you have a 
“Locked File Selected” and “The selected file appears to already be open in another application. 
Please close the other application so RAD-IT has exclusive access to the file.” If this happens, 
you can still close RAD-IT and your information is still stored. To avoid this message, go into the 
settings for the file sharing program, e.g. Drop Box, and pause synchronization until you are done 
generating the tables, documents, diagrams, or web pages. 
 
 

o Icons and buttons may disappear if there are a lot of programs running at the time or if RAD-IT is 
working with a very large architecture and system resources start to get constrained. This has 
been observed on the Add Interfaces window when the Yes button did not appear. Exit, (save 
your work), and restart RAD-IT and try again. This issue may also be related to Display Settings 
which can affect some windows if a setting other than 100% scaling is used on Windows 
computers. 
 
 

o Also related to very large architectures, some users reported issues with the Interfaces tab after 
converting very large architectures, well over 100,000 flows. As they were Un-Including flows 
they didn’t want on the tab after several clicks they would click Apply and get a “Concurrency 
violation” error. In these cases, doing a Conservative build to remove flows not included greatly 
reduced the size of the file/architectures and the errors didn’t recur.  
 
 

o Some users reported a situation where RAD-IT would stop whenever they tried to Save a file and 
a screen would appear saying “RAD-IT Stopped Working”. As of May 1, 2018 this has been 
determined to be an issue with the Microsoft Access Database utilities that RAD-IT makes use of 
during saves. The fix is to do the following steps outside of RAD-IT: 
 

o Open a Microsoft Access database: Either start Access and then select a database or 
just double-click on a database file. 

o From the File menu, select the Compact & Repair Database function. 
o Close Access 
o Restart RAD-IT 

 
o Occasionally, users with Microsoft 365 get errors trying to do an Output. The error might say 

something like “Unable to cast COM object of type ‘Microsoft.Office.Interop…’”  
Use the following steps to run a “Quick Repair” of Office and try again: 

o Close RAD-IT 
o Go back to the Control Panel 
o Look for Microsoft Office 365 or “365 Apps for Enterprise” 
o Click “Modify” or “Change” 
o Choose the “Quick Repair” option and click “Repair” 
o Afterward, restart RAD-IT; open the project again and try the output table again. 
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o Currently RAD-IT will not work if the executable files reside on a network drive. You may 

receive different error messages in these situations. You should be able to run if your executable 
is local and your saved data file is on a network though some users have reported that Cloud 
Services like Azure require an answer from the user before saving or opening RAD-IT files on 
that service. 
 

 

What is RAD-IT? 
Formerly known as Turbo Architecture, The Regional Architecture Development Tool for Intelligent 
Transportation, or RAD-IT, is a high level, interactive software program that aids transportation planners 
and system integrators, both in the public and private sectors, in the development of a Regional and/or 
Project ITS Architecture. RAD-IT is a planning and integration aid designed to facilitate usage of the 
National ITS Architecture, now known as the Architecture for Cooperative and Intelligent Transportation 
or “ARC-IT”. The application will utilize user inputs and information from the ARC-IT databases to 
provide users with tabular and graphical outputs comprising a high level representation of their Regional 
or Project Architecture. In order to more easily use the tool, it is highly recommended that the user of the 
RAD-IT application be familiar with ARC-IT. (This tool is not an introduction to or training aid for ARC-
IT. Look to the ARC-IT website for training on the architecture.)   
 
RAD-IT and its companion tool, the Systems Engineering Tool for Intelligent Transportation (SET-IT) 
are all based on the same ARC-IT databases. RAD-IT’s focus is on the development and maintenance of 
regional ITS architectures to support planning for ITS in a region and other long-range, region-wide 
activities. SET-IT’s focus is at the single project level – once a project is being scoped SET-IT can use the 
same ARC-IT reference architecture to define and build a customized project architecture. Now, both 
tools support the import of data from one tool to another. See the section on Importing a SET-IT Project. 
 

In General Terms 
RAD-IT: 

• Guides users through the design of a Regional or Project Architecture, identifying and extracting 
the required portions of ARC-IT.  

• Assists in local mapping and tailoring to a region’s needs.  
• Helps the user with potential conflict resolution between Regional and Project Architectures.  
• Provides a “jumpstart” toward architecture development and consistency with the National 

Architecture.  
• Is a standalone application.  

 
RAD-IT is not a complete end-to-end solution to fully develop ITS architectures. User and stakeholder 
interaction, gathering local needs and systems, a “Concept of Operations” agreed to by consensus, and 
extension of the resulting architectures will be required beyond the data, diagrams, and output tables that 
the tool provides, in order to meet the needs of the local transportation community. The local region may 
require queries of the data or outputs that are not part of RAD-IT. The Federal Highway Administration 
(FHWA) Code of Federal Regulations (CFR) 940 and the Federal Transit Administration (FTA) policy on 
Regional ITS Architectures and Standards requires various other documents and data. RAD-IT aids the 
user in gathering much of this additional information. 
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Feedback and consensus is required between the stakeholders during the creation of a Regional or 
Project ITS Architecture. The architecture is NOT complete simply by following the RAD-IT tabs, 
building the architecture, and printing the results. A great deal of customization may be required, 
including iteration of the steps in RAD-IT, selecting additional service packages, etc., in order for the 
interconnections and information flows between elements to be complete and correct. Stakeholders 
should be involved initially to attain consensus on the services (centers, data, equipment, and interfaces) 
that a project or region require. They should become involved in the process again as the Project or 
Regional Architecture is customized. 
 

What Can RAD-IT Do for You? 
This section discusses some basic topics about RAD-IT – users, their expectations, terminology, system 
overview, and a review of what makes a regional architecture. 
 

Who are the Potential Users of RAD-IT? 
Many types of agencies and personnel may find the RAD-IT tool useful. The following is an example of 
potential users of the tool: 
 

1. Local and state transportation agencies such as: 
a. Traffic Management Centers 
b. Transit Management Centers 
c. Emergency Management services deploying ITS in a region 

2. Metropolitan Planning Organizations – transportation planners 
3. ITS Architecture Deployment Workshop attendees 
4. Consultants developing Regional and Project ITS Architectures 

 
 

User Expectations 
The RAD-IT application can be used to generate Regional and Project Architectures. Elements may exist 
within each region that have already been deployed or are planned for the future, or an entire project may 
be labeled as planned for the future. The output tables and diagrams produced by the tool are able to 
distinguish between existing and planned architecture elements within a region or project. Within a single 
database file generated by the tool, there may be at most one Regional Architecture and/or zero to many 
Project Architectures. 
 
Architectures generated using the current release of the tool and ARC-IT databases are planned to be 
upward compatible with future releases of these databases and software. You need to be able to create an 
architecture today that represents the current transportation plan for a region, perhaps including certain 
elements that are known to be planned for the future (not budgeted or entirely defined today). You must 
then be able to return to this architecture in a year or two and move those planned elements to “existing”, 
flesh them out, and also create new (existing or planned) projects that will be added to the architecture for 
the region. The Regional and Project ITS Architectures are “living documents” for how communication is 
handled between various agencies and groups in the region. The database structure that has been 
implemented for the RAD-IT application makes this possible. 
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Definitions and Terminology 

Architecture, Uncustomized 
An uncustomized architecture is one which has been built via the “Build” button on the “Interfaces” tab in 
the RAD-IT tool, but no changes to element or information flow selections have been made, i.e., no 
tailoring of the architecture has been done yet on the “Interfaces” tab. 
 

Architecture, Customized 
A customized architecture is one in which element and information flow associations have been modified 
on the “Interfaces” tab in the RAD-IT tool. The flow status may be changed or the project association for 
a flow or interconnect may be deselected (i.e., in order not to display this flow or interconnect on the 
diagrams). 
 

Center 
Center elements are the primary Administration or Management “Element” in the region/project. This 
may often be a physical building (such as the Marinara County Freeway Management Center). 
 

Element 
This is the basic building block of a local regional or project ITS architecture. It is the name used by the 
stakeholders to describe an instance of one or more ITS physical objects. An element is defined by the 
name that is given to an instance of an ITS physical object (e.g., Caltrans/California Highway Patrol 
District 12 Traffic Management Center). An element is also assigned to a stakeholder. In addition to 
Transportation Elements like TMCs, RAD-IT supports Communications Elements (e.g., communications 
gateways and hubs). 
 

File 
The definition of an architecture is saved in a file. A file is also referred to as: 

• A database file 
• RAD-IT database file 
• RAD-IT file 

 
Within a single RAD-IT “file” (or database), you may define zero or one Regional Architecture and/or 
zero to many Project Architectures. 
 

Interfaces, Interconnect 
Communications paths that carry information between physical objects (subsystems and terminators) of 
ARC-IT and between elements of a Regional or Project ITS Architecture. Interconnects are directionless 
and contain one or more information flows.  
 

Interfaces, Information Flows 
Information flows define direction-specific information flow between ARC-IT physical objects and 
between elements of a Regional or Project ITS Architecture – such as “road network conditions” from a 
traffic management center to an emergency center. Forms the basis for the standardization of ITS 
interfaces.  
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Physical Object 
A physical object represents a system or device defined in the ARC-IT physical view, or a user defined 
(locally defined) object. In RAD-IT, each element is associated with a physical object. Physical objects 
are grouped into five classes: Center, Field, Personal Support, and Vehicle. Examples include the Traffic 
Management Center (TMC), the Vehicle Onboard Equipment (VOBE), and the ITS Roadway Equipment, 
corresponding to traffic operations centers, automobiles, and legacy ITS field equipment. 
 

Project 
A project is a set of ITS deployment activities grouped together (usually within a single procurement) for 
planning, deployment, and/or operational purposes. A project has defined boundaries within the context 
of a region. 
 

Project Architecture 
This term defines the elements and information exchanges of a single ITS project.  
 

Region 
A region is a geographical area spanning one or more jurisdictions. A region is a local decision. It is not 
necessarily bounded politically. It could be a state or multiple states, a metropolitan area or multiple 
metropolitan areas, one MPO or multiple MPO’s, a corridor (e.g., I-95 corridor), counties, rural towns or 
areas. 
 

Regional Architecture 
A regional architecture can be thought of as a regional framework for ensuring institutional agreement and 
technical integration for the implementation of ITS projects or groups of projects. It defines the elements and 
information exchanges of the many ITS projects existing or planned within a region. It should be a 
comprehensive organization of the region’s ITS. 
 

Stakeholder 
A stakeholder defines an organization or an institutional enterprise that owns, operates, or interfaces with 
the ITS elements in a region. 
 

Subsystem 
There are 59 subsystems – physical objects with defined functionality – that make up ARC-IT’s physical 
view and encompass all the functionality of ITS and are grouped into five classes: Centers, Field, 
Personal, Support, and Vehicles. There is an additional subsystem, ITS Object, that is defined to represent 
core capabilities that may be common to any class of object. Examples of subsystems include the Traffic 
Management Center (TMC), the Light Vehicle Onboard Equipment (OBE), and the ITS Roadway 
Equipment, corresponding to traffic operations centers, equipped passenger automobiles, and intelligent 
transportation devices at or near the roadside. 
 

System 
A system is a collection of hardware, software, data, processes, and people that work together to achieve a 
common goal (definition from the NHI System Engineering Course). NOTE that “system” is a relative 
term since many different types of systems fit this definition. To a sign manufacturer, a dynamic message 
sign is a “system”. To a state DOT, the same sign is only a component of a larger Freeway Management 
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System. In ARC-IT, a Freeway Management System is a part of the overall surface transportation system 
for the region. 
 

Terminator 
Terminators are physical objects that define the boundary of an architecture. In ARC-IT terminators 
represent the people and systems that interface to ITS. The interfaces between terminators and the 
subsystems and processes within ARC-IT are defined, but no functionality is allocated to terminators. 

NOTE:  Sometimes terminators are removed from ARC-IT. If you had an older architecture that 
included elements mapped to those physical objects they will be classified as “discontinued” by 
the conversion process. 

 
To continue the terminology discussion, a user begins by creating a database file to contain 
architectures. An architecture is composed of elements (centers, systems, vehicles, personnel, and 
roadside equipment, etc.) and information flows that connect the elements together. The elements are 
associated with physical objects (ARC-IT’s subsystems and terminators, and user defined physical 
objects), projects (the current project or other projects in the region), and service packages.  
 
 

System Overview 

RAD-IT Features 
RAD-IT is a Microsoft Windows based software product that uses the ARC-IT databases to aid in the 
development of a Regional and/or Project ITS Architecture. RAD-IT can convert existing RAD-IT 
databases of Regional and Project Architectures so they are consistent with the latest version of ARC-IT.  
 
The computer system requirements to use RAD-IT are fairly straightforward: 

• PC-Compatible  
• Operating Systems: Windows 8.1 and Windows 10 
• 200MB Free on Hard Drive  
• Minimum 1280X1064 Monitor Resolution  

 
As with any software product these minimal specifications may work but you’ll want more memory and 
processing speed to develop and maintain large, complex architectures. 
 
64-bit or 32-bit: RAD-IT offers a 32-bit version and a 64-bit version. It depends on what type of 
Microsoft Office suite you have installed. If you have a 64-bit version of Office or Microsoft 365 then 
you need to download and use the 64-bit version of RAD-IT. 
Language: RAD-IT has been modified to work in other countries that have different language settings. 
This should allow RAD-IT to be more language resilient but has not been exhaustively tested or verified. 
Save over a Network drive:  You can now save a RAD-IT file and open it over a network drive, 
including windows servers, network filesharing platforms like Drop Box and OneDrive. We still 
encourage users to use a local drive for better performance. You can zip and save your work to a network 
drive for later use and version control.  
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RAD-IT Capabilities 
The tool can be used to create a Regional Architecture, create a Project Architecture, modify a Regional 
Architecture, modify a Project Architecture, or update one based upon the other. The basic uses of the 
tool are to: 
 

1. Create a new Regional Architecture. 
2. Create a Project Architecture when no Regional Architecture exists. 
3. Create a Project Architecture when a Regional Architecture does exist.  
4. Update an existing Regional Architecture with a Project Architecture definition. 
5. Import a project to SET-IT. 

 

User Scenarios 
Using the four basic capabilities of the tool, there are several additional scenarios that the tool will 
support. Included below are some of these (this list is by no means all-inclusive): 
 

1. Create a Regional Architecture composed of many projects, some that exist in the plan for the 
current year, and some which may occur in the near or distant future for the region. 

2. Import a project from SET-IT. 
3. Bring multiple disjoint project definitions together in order to define a Regional Architecture. 
4. Create a multi-phase project, where part of a project is being developed currently, but other 

phases may occur in subsequent years. 
5. Create a two-tier or three-tier architecture. For example, several Regional Architectures are 

combined into a corridor or statewide architecture. 
6. Determine the ITS standards that may correspond to portions of a Project. 

 
 

What is a Regional Architecture? 
Regional Architectures may be built as a standalone architecture, or can be built around Project 
Architectures. As the name implies, a Regional Architecture is a description of a region that may be used 
for planning ITS projects and facilitating integration. It lists the functions, interconnections, services, 
stakeholders, how they communicate, and how they are all connected. Many diagrams and tables can be 
generated for later use by RAD-IT for the Regional and Project Architectures. 
 
If transportation services are represented by service packages and functions in ARC-IT and the Regional 
Architecture, then the functions plus interfaces indicate how the services are implemented. When a 
Service Package or ARC-IT physical object (subsystem or terminator) is associated with an inventory 
element or center in RAD-IT, many information flows are selected by the system and provide connections 
to and from the element in the Regional or Project Architecture. These indicate the interconnections for 
this element to the rest of the architecture.  
 
Regional ITS Architectures are becoming the link between planning and ITS standards, enabling project 
implementations to consider the standards based on the Regional ITS Architectures.  
 
 



20 

Approaches to Creating a Regional Architecture 

Architecture Definition Approaches 
There are two main approaches that may be used to define architectures using RAD-IT:  Top-down, where 
a Regional Architecture is developed and used as the basis for defining Project Architectures or Bottom-
up, where a set of Project Architectures is defined and then merged together into a Regional Architecture. 
There is a third approach where a Regional Architecture is built as a complete standalone entity. It does 
not include any Project Architectures. 
 
RAD-IT supports all of these approaches. In support of the top-down approach, a user may develop a 
Regional Architecture, then use portions of this architecture to define a single or multiple Project 
Architectures. The tool also supports the bottom-up approach by providing the capability to update a 
previously defined Regional Architecture with a Project Architecture. If no Regional Architecture exists, 
then this update capability can be used to create one from the projects defined in the database. 
 
Within a single RAD-IT “file”, the user may define at most one Regional Architecture and/or zero to 
many Project Architectures. Within a single database file, each Project Architecture corresponds to a 
single, unique project. The user may also create separate files to represent different regions, or different 
collections of projects (or phases of a project) within a single region. 
 

Architecture Creation 
The basic steps involved in creating a Regional or Project Architecture are: 
 

1. Gather the Initial Data  
2. Input Data (Inventory) 
3. Build an Uncustomized Architecture 
4. Customize the Architecture 
5. Generate Outputs 

 
 

Getting Started 
This section describes the data you need to collect before starting to develop a regional architecture and 
some tips for success. 
 

Gathering the Data You Need 
The following steps will help you to gather the data required to begin design of a Regional or Project 
Architecture: 
 

1. Interact with the stakeholders. Learn their issues and needs. 
2. Review the Transportation Improvement Programs (TIP), Statewide TIP (STIP), State 

Implementation Plan (SIP), Capital Improvement Programs, Long Range Plans, Congestion 
Management Plans, the Commercial Vehicle Safety Plan (CVSP) for project scope and timing, 
and other plans and studies to identify regional transportation priorities and implementation time 
frames.  
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3. Review the Regional ITS Architecture Definition pages of the ARC-IT website which describes a 
process for creating Regional ITS Architectures with supporting examples for each architecture 
product and discusses mainstreaming ITS into the planning and project development processes. 

 
In general, to effectively use RAD-IT, you will need a fairly complete understanding of the stakeholders, 
centers, elements, and services that are involved in the architecture you wish to develop. 
 

Suggestions for Success 
The following suggestions may help you get the most from designing an architecture: 
 

1. Gather the data for creation of your architecture(s). 
2. Install the RAD-IT software. 
3. Save intermediate backup versions of your architecture in files with different names, in case you 

need to return to them. RAD-IT includes a “Save As” feature that may be used to create 
checkpoints of an architecture in development. 

4. Keep all paperwork together for each Regional or Project Architecture. 
5. Organize the activity and personnel in a way that makes sense for your region. If you have 

multiple people involved in developing Project Architectures (which you later plan on merging 
into a single Regional Architecture), then it is best to develop a common set of terms for the 
element and stakeholder names. This will greatly facilitate the merge part of the process. (For 
example, do you call an element “City Transportation Management Center” or “City TMC” – the 
tool will interpret these as two different elements when you perform the operation to merge the 
projects into the Regional Architecture.)  The timing of the updates should be reviewed, and a 
process put in place.  

6. Keep communications open with the stakeholders. Review the architecture with them periodically 
during the development and at the end of the development cycle. Keep them involved. 

 
The following walks through a set of steps that illustrates simple usage of the tool. After installing the 
tool, the user starts the tool by double clicking on the “RAD-IT” icon on your Desktop, double clicking 
on the RAD-IT executable file in the directory where it was placed, or by selecting Start-> Programs-> 
ITS Architecture -> RAD-IT to run the tool.  
 
To create a new RAD-IT database file or open an existing file before opening an architecture, from the 
menubar pulldown, select “File => New” to create a database file, or “File => Open” to open an existing 
file. The first time into a new release of RAD-IT, the default directory is “My Documents”. If opening an 
existing database file, this directory must be changed to the directory that holds your architecture(s).  
 
The next thing the user needs to do is to create or open an architecture in this file. To create a new 
Regional ITS Architecture, select the “New” button in the “Regional” area on the Start tab. In the same 
manner, to create a new project ITS architecture, select the “New” button in the “Project” area on the 
Start tab. To open an existing architecture, select a name from the existing Regional ITS Architecture or 
the list of Project ITS Architectures on this window. 
 
 

RAD-IT File Extension 
RAD-IT is a stand-alone application. It does not require any other applications, or databases in order to be 
used. RAD-IT generates Microsoft Access-compatible databases, but it is not necessary to have the 
Microsoft Access software resident on the machine in order to run RAD-IT. Nor does RAD-IT require 
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any ARC-IT databases from ARC-IT web site. After bringing up the application, the “File => About 
RAD-IT” option on the main menubar displays the version number for the RAD-IT application, and for 
all portions of the ARC-IT that are used with that version of RAD-IT. 
 
RAD-IT includes support for the file extension, “radit” or “.tbo”, for legacy Turbo architectures. RAD-IT 
also accepts the “.accdb” extension when opening or converting older Turbo files. The “radit” or “.tbo” 
file may also be double clicked from a Windows Explorer window and the RAD-IT application is 
launched.  
 

WARNING: Although the “.radit” or “.tbo” extension does not completely prevent a user from 
opening a RAD-IT database using MS Access, which non-expert Access developers should never 
do, it is less likely that the user will want to do this and damage his RAD-IT file.  

 
TIP: Alternatively, the RAD-IT development team recommends only using the .radit database 
file in Access as a way to review or create custom outputs. Always create a copy of the database 
first and work with the copy in Access.  
 
NOTE: If a user tries to open an older turbo file created prior to 2000 when the older.mdb 
extensions were used they will get an error saying, “Failed to open workspace.” This is a pre-
2000 mdb format file that is no longer supported by Microsoft. You may also get an error if you 
try to open a database created before 2010. This is also due to databases that are no longer 
supported by Microsoft. 
 
In either case you will have to convert it to a newer format before you can open it with RAD-IT. 
Contact the help desk for more information. 
 

To work around this issue, use a 2010 or earlier version of Access to open and save the older 
database as an .accdb file: 

1. For ‘really old’ files (Access 97):  
a. Open the old database in Access 2003. 
b. On the Tools menu, click Database Utilities, click Convert Database, and then click to 

Access 2002-2003 file format. 
c. Enter a name for the database, and then click Save. 
d. Exit Access 2003. 
e. Open the database in Access 2013 or later version of Access.  
f. On the File tab, click Save As, select Access Database (*.accdb), and then click Save As. 
g. In the Save As dialog box, click Save. 

2. For files from 2002 or 2003:  
a. Open the old database in Access 2010. 
b. As it opens you will see a “Database Enhancement” window telling you that it was 

created in an older format and you need to convert it to ‘enable recent enhancements’. 
c. Say “Yes”. 
d. It may say an error was encountered and direct you to see a new table it created called 

“Conversion Errors”. There should be a single row in that table that says “The current file 
format no longer supports user-level security. The conversion or compaction process has 
removed any user-level permissions.” This is OK. 

e. On the File tab, click Save As, select Access Database (*.accdb), and then click Save As. 
f. In the Save As dialog box, click Save. 
g. You can now also copy that to rename it with a *.radit file extension so you can double-

click it to start RAD-IT. 
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When you use the tool to create an architecture, there will be a single RAD-IT database file created by the 
tool. This database will contain data tables, relationships, and elements for a single Regional Architecture 
and multiple Project Architectures. If a second Regional Architecture is to be defined, this must be done 
in another RAD-IT database file.  
 

Read Me 
A README file comes with each version of RAD-IT and is available from several places: 

- As a text box within the About screen that is part of the Project menu 
- As a text file that can be opened independently of running RAD-IT. Click the Windows Start 

button and scroll down to “I” for ITS Architecture and select the RAD-IT Read Me file. 

 
- From the ARC-IT website – https://www.arc-it.net/tools/raditreadme.txt 

 

Managing Database Files 
This section provides some technical information about the files and file structures used by RAD-IT and 
how to work with older files. 
 

Creating a New RAD-IT Database File 
To create a new database file in which new architecture definitions will be stored: 
 

1. On the menubar, select:  File => New 
 

2. If you already have an architecture database file open and have made changes, you will be asked 
if you would like to save the changes. 

 
3. A new blank architecture file will then open. The title bar of the main RAD-IT window will 

indicate that the file is “new”. 

https://www.arc-it.net/tools/raditreadme.txt
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Opening an Existing RAD-IT Database File 
To open an existing RAD-IT database file:   
 

1. On the menubar, select:  File => Open 
 

2. If you already have an architecture database file open and have made changes, you will be asked 
if you would like to save the changes. 

 
3. You will then be asked to select the name of an existing RAD-IT database file you wish to open. 

 
a. If the database file selected was created using the current version of RAD-IT, then the 

database will open. 
b. If the database file selected was created in an earlier version of RAD-IT, then you will be 

asked to convert the database or to open it without conversion. 
 
RAD-IT locks the files (sets them to Read-Only) so you can’t have a conflict where one application 
writes data that the other application is also editing. If you try open a file that is already open you will get 
a warning message that the file is in use by another program and to close the other program and try again. 
 
 

Opening a Prior Release RAD-IT Database File 
You may open an architecture database file created in an earlier version. When doing this, the software 
automatically detects that the architecture was created in a prior release. You will be asked if you would 
like to open or convert the database to the current version of RAD-IT. 
 

 
 
If you choose to simply open the database without conversion many of the current capabilities, including 
new services, interconnects and information flows will not be available. The Communications tab will 
also be blank since no solutions will have been selected yet. This Open option will also provide a read-
only version. See “General Information Concerning the Conversion Process” for some reasons why you 
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may not want to convert the database though for the most part you will want to use the Convert File 
option. Open File is only useful for browsing an older file but not to work on it.  Note that even Open will 
change the file. It has to do this in order to put the database tables into the right schema in order to be read 
by the current version of RAD-IT. 
 
The “Conversion” process migrates existing Regional or Project Architectures and database files created 
with prior releases of RAD-IT up to the current release of the software. Selecting to convert begins the 
automated conversion process. A series of screens is displayed checking off the steps of the process, and 
asking certain questions about how the process should proceed. 
 
 

Saving a RAD-IT Database File 
1. To save an open file, on the menubar, select:  File => Save. This will overwrite the previous 

version of the database in the same directory where it was opened.  
 

2. If “what-if” scenarios are being tested and several versions (checkpoints) of a database and its 
architectures are to be saved (for “what-if” testing or archival purposes), on the menubar, select:  
File => Save As… 

 
A window will appear asking you to select a name of the new RAD-IT database file. You may select an 
existing file and will be warned that the file will be overwritten. 
 
NOTE: If you are using a cloud-based or network based storage system like OneDrive or Drop Box that 
try to synchronize your local files over a network then you may get a message that you have a “Locked 
File Selected” and “The selected file appears to already be open in another application. Please close the 
other application so RAD-IT has exclusive access to the file.” If this happens, you can still close RAD-IT 
and your information is still stored. To avoid this message, go into the settings for the file sharing 
program, e.g. Drop Box, and pause synchronization until you are done working with RAD-IT. 
 
 

Exiting from a RAD-IT Database File 
1. To exit from the RAD-IT tool, select:  File => Exit or click the X in the upper right corner of the 

RAD-IT window. 
 

2. If changes made to Regional or Project Architectures in the database file have been saved this 
command will simply exit from the tool. 

 
3. If changes have not been saved a window will appear asking if you wish to save the changes.  

 
 

AutoBackup 
Another project management feature is called AutoBackup. You can enable this to periodically make a 
backup of your project’s files. This has the effect of making a copy of your project’s files that you may 
need if there is a problem and you need to start over from a certain point. For example, if you mistakenly 
made the wrong changes to a project and had already done a Save. This will let you go back to your last 
backup and restart your work.  
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The settings to manage how often, how much, and where the backups are stored are also found on the 
Project / Options menu – look for the AutoBackup tab. 

 
 
The settings let you assign a specific folder to keep all of your backups in or it will put them in your 
architecture’s current folder. When the backup routine runs it creates a compressed or zipped file and 
adds a date/time stamp to the filename and uses a unique file extension, “.raditbkp”. This file type can be 
opened by any file compression software. 
 
You can change the interval, or how often backup will run; every time you do a Save or when opening the 
file.  
 
AutoBackup will backup the database and the log file associated with your RAD-IT architecture.  
 
TIP: one useful purpose of this backup file may be to have a ready copy of your data to send to a 
coworker or to the RAD-IT Help Desk in case you have a problem. If they can see your database 
alongside the log file they may be able to recreate your issue quicker and find a resolution.  
 
As the note says on the screen – the backup is created as soon as you click the ‘Save’ button but just 
before the changes are actually saved to the database. This means the backup does not include the latest 
changes that are about to be saved.  The idea is to make a snapshot of your project just before you hit save 
at whatever stage you were at.  This may come in handy in the error/problem scenario. 
 
The settings for AutoBackup also let you set how many backups to keep. Over time the files can really 
add up so you may want to limit the number of backups it keeps. 
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File Sizes & the Temp Files 

Save Your Work Often 
Data is only saved when you choose the “Save” or “Save As…” options (or when you exit the file and 
save). All work you do between saves is put into a temporary file. As you work this temporary file grows 
in size. If you wait too long to exit and save, this file can grow so large you may not be able to save it.  
 
In order to actually shrink the size of the temporary file while working with large architectures, you must 
save periodically or exit RAD-IT. Applying changes isn’t enough as that places new work in the original 
user file in compressed format, but the temporary file remains at the same size and keeps growing. To 
shrink the temporary file, the database file must be saved.  
 
You may notice an error message popup warning you that you are about to exceed Microsoft’s file size 
limit and to save/close your file. 

 
 

RAD-IT Crashed and I Forgot to Save! 
If the tool should fail with unsaved data, you may be able to partially recover. Look for the temporary file 
in the Windows “temp” directory (e.g., C:\Users\<logon id>\AppData\Local\Temp). Rename this file to 
end in “.radit” and then try opening it with RAD-IT. See the release notes for more hints on how to 
correct this problem if it happens. 
 
A utility in the RAD-IT Options Menu item provides a way to find and recover these temporary files. 
Click on “File” and “Options”. From there click “Advanced”: 
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If you need to find a temporary file in order to restore it click “Path” and it will open the system file 
folder that contains the temporary files. 
 

 
 
From this folder you can copy the temporary copy of the .radit file and re-open it in RAD-IT. You may 
not be able to recover all of your data but in most cases most of your data will be preserved here. 
 

Other uses of the Temp Folder window 
Clear – One quick way to reduce the size of the temporary files is to click the “Clear” button. That will 

instantly erase any but the file currently being used by RAD-IT. 
Export – Sometimes you may encounter a situation in which you need the help of the RAD-IT support 

team to fix your file or to find out what is wrong with RAD-IT. For some situations they may ask 
you to send them your temp files so they can help isolate the problem and debug any errors in the 
data or software. In this situation, click Export to create a zip file of the temporary RAD-IT files 
that you can email to the team.  
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Open a Sample File 
Use the Sample File as a way to learn how to use RAD-IT’s features and to see a sample that includes a 
basic set of objects and interfaces that are likely to be common in many ITS architectures. 

 
 

Opening and Saving the Sample File 
Clicking on the Sample File option from the File menu, brings opens the sample database called 
Marinara.radit. All the tabs will have information populated for a region and 4 projects. 
 
You can save your own copy of this file for later by clicking Save. Since the copy of the sample file was 
stored in a read-only area you will see a window that is like the Save As window and allows you to save 
this sample as your own project into your own file folder. Use this window to choose the file folder and 
the name for the file. 
 
Now you can edit the file, add to it, change the names to match your own, or just review or print out 
portions of the sample file to better understand how RAD-IT works and how to build a regional ITS 
architecture. 
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More on the Sample File 
The sample’s file name is “Marinara” and once it is open the longer name for the region appears as the 
“Marinara County” regional ITS architecture.  
 
This sample architecture originated as an exercise in the National ITS Architecture Public Sector Training 
Course. It illustrates many of the RAD-IT features. It can be used to highlight features of the tool as well 
as part of ARC-IT that merges traditional ITS concepts with connected vehicle technologies and 
supporting services. To this end, several minor extensions have been made to the basic Marinara County 
scenario so that features like user defined Physical Objects, Flows, and connected vehicle service 
packages can also be illustrated. 
 
Use this sample as a starting point for your own regional or project architecture or simply to refer to how 
these support concepts are shown. Each tab is populated to show how they can be used. 
 
Marinara includes the following features: 

 Connected Vehicle as well as traditional ITS services 
 Use of Element Instances in the project architectures 
 Use of Communications elements – Data Distribution and Wide Area Information 

Dissemination 
 Support services such as Security Credential Management, ITS Communications Support, 

and System Monitoring 
 User Defined Physical Objects and User Defined Flows 

 
The current version of RAD-IT now includes all of the service packages, physical objects, and 
information flows as part of ARC-IT which is the new name for the National ITS Architecture. ARC-IT 
v8 and higher includes merged content from both version 7.1 of the National ITS Architecture and the 
Connected Vehicle Reference Implementation Architecture (CVRIA) so they can be included in your own 
project just like other ITS or connected vehicle applications defined in the Architecture. 
 

RAD-IT Options 
RAD-IT has an Options menu that is accessible from the File menu. At the top left of the RAD-IT 
menubar, click “File” and go down to Options. 
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The Options menu has 4 categories: General, Event Log, Advanced, and AutoBackup. 

General Options 
The General category lets the RAD-IT user set the default directory for new architectures. Use the 
Browse button to navigate your file system and select the directory or folder that will be used as the 
default starting point when you Create, Open, or “Save As” a region or project file.  
 
Current File Settings: used to set the Applicable Regions for the information to be included in your 
project. Choose from Australia, Canada, the European Union (E.U.) or the United States (U.S.) to 
determine what objects, flows, services, communications solutions, etc., are made available to choose 
from as you build your region/project.  
 
For example,  

• Select US and EU as input sources on the Settings screen  
• On the Service Packages tab RAD-IT displays services that come from EU or US only. So an 

Australian-unique service, for example would not make the list (you may notice a gap or 2 in the 
list of service packages) 

• Select the service packages to include and RAD-IT will only show the physical objects, 
functional objects, flows for those services that are relevant to the US or EU. 
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These settings are also used as you create user defined flows, physical objects, and functional objects. As 
you create those components they will be stored in the database as having those applicable regions. Later, 
if you change the settings to display components from another region those components will not be 
shown. 
 
Physical Object Visibility: RAD-IT now supports new class level physical objects and allows specialty 
level objects to inherit the characteristics of the higher-class level objects. Previous versions of RAD-IT 
included Center and Field physical objects so now there are Vehicle and Personal class level objects. 
These class-level physical objects will be invisible to the user unless they choose to show them using the 
Options window.  In order to see those class level objects, go to File / Options and check the checkbox to 
“Show class level physical objects”.  
 
 

Event Log Options  
This screen includes options to turn on/off an event log utility that can be used for debugging errors 
caused by RAD-IT or issues in a projects database or diagrams. There are 2 sections: 
 

• Enable Logging is a checkbox to first turn on the logging capability. Then there are check boxes 
for the type of error sources to trace: database, diagram, exceptions, form details, shape 
properties, other. There are pull-downs for each of Information or Verbose.  

TIP: It is a very good idea to check this box. If you run into problems or you have a 
strange error message pop-up, the RAD-IT development team will be able to diagnose 
your problem more quickly if you have this enabled. 
NOTE: The Trace Sources settings can only be changed if you are running as an 
Administrator on your computer. Many users can do this when they start RAD-IT from 
the program menu or the desktop. Right-click on the RAD-IT icon and select “Run as 
Administrator…” 
  

• Log File – allows you to browse and set the location for the log file to be stored. It will be created 
in the form of a normal text file. The default path is the same file path of the current project. You 
can also set the maximum size of the file. When it reaches the maximum it will create a copy and 
start another file. If it reaches the maximum again then the first file will be copied over. File 
information tells you when the log file was created, modified, or last accessed. 

 
NOTE: There is another log file used to capture ‘Start-Up’ events that happen when a 
program is started but before a project has been opened or started. This Start-Up Log File 
is stored on your PC under C:\Users\<username>\AppData\Roaming\Iteris, Inc\RAD-IT\. 
A subfolder is created for each new version of RAD-IT and the file is called “RAD-
IT.log”. 
 
TIP: An easy way to find the Start-Up log is to start RAD-IT and select Project/Options 
before you open a project. Go to the Event Log tab of the Options window and click “Log 
Path” and it will open that directory in a Windows Explorer window. 

 

 Advanced Options  
This screen includes options to set the Temporary folder. This lets you see the path to the files that 
contain copies of the temporary databases and log files in case you have a crash or other bug. You can 
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click Export to move the files for offline analysis or you can Clear the files to make room on your hard 
drive. 
 

 
 
Under Database Access Options, you can change the maximum number of File Locks used by the 
Database Access Operations.  Change this only if you are having issues with system resource errors. 
 
The RAD-IT Update options allow you to manually check the National ITS Architecture website, 
www.arc-it.net to see if there are updates available for RAD-IT. The checkboxes here give you to option 
to show messages at the bottom right corner of the main RAD-IT window or to Check for updates during 
start-up.   
 
 

AutoBackup Options 
Another project management feature is called AutoBackup. You can enable this to periodically make a 
backup of your architecture. This has the effect of making a copy of your file that you may need if there is 
a problem and you need to start over from a certain point. For example, if you mistakenly made the wrong 
changes to a project and had already done a Save. This will let you go back to your last backup and restart 
your work.  
 
The settings to manage how often, how much, and where the backups are stored are found on the File / 
Options menu on the AutoBackup tab. 
 

http://www.arc-it.net/
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Accessibility Features of RAD-IT 
This section describes some features of RAD-IT that make it easier to use by all users. 

General Information about RAD-IT 
In RAD-IT, Accessibility features are supported for compatibility with Section 508 of the Rehabilitation 
Act of 1973, the Standards for Electronic and Information Technology section. These features include the 
following: 
  

1. Keyboard Shortcuts for all menu, toolbar, and form commands. 
2. Accessibility Information in this Help resource (all figures include alternative text). 

 

Keyboard Shortcuts 
There are several ways in which to access RAD-IT options and pulldown menus for accessibility without 
using a mouse. Many options include a “CTRL + <letter>” shortcut to perform a RAD-IT option. These 
are listed on the pulldown menus. For example, “CTRL+S” to save a file, appears next to the “File => 
Save” option on the pulldown menu. The “ESC” key acts as a cancel button. 
 
Another shortcut method that may also be used in, is by using the “ALT” key. After pressing the “ALT” 
key, the menubar appears with the first character (in some cases it is another character) of each pulldown 
menu underlined. You may then type the underlined character for the menu and option that you are 
looking for, such as, “ALT” key, “F” for the “File” pulldown, then “O” to open an existing architecture. 
Case is not important and the “ALT” key does not have to be held down while pressing these other keys. 
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You may also press the “ALT” key and the underlined letter (press at the same time) for each of the tabs 
across the top of the RAD-IT main menu, or press “ALT > s” (“Start” tab) then the right and left arrows 
to move between the tabs. For example, “ALT > i” will display the “Inventory” tab. Then it is a matter of 
pressing the right, left, up, and down arrows, as well as the tab right and left (“Shift > Tab”) keys to move 
between the list of Inventory items and the options and tabs on the right of this screen.  
 
On several tabs throughout RAD-IT, clicking the Right Mouse button will expand a list of objects. For 
instance, on the Inventory tab, right-click over the list of Physical Objects and the list will expand. It will 
also show the description field for the object you highlight. To go back to the original size list just do 
another Right-Click. This works on several places including the Stakeholders list for groups of 
stakeholders, projects on the Inventory and Services tab, and agreements on the Agreements tab.  
 
The “Interfaces” tab works a little differently. The tab and arrow keys will move down the list of 
information flows and to the options at the bottom of the window, but they do not move to the options at 
the top of the window (“Connects”, “Flows”, etc.). This is a known problem with the third party tool that 
is used to generate this screen. Hence, all of RAD-IT and the documentation is compliant with Section 
508 except for the toolbar on the “Interfaces” tab. 
 

Toggle between Open Applications without Using a Mouse 
When using an application such as RAD-IT, you may toggle between open applications in Windows that 
appear across the task bar (generally at the bottom of the screen) without using a mouse. There are two 
ways to navigate between open applications: 
 
1. Use the “ALT > TAB” keys: 

a. Enter any window, tab, or option in RAD-IT. If you have selected a menubar option and see 
the pulldown menu, you must select an option on this menu. The pulldown menu itself will 
not remain visible when the “ALT > TAB” keys are pressed. 

b. Press the “ALT > TAB” keys at the same time. 
c. A small navigation window pops up. This window includes an icon representative for each 

open application. 
d. While holding the “ALT” key down, use the right “Tab” and “Shift > Tab” keys to move 

between the open applications. One of these applications is an icon for RAD-IT. If selected, 
RAD-IT remains active. If another application is selected, such as a Windows Explorer 
window, this screen pops in front of the RAD-IT window. 

2. Use the “ALT > ESC” keys: 
a. Enter RAD-IT. 
b. Press the “ALT > ESC” keys at the same time. 
c. While holding down the “ALT” key, keep pressing the “ESC” key. This will toggle between 

the open applications without reliance on the “ALT > TAB” navigation window.  
d. The main difference is that with “ALT > ESC”, the application windows must actually be 

active (click on each window to maximize it). If “ALT > ESC” is attempted when an 
application window is minimized, it will not come up. 

 

Display Settings 
NOTE: sometimes you may notice differences in the way the text on some buttons looks or labels for 
different columns. This may be caused by a Display Setting that some Windows users do called Font 
Scaling. RAD-IT attempts to scale the appearance of text as well as other Windows programs but when 
users select 125% scale or greater then they may occasionally see some differences, e.g. some button 
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labels may be truncated or letters will run together. If this happens try adjusting the Display Settings to 
100%. 
 
 

Converting from Prior Releases 
RAD-IT Version 9.0 was developed specifically to support version 9.0 of the National ITS Architecture, 
now referred to as ARC-IT. An important facet of this support is the “Conversion” tool that allows users 
to quickly and easily upgrade their existing architectures to use the latest version of ARC-IT. This utility 
does much of the “heavy lifting” that is required to convert a regional or project ITS architecture so that it 
is uses Version 9.0 of ARC-IT. 

General Information Concerning the Conversion Process 
The following are several items of general interest concerning the “Conversion” process. 

1. Some of the features of the latest version of the RAD-IT software are not available to previous 
version databases unless the database has been converted. 

2. If a customer site has not yet upgraded the RAD-IT tool from previous versions, RAD-IT will 
automatically upgrade an older version database to make it compatible with the latest version. 
You will notice an additional dialog box that will be displayed showing that the earlier version 
“database compatibility upgrade” is in progress. 

3. All user-defined extensions will be carried forward into the current version of RAD-IT. In special 
circumstances, where a user defined Physical Object or flow happens to exactly match a new 
ARC-IT physical object (subsystem, terminator) or information flow, the user-defined extension 
will automatically be converted to the equivalent ARC-IT Physical Object or flow. These are duly 
noted in the conversion output tables. In every case, the interfaces defined will be carried forward 
into the new database. 

4. During the conversion from a prior release RAD-IT database file, all system tables and 
configuration information are maintained. The conversion software copies all user data from 
source to destination and also copies any old system data that is referenced in your architecture.  

5. Sometimes one information flow is replaced with another automatically during the conversion.  
6. RAD-IT can open and use architectures that are based on current and previous versions of ARC-

IT. It will detect when a previous version architecture is opened and ask if you would like to 
convert the architecture. If you choose to open the architecture and not convert it, RAD-IT will 
work with the older architecture in a Read-Only format – not recommended for any editing of the 
architecture.. You may return to the older version architecture at any time. RAD-IT automatically 
preserves the original file.   

 
NOTE: Opening an older pre-2000 mdb format file may yield an error because it is no 
longer supported by Microsoft. You will have to convert it to a newer format before you 
can open it with RAD-IT. Contact the help desk for more information. 

 
7. If upgrading the tool to the latest version of RAD-IT, then the question arises of whether to 

migrate architectures developed with prior releases.  
a. It is recommended if you are actively working on a particular architecture coordinate the 

decision to upgrade to avoid incompatibility issues. The upgrade should be done at the 
same time for all architectures and database files within the project, and should be timed 
so as not to interfere with the development schedule.  

b. If the new features of ARC-IT are not necessary for the current project, perhaps the 
upgrade can wait until after the project is completed. However, if the new architecture 
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features are required in the architectures under development, the upgrade should be 
coordinated sooner rather than later. 

c. If you are in the middle of developing a Regional Architecture, the decision to upgrade 
depends on the situation. Here are a few pointers. RAD-IT provides a conversion feature 
that makes the conversion to support the latest ARC-IT version quick and easy – a basic 
conversion can be done in a few minutes, even for a large architecture. What must be 
considered is where you are in the process, how the conversion will impact work 
products that have already been delivered, and how the conversion will impact 
stakeholder reviews and consensus work that has already been performed.  

d. If the Regional Architecture has not yet been developed to the point that interfaces have 
been reviewed with stakeholders, then it is probably best to upgrade RAD-IT and convert 
to the latest version of ARC-IT so the stakeholders invest their time in reviewing the 
latest interface options. If the stakeholders have already invested time in reviewing 
interfaces, and the architecture is close to “final” publication, then it is probably best to 
wait and address conversion as part of future architecture maintenance activities. 

8. As for the new version of the ARC-IT, the “What’s New” section of the http://www.arc-it.net/ is 
the best source of information. This web site provides a list of the changes and a list of all 
physical objects, service packages, and information flows that were impacted. RAD-IT also 
provides special conversion tables that identify all impacts to subsystems, terminators, service 
packages, needs, functions, information flows, and standards mapping. As part of the conversion 
process, other tables are available that list the differences between the older RAD-IT and the 
converted architecture. 

9. Agreements from older Turbo files will be copied into the new RAD-IT database but the Type 
field will not be converted. In Turbo the type field was a text field but with RAD-IT it became a 
pull-down to select from a pre-defined set of Agreement Types. If a Turbo user had agreements 
listed then they will need to manually go through and pick the most appropriate type manually. 

10. In ARC-IT version 9.0 the Parking Management System physical object was split into 2 objects – 
a field-class Parking Area Equipment object and a center-class Parking Management Center. 
During Conversion if there was a Parking Management System element it will be mapped to both 
the new physical objects. Afterward, you may decide that you need another element or that your 
element is more related to one versus the other object and so you can adjust your mappings after 
conversion. 

11. Conversion looks for and updates any duplicate need numbers within the same need area and 
architecture. It fixes all duplicate numbers, including ARC-IT as well as user defined needs. 

 
 

The Conversion Process from a Previous Version of RAD-IT 
The following details the conversion process of a prior release architecture file to the current version of 
the software: 
 

1. Begin the conversion process by selecting “File => Open” for a database file from a previous 
release of RAD-IT. 

 
2. Select the file and click “Open” to open the file and begin the conversion process, or “Cancel” to 

cancel the conversion.  
 

3. The RAD-IT software will detect that the selected file is from a prior release of RAD-IT and that 
conversion is an option. The next window will ask if you would simply like to open this file and 
view it as is, maintaining all previous version elements, physical objects, and information flows, 

http://www.arc-it.net/
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or if you would like to convert the file so that it uses the latest version of ARC-IT. “Convert” is 
selected by default. 
 

 
 

a. Select “Open File” and “OK” to simply open the file using RAD-IT without converting 
just to see what the older architecture looked like and perhaps answer a question that a 
user might have about the older architecture. It will still need to make some changes to 
the database in order for RAD-IT to work and be able to ‘see’ the older architecture. You 
may see warning messages during the Open process about fields not included. After 
opening the older file you will see a red box at the top of the screen saying “OPEN 
ONLY MODE” and the Save buttons have been disabled. 
 
CAUTION: “Open File” is not recommended for use of RAD-IT because changes 
cannot be saved. If you want to make any changes to anything in the older architecture, 
use the Convert option and then you can save the changes. 

 
b. If you wish to convert the file, select “Convert File” and “OK” to begin the conversion. 
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4. The next window asks you to select a destination file. The existing file is NOT replaced. It still 

exists in the original format at the end of the conversion process. Click “Save” to begin the 
conversion process, or “Cancel” to exit from the process. The software will warn you if an 
existing file name is selected. 

 
5. The conversion will have to run to completion although you will be allowed to cancel out at 

different points during the process. You will be kept apprised of the progress and will be given 
the option to display, export, and print conversion tables during the conversion. The next screen 
reports the conversion progress. As each step in the conversion task list is completed, it is 
checked off and the pointer moves to the next step.  

 
6. At the “View Tables” Step, you may display tables about the conversion, detailing both the 

differences in the two files, as well as the differences between the ARC-IT Versions. You may 
review the changes that have been made during the conversion and save a record of these changes 
for future reference. This is the only opportunity to view the conversion tables. If these tables are 
needed later, do not delete the original file. You may need to run the conversion again in order to 
see the tables a second time. The tables may also be printed or saved. As with the standard RAD-
IT tables, the conversion tables can be customized to include or order by different fields and 
allows you to save the file or open it in Word or Excel. 

 
NOTE:  Physical Objects and flows that have been “discontinued” in the current version will appear 
with an asterisk (*) after the flow name in the output tables. 
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NOTE:  In versions 8.0 through 8.3, environmental type terminators such as traffic, vehicle physical 
characteristics, or pavement conditions were no longer represented in ARC-IT. If you had an older 
architecture that included elements mapped to those physical objects they will be classified as 
“discontinued” by the conversion process. Some of them have been reintroduced in version 9.0 so you 
can re-map them to the new environmental physical objects on the Inventory tab after conversion. 
Say, No, when it asks if you want to remove discontinued objects at the end of conversion. Otherwise, 
it is always best to say Yes to remove the discontinued objects from your architecture. 
 
NOTE:  Service Package instances may be renamed if they still had the default name created by 
previous versions of Turbo, e.g. “ATMS01 Network Surveillance (Instance 1)” to use the new name 
and number “TM01 Infrastructure-Based Traffic Surveillance (Instance 1)”. If you have customized 
the names then those will be retained. 

 
7. The final conversion window asks if you wish to delete “discontinued” physical objects and flows 

from the original architecture. These are subsystems, terminators, and information flows that have 
been deleted (perhaps completely deleted, or split into other physical objects and flows) in current 
version of ARC-IT. Select “Yes” or “No”.  

 
a. If discontinued flows are not deleted during the conversion, they will remain in the converted 

architecture, and will be marked with an asterisk (*) in the database and in tables as 
discontinued.  

b. These flows may be viewed on the conversion report titled “Discontinued Flows”. This report 
can be displayed during the conversion, or with the other standard RAD-IT tables available 
on the “Output => Tables” pulldown menu. 

c. Discontinued flows can later be changed to user defined flows under the “Tools => Add 
Flows” option. 

 
8. The “RAD-IT File Conversion” process step window remains displayed after you have selected 

to keep or discard discontinued flows, saying that the conversion has completed successfully and 
tells you that you should now do a “Build” on the Interfaces tab to add the latest flows to your 
architecture. Click “OK” to complete and exit from the conversion. The converted database is 
now open and available for editing. 

 
9. Go to the Interfaces tab and do a “Build” to add flows to the tab and/or to your architecture. 

 
10. Save the newly converted file. 
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List of Conversion Tables 

    
 

Conversion Results:   
The Output Tables that may be displayed during the conversion process include the following: 
 
Conversion Summary: This report illustrates information about the source and destination RAD-IT files, 
including version information, source and destination file names, and a list of the architectures that were 
converted.  
 
Element Mapping Conversion Details: This report identifies the changes that were made to the mapping 
between elements and physical objects in the converted architectures. All mappings between architecture 
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elements and the ARC-IT Physical Objects (subsystems and terminators) are listed by the change 
represented – new, modified, replaced, discontinued, including the old and new Physical Object names 
where applicable. This report identifies the physical objects that were added, deleted, and renamed, along 
with the elements that are impacted by the changes. This report might be a couple of pages in length for a 
large architecture. The report shows new element mappings that were created, existing element mappings 
that were replaced, and any user defined physical objects that happened to match and were converted to 
ARC-IT Physical Objects during the conversion. This will also show additional mappings for class-level 
objects like Vehicle, Personal, Field, and Center physical objects so that elements can inherit the higher-
level capabilities of those class-level objects.  
 
Functional Requirements Conversion Details: This report identifies changes made to the requirements in 
the converted regional or project architecture. In version 8.0, 8.1, and 8.2 there were no requirements so 
this report may not show any changes. However, for an old Turbo architecture, version 3 through 7.1 it 
will list the changes to the requirements for each element based on the underlying changes to the physical 
object and services mappings. 
 
Flow Conversion Details: This report identifies specific information flow level changes that were made to 
the converted Regional and Project Architectures. This report lists the new information flows between 
elements, as well as the flows that changed names due to updates in ARC-IT. This report identifies all the 
information flows that were added, deleted, and renamed by the conversion. This will be a long (10s of 
pages) report for a large architecture. Similar to the previous conversion details report, it shows new flows 
that were added, existing flows that were replaced by new flows, and any user defined flows that 
happened to match new ARC-IT information flows and were converted. Conversion replaced all 
parenthesis from flow names because that would conflict with an alias name and the actual information 
flow that would appear in parentheses on the outputs. 
 
Discontinued Flows: This report shows the discontinued information flows that are still included in the 
converted Regional and Project Architectures. This simple report shows all discontinued flows that 
remain in the architectures after conversion. If you choose to keep these flows, they can be edited 
individually on the “Interfaces” tab. This report also appears in the list of standard RAD-IT output tables. 
The “Interfaces” tab lists discontinued flows, user defined flows, and ARC-IT information flows, and 
distinguishes between them by using an asterisk for discontinued and National ITS Information flows if 
the database has been converted. The “Info” form (under “Interfaces” flows view) also distinguishes 
between the three types of flows. 
 
User Defined Physical Objects and Flows: This report identifies all user defined physical objects and 
flows in the converted Regional and Project Architectures. This report allows you to review user defined 
physical objects and flows since some of these could be converted into new ARC-IT Physical Objects or 
flows. Note the last column, where the conversion may actually convert user defined physical objects and 
flows into equivalent ARC-IT Physical Objects and flows, yielding a “user defined” flow that actually 
consists only of ARC-IT Physical Objects, but not in a way defined by ARC-IT. During the conversion, if 
the software determines that there is a name conflict between user defined and ARC-IT flows and 
Physical Objects, you will be notified and the ARC-IT flow or Physical Object always takes precedence. 
These are also noted in the conversion output tables.  
 
 

ARC-IT Changes: 
Version 9.2 Physical Object Changes: This report identifies all subsystem and terminator changes. All 
physical objects are listed by the change represented - new, modified, replaced, discontinued, including 
the old and new name where applicable. This report is based only on ARC-IT and thus will generally be 
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the same for each user who runs it during the conversion. The report may be longer if the original 
architecture was based on an older version of the National ITS Architecture.  
 
Parking changed in version 9 to include 2 parking physical objects – Parking Management Center and 
Parking Area Equipment, a field class object. If you had a parking management system in your older 
architecture, Conversion will map your old element to both the new Parking Management Center and the 
field based Parking Area Equipment. You may need to edit your architecture after conversion depending 
on if your parking element is more center based (back-office reservations, scheduling) or field based 
(occupancy monitoring, signage, etc.). And you may need to create a new element if you think you need 
to represent both aspects – center and field – in your architecture.  With 9.2 a similar change was made 
for Electric Charging; there is now a management center in addition to the field-based charging 
infrastructure. 
 
Version 9.2 Service Package Changes: This report identifies all Service Package changes. All Service 
Packages are listed by the change represented - new, modified, replaced, discontinued, including the old 
and new name and Service Package number where applicable. This report is based only on ARC-IT and 
thus will be the same for each user who runs it during the conversion unless their architecture is several 
levels back.  
 
Version 9.2 Information Flow Changes: This report identifies all information flow changes. All 
information flows are listed by the change represented - new, modified, replaced, discontinued, including 
the old and new flow name where applicable. Also included is the source and destination Physical Object 
name for each flow. This report will identify all information flows that were created, substantially 
modified, or discontinued.   
 
In Version 9 communications elements were split up to distinguish between ITS Communications 
Equipment and Data Distribution Systems. You will now see 2 columns on the Interfaces tab. 
 
Version 9.2 Functional Object Changes: This report identifies all functional object changes. All functional 
objects are listed by the change represented - new, edited, or discontinued including the old and new text 
where applicable. They are grouped by the physical object involved.  
 
Version 9.2 Functional Requirement Changes: This report identifies all functional requirement changes. 
All functional requirements are listed by the change represented - new, edited, or discontinued including 
the old and new text where applicable. They are grouped by the physical/functional object involved.  
 
NOTE: there used to be a Standards Changes report but since 9.0, ARC-IT includes an expanded 
communications view that includes a more complete listing of communications solutions including the 
data and communications profiles as well as the supporting standards. RAD-IT users will need to use 
Auto-Select on the Comm tab after conversion. See the Communications tab for more details. 
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Convert vs Open 
When you click on a older Turbo or RAD-IT file you get a screen that asks if you want to Convert it or 
Open it. What’s the difference and which should I choose? 
 

 
 
Convert, as has already been described, changes your old file and converts the information so that it uses 
the latest version of ARC-IT. This is the preferred method to make sure your file has the latest mappings 
to the ARC-IT (National ITS Architecture) physical objects, information flows, etc. 
 
Open is also useful in certain situations. The main scenario where this is useful is when you need to look 
up something in an older version of the architecture or someone has sent you a file that is older and you 
just need to look at it. 
 
With Open, RAD-IT will still make changes to the file but only enough to make the data tables match the 
schema as the RAD-IT user interface so you can ‘see’ the information on the various tabs.  
 

NOTE: only use OPEN to do just that – open an older file and look up something. Once you 
decide you need to make changes to that old architecture then go back to the original file and 
choose Convert. 

 
You will not be able to first OPEN the file and then choose CONVERT on the same file; not everything 
may line up as expected – go back to the original and convert it. 
 



45 

Data Input 
This section describes the overall user interface for RAD-IT and some naming conventions. 
 

General Information about Data Input 
Notice that the appearance of the tabs across the top of the RAD-IT window is oriented towards the work 
flow of generating a Regional Architecture. There is one tab for each major step in the architecture 
development work flow. 
 
The tabular input windows consist of the following tabs where inventory elements and services may be 
entered and customized: 
 

• Start:  Create/modify/delete an architecture. 
• Planning: Create/modify/delete planning objectives and strategies and relate these to the 

architecture. 
• Stakeholders:  Create/modify/delete a stakeholder name or group, global to all 

architectures in the file. 
• Inventory:  Create/modify/delete an element in the open architecture. 
• Services:  Associate an ARC-IT service package with local inventory elements. 
• Needs: Select/create/modify/delete needs for a region or project based on the service 

packages. 
• R&R:  Create/modify/delete Role and Responsibility (R&R) areas to the current 

architecture based on service package choices and write/edit roles and responsibilities for 
each participating stakeholder. 

• Functions:  Associate functional objects with inventory elements based on the inventory 
and service package choices and requirements based on the needs choices. 

• Interfaces:  Build and customize the architecture. 
• Communications:  Customize the list of applicable ITS communications solutions, 

including ITS standards, based on inventory, service package, and interface choices. 
• Agreements:  Create/modify/delete lists of agreements between stakeholders and agencies 

in the region; Associate agreements with the stakeholders based on the information flows. 
 
There is a certain order to be followed while using the tabbed windows. Several of the menubar options or 
menu tabs will be grayed out if they cannot be used yet. For example, a user is not allowed to customize 
the inventory and information flow list if an architecture has not been created or opened.  
 
All tab windows indicate the deployment status of an item (element, service package, information flow). 
 
As an aside, the items on the inventory input and customization tabbed windows (the Inventory, Services, 
and Interfaces tabs) are directly related to ARC-IT. There are physical objects (subsystems and 
terminators) and service packages that when built into the Project or Regional Architecture (i.e., selected 
and assigned to a local element) generate information flows that are directly associated with ARC-IT 
physical objects assigned to the elements. 
 
It is strongly recommended that the user be trained in the terminology, relationships, and usage of the 
ARC-IT. The USDOT offers classes across the country on the Architecture. There is also the ARC-IT 
web site (www.arc-it.net) that may be used as a reference. The Resources / Training page on the ARC-IT 
website includes a self-paced training course called, “ITS Architecture Use & Maintenance”.  This 4-

https://www.arc-it.net/html/resources/useandmainttraining.html
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module course includes references on the steps to generate a regional ITS architecture and discussions on 
the uses of an architecture along with the steps to maintain the architecture. 
 
The Regional ITS Architecture Definition portion of the arc-it website is also an excellent resource to see 
how to apply ARC-IT to regions and project situations. It can be found under Architecture Use / Regional 
ITS Architecture Definition. 
 

Naming of RAD-IT Items 
GUIDELINE:  It is recommended that a RAD-IT database file be named based on the region name. 
 
GUIDELINE:  A naming strategy for all user-entered names (element, stakeholder, user defined Physical 
Object/flow, project) should be established before designing the initial architecture in a RAD-IT database 
file. 
 
Remember that when naming an element, stakeholder, architecture, etc., certain special characters 
(ampersand (&), apostrophe (‘), and quotes (“)) may not be used in the name. RAD-IT will give a 
warning message and not allow these names. Spaces, underscores (_), hyphens (-), are all acceptable in a 
named item in RAD-IT.  
 
The following shows the Maximum Name Sizes in List Boxes by the number of characters: 

• Element names:  255 
• Stakeholder names:  255 
• Architecture names:  255 
• Project names:  100 
• User-defined physical objects:  100 
• User-defined flows:  100 
• User-defined standards:  255 
• Service Package names:  255 
• Role and Responsibility Area names:  255 
• Functional object names:  255 
• Agreement names:  255 

 
CAUTION:  While 200-255 characters may be the maximum length for some names it is not really 
practical to go over 80 characters and, ideally, even less if they are to appear as labels for boxes on 
diagrams such as the element and stakeholder names. 
 
NOTE: if you accidentally put a space at the beginning or end of a name field, RAD-IT will 
automatically trim the name to reduce the leading for trailing white space (extra characters). 
 
 

Starting RAD-IT 
As you click to start RAD-IT or double-click on a .radit file RAD-IT will start and a ‘splash' screen will 
indicate what version of RAD-IT is starting. 
 
RAD-IT will verify that you have the right version of RAD-IT for your version of Office. It will warn you 
if you are trying to run 32-bit RAD-IT with 64-bit Office or 64-bit RAD-IT with 32-bit Office. 
 

https://www.arc-it.net/html/raguide/raguide-c2.html
https://www.arc-it.net/html/raguide/raguide-c2.html
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Depending on your settings on the Options menu, RAD-IT will also check to see if there are any updates 
available from the ARC-IT website (www.arc-it.net).  You may see a notification in the bottom right 
corner of the RAD-IT window saying, either “RAD-IT up to date” or “Update available!” It may also say 
“Version check failed” if you are not connected to the internet or if the verification server is not available 
for some reason. Use the Options menu to check manually.  

Start Tab 
Looking at the RAD-IT screen we will start working our way from left to right across the tabs at the top. 
This section discusses the first tab – the Start tab. 

  
 

Beginning a New Architecture 
Managing the architectures contained within a file is done from the Start tab. This tab allows the user to 
create a new architecture or select an existing architecture. The tab allows the user to define scope, time 
frame, and other basic definition information for the new or selected architecture. 
 
After opening an existing file all architectures contained in the file will be shown, and the architecture 
that was last opened in the prior use of the file will automatically be selected when the file is opened. 
 
The left-hand side allows the user to create a new architecture, delete an architecture, or select an 
architecture. Selecting an architecture causes the right hand side of the window to be filled in and makes 
the selected architecture the current architecture shown in the banner and on other tabs. The following 
sections will explain in detail how to use these options. 
 

http://www.arc-it.net/
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A new architecture is created on the “Start” tab by selecting the “New” option under either the Regional 
or Project Architecture areas. This adds a new architecture to the file. The following process may be used 
to begin a new architecture: 
 

1. Select the type of architecture: 
a. When creating a new Regional Architecture in an open database file, the name of the 

architecture must be entered. The other attributes of the architecture are optional. There is 
no “Status” field. There may only be a single Regional Architecture in a RAD-IT 
database file.  

b. When creating a new Project Architecture in an open database file, the name and status of 
the architecture must be entered. The other items are optional. The names of existing 
Project Architectures in this database file are displayed so you may see the existing 
names and enter a new name. The software prevents you from creating a project 
architecture with the same name as one previously defined. 

2. Enter the attributes of the architecture. Items such as Geographic Scope, Service Scope, and 
Timeframe, are discussed in more detail in the “Regional ITS Architecture Definition” section of 
the ARC-IT website. All of these attributes may be changed later on the “Start” tab, and will be 
displayed for each architecture in the file, in the “Architecture Summary” report. 

a. Name: The name of the architecture. Required. 
b. Description: Description of the architecture. Optional 
c. Timeframe: Define the planning timeframe that the Regional ITS Architecture will 

address. Should the architecture encompass systems and services that are implemented 
over the next five, ten, or twenty years?  If this is a “planned” architecture for deployment 
in a future planning cycle (e.g., two years from now, or the five, ten, or 20 year planning 
horizon), this should be entered here. Optional 

d. Status: Status of the Project Architecture. If you have extended the list of status values, 
all will appear in this list. Required 

e. Geographic Scope: Where the architecture will be deployed (e.g., District 7, Southern 
California). Ideally, the geographic scope of a region should be established so that it 
encompasses all systems that should be integrated together. In practice, it is sometimes 
difficult to determine where to draw the line so that the architecture is inclusive without 
expanding to the point that the effort becomes unmanageable and consensus is difficult to 
achieve. While this is frequently called a “geographic” area, it is usually a political map 
that is being partitioned, defining a region along existing institutional boundaries. The 
regulation/policy states that metropolitan areas must consider the metropolitan planning 
area (MPA) as a minimum size for a region. The MPA is a good place to start since this 
boundary normally encompasses most integration opportunities and it coincides with the 
geographic region used for transportation planning. Optional 

f. Service Scope: Determine the basic scope of the services that will be covered. For 
example, determine if the Regional ITS Architecture should define commercial vehicle 
related services. Optional 

g. Developer: Name of the person or team that has developed this architecture. Optional 
h. Maintainer: Name of the person or team maintaining this architecture. Optional 
i. Version: Enter a value for this field that makes sense for the region. Architecture version 

numbers or names should be agreed to by all affected parties, and should be consistent 
across all architectures in the region covered by this regional architecture. Optional 

j. Date/Time: This field displays the current date and time when a new architecture is 
created. The field may be changed when the architecture attributes are modified. Optional 
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NOTE: Project Architectures have additional characteristics that can be defined: 
k. Alternatives Considered provides a field to describe any analysis of alternative system 

configurations and technology options that were explored as part of the development of 
the system architecture. 

l. Procurement Strategy may indicate what types of contacting or options that were 
explored before deciding on the approach to be taken on this particular project.   

m. Operations Resources briefly describes changes in the staffing, training, tools, or hours of 
operation in order for the systems modified or created in this project to work.   
 

3. After selecting “apply” the architecture will be created. 

 

Continuing Development of an Existing Architecture 
The following process is used to continue development of an architecture in progress.  
 

1. To open an existing architecture, Click on the “Start” tab in an open database file, select the 
Project or Regional Architecture name from the lists on the left, modify the attributes for the 
selected architecture on the right, and click “Apply” (available only if attributes were changed). 
The architecture name will appear in the title bar of the RAD-IT main window, along with the file 
name. 

2. To save and close this architecture and open another architecture from the same database file in 
the same RAD-IT session, select the other architecture name on the “Start” tab, or select the 
“New” option under Project or Regional Architectures (if a Regional Architecture does not 
already exist) to create a new architecture in this file. The RAD-IT tool allows only one 
architecture to be opened at a time, so opening a second architecture will close the first. If 
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changes have been made to the first architecture, you are asked to save them before the second 
architecture is opened. The new architecture is opened in the same RAD-IT session. 

3. Because all of these architectures are stored as tables in the same database file, changes will not 
be saved to the database unless explicitly requested. 

 

Deleting an Architecture 
The following process may be used to delete a Regional or Project Architecture from the database file. To 
delete an existing architecture: 
 

1. To delete a Regional or Project Architecture in an open database file, go to the “Start’ tab, select 
the architecture name to be deleted, then click the “Delete” option. 

2. A verification window will appear where you may cancel the delete or continue. 
 

NOTE: Deleting the architecture from the database file does not actually delete all references to 
elements used in this architecture that may be connected to other elements, stakeholders, physical 
objects, or information flows, in the rest of the Regional Architecture. This process is manual and 
must be done on the “Interfaces” tab after deleting the architecture. 

 
NOTE: Architectures are stored as tables in a database file. However, changes made to the file are 
not automatically saved to the database (this works differently from Microsoft Access). You must 
explicitly save changes periodically. This also compresses the database file and removes the 
temporary files.  

 
 

Modifying the Attributes of an Architecture 
The following process may be used to modify the attributes of a Regional or Project Architecture in the 
currently open database file. These attributes include the architecture name, description, status, and many 
other items. 
 
To modify a Regional or Project Architecture name, description, status, or other available attributes in an 
open database file, go to the “Start’ tab, select the architecture name whose attributes are to be modified, 
and update the attributes on the right-hand portion of the screen. Click “Apply” to accept the changes, or 
“Cancel” to ignore changes to the attributes of the architecture.  
 
As with element and stakeholder names, the architecture name is stored by identification number in RAD-
IT, so changing the name of the architecture on the Start tab will change it everywhere in the database 
file. 
 

TIP: You can change the status of all the flows in a selected project just by changing the status of 
the project on the Start tab. This is useful when a project is complete and you are ready to change 
everything from Planned to Existing. You will be asked if you are sure with the following 
dialogue box: 
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If you click No it will change the status of the project without affecting the other items like 
elements and flows. If you say Yes then you can see that all the elements, service packages, 
requirements, and flows will all have the same status to match that of the project. 

 

Change Log 
Architectures are not static; they will undergo change. RAD-IT includes a Change Log that provides the 
ability to record the changes made to the RAD-IT file. This log includes a record of the changes made to 
the selected architecture as recorded by the user. The user can add/modify/delete entries in the change log. 
Each entry includes timestamp, name, version, and change description. 
 

1. Select the “Change Log” option at the bottom of the “Start” tab for an existing architecture in an 
open database file. The change log window will appear. 

2. The window title identifies the architecture by name.  
3. The left-hand list box lists all maintenance records for the current architecture, ordered by 

Date/Time. Standard operation - picking an item on the left causes all information for the record 
to be displayed on the right. 

4. This example displays a list of existing change log entries. The user is creating a new entry by 
selecting the “New” option. Today’s date/time has come up automatically, but this may be 
changed by the user. The user then enters the name of the person (50 characters max) updating 
the log (this could be a different person from the “maintainer” shown on the “Start’ tab for this 
architecture), a new version number (default is the version on the Start tab, 50 characters max), 
and a description of the change. All fields are optional except for the date/time.  

5. The “Delete” option can be used to delete maintenance records (change log entries).  
6. Click “Apply” to accept the changes, or “Cancel’ to ignore the changes, then “Close” to close this 

window. The “Close” option toggles to “Cancel” and “Apply” is active when the user is editing.  
7. The “Date/Time” and “Version” fields have buttons to the right of them with the title “Apply to 

Start Tab”. Selecting these buttons will cause the date/time or version number that shows on the 
Start tab to be updated.  

NOTE:  If the person making the change is the same as the “Maintainer’ on the Start tab, 
then the “Apply to Start” buttons will default to checked. If the person is not the same as 
the “Maintainer”, then the buttons will default to not checked. 



52 

 
 

Related Architectures 
There are now more than 300 ITS architectures representing statewide areas, metropolitan regions, 
corridors, or districts within a state. There are also a small number of multi-state architectures. With so 
many architectures across the country there is bound to be some overlap, either in geographic scope or in 
the types of services that are represented. A regional ITS architecture can be developed to cover a 
metropolitan area but it could also be developed for an entire state. In many places, both exist - the cities 
have their architecture for their existing and future services and there are district or statewide 
architectures covering services planned by the state DOT for larger areas.  
 
RAD-IT includes a couple of features to help document that there are other architectures involved and 
track the elements that may be included in another architecture. This can help the maintainers of an 
architecture coordinate their updates with the stakeholders of the other architectures. 
 
On the Start tab, the Related box, shown in the figure above, lists other architectures that have been input. 
These other architectures are meant to be other regional/statewide architectures that are in other databases 
somewhere. It could also include a project architecture that is stored in another file. 
 
To add a Related architecture, click the “New” button below the “Related” architecture box. The right 
side of the screen will change to allow for data entry of the new related architecture. The Name is the only 
required field but the Description, Timeframe, Status, Geographic Scope, Service Scope, Developer, 
Maintainer, Version, and Date/Time can also be edited. 
 
The Description field of the Related Architecture should be complete enough to understand something 
about the other architecture and its relationship to the current architecture. Include the filename, the 
overall scope, and the main agency responsible for it. Other information to include might be the reason 
that this other architecture is related to the regional or project architectures in the current database.  
 

TIP: An easy way to populate the Related Architecture information is to open that other 
architecture in another RAD-IT window (Yes, you can have 2 copies of RAD-IT running at 
once). Then copy the information from the Start tab of one screen and paste it into the Start tab of 
the other screen. 

 
Once you hit “Apply” the information is stored and the name is added to the list on the bottom left side of 
the Start Tab. To edit the information of a Related architecture, simply click the name on the left side of 
the screen, change the attributes on the right as needed and click “Apply”.  
 
To remove a Related Architecture, click the name of the Related architecture and click “Delete”. Click 
“Yes” on the confirmation box and the name of the related architecture and its attributes will be removed 
from the database. This would be useful when, perhaps, a project that used to be in a separate file has 
been imported into this file. 
 
The Related Architecture will be available on the Inventory tab to be able to identify an element as being 
“Shared” with elements in another architecture.  
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Additional Architecture Management Options on “Start” Tab 
In addition to the options that add, modify, or delete an architecture on the “Start” tab, there are two 
additional options. They each contain a topic area of their own. 
 

• The “Project to Region” option is used to merge a Project Architecture into an existing Regional 
Architecture, and may be used in various situations, one of which is after an “Import.” See the 
Merging section below. 

• The “Region to Project” option may also be used in a variety of situations, and is handled as an 
“Advanced Topic” later. See the sections on Importing and Converting a Region to a Project 
below. 

 
 

Maintaining Consistency between the Regional and Project Architectures 
If changes are made on the “Inventory” and “Services” tabs while in a project, these changes will be 
reflected in the Regional Architecture, and vice versa. This applies ONLY to element inventory, Physical 
Object, project, and status changes on these windows. In order to regain consistency of information flows 
and interconnections between the Project Architectures and the Regional Architecture, such as 
customization done on the “Interfaces” tab in a project, the Project Architecture MUST be merged (or 
merged again, if previously done) into the Regional Architecture via the “Project to Region” option on the 
“Start” tab. 
 

NOTE: If flows have been deleted from the Project Architecture, then “Project to Region” (to 
merge the project into the regional) and the “Build” button on the “Interfaces” tab (to build the 
architecture) are not necessary. They will not change the Regional Architecture. The flows must 
be deleted manually from the Regional Architecture. The “Build” button to build the architecture 
only adds new elements and flows to the “Interfaces” tab (for instance, if a new inventory 
element was created or a service package was selected), and “Project to Region” only makes the 
two architectures consistent if customization has been done to the project. 

 
GUIDELINE:  If an interconnect is selected in the Regional Architecture that is already in the 
project, only flows are selected that are in the Regional Architecture. If an interconnect is 
removed in the Regional Architecture, it does not affect the Project Architecture. 

 

Import 
In RAD-IT, the Import tools provide the ability to import project architecture information from another 
file.  
 
There are essentially 2 types of import supported by RAD-IT: 

 Importing a project architecture from another RAD-IT file (see “Importing an Existing RAD-
IT Project Architecture” below) 

 Importing project information from a SET-IT project (see “Importing a SET-IT Project” 
below) 

 
NOTE: Either type of Import only applies to Projects and Import only applies to files of the same 
version. If you have an older file then convert that file to the latest version and then it can be 
imported into your RAD-IT file. 
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Importing an Existing RAD-IT Project Architecture 
The following process may be used to import an existing Project Architecture from a second RAD-IT 
database file (source file) into the open database file (destination file). 
 

1. It is a good safety measure to do a Save As… of the destination RAD-IT database file prior to 
importing. Once an architecture is imported into this file and saved, it is not possible to undo the 
import. 

2. For a Project Architecture to be imported from the source database file, the project must already 
be fully defined in that database file. That is, the Project Architecture to be imported must be 
built, via the “Build” button on the “Interfaces” tab, so that all elements and information flows 
appear in the “Interfaces” tab and are present in the architecture.  

3. To import the external Project Architecture into an open database file, on the menubar select:  
File => Import… 

4. A window will appear asking you to select the name of the RAD-IT database file from which to 
import the Project Architecture. Select the desired path and file name. Click “Open” to open this 
file. 

NOTE: You cannot import from a file that is open in another session of RAD-IT. Close 
that copy of RAD-IT and then you can import the project from that file. If you forget then 
you may get an Error message from RAD-IT that says “Error accessing the import file.” 
If you get that just close the other copy of RAD-IT and try again. 

5. If you attempt to import a prior release architecture, you will be notified that the file must first be 
converted and the import process will exit. At that point, do the following: 

a. Close your destination file,  
b. Open the source file in RAD-IT and  
c. Let it convert to the current version and then  
d. Save the file as the new source file for your import.  
e. Close the source file and  
f. Reopen your Destination file.  
g. Start the Import over to get through step 4. 

6. The next screen lists the Project Architectures included in that database. Select the Project 
Architecture to be imported (only one project at a time may be imported). The path name may 
also be changed without returning to the previous screen. Click “Import” (or double click on the 
project name) to begin the process.  

7. If the project name already exists in the destination file, a window will appear stating that you 
must rename the existing project in either the source or the destination file. 

8. The next screen lists elements that are defined in the project being imported, but not included in 
the Regional or Project Architectures in the destination database file. Select “Yes” to import these 
elements, or “No” to ignore them. Only the elements with unique names are listed in this window, 
although ALL elements from this project will appear in the imported project in the destination 
file. The elements that already exist in the destination file will continue to have those elements’ 
associations and attributes. If you intend to keep these as completely separate elements, they may 
be changed on the tabbed windows in the imported Project or Regional Architecture. 

9. The next window asks if you wish to add user defined physical objects that are in the imported 
project but not in the destination file. Answer “Yes” or “No”. This window will not appear if 
there are no user defined physical objects in the architecture. 

10. The next window asks if you wish to add stakeholders that are in the imported project but not in 
the destination file. Answer “Yes” or “No”. 

11. The next window asks if you wish to add Service Packages and Needs that are in the imported 
project but not in the destination file. Answer “Yes” or “No”. 
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12. The next window asks if you wish to add Planning objectives and strategies that are in the 
imported project but not in the destination file. Answer “Yes” or “No”. 

13. The next window asks if you wish to add stakeholder Roles & Responsibilities that are in the 
imported project but not in the destination file. Answer “Yes” or “No”. 

14. At this point, a window may appear asking if you wish to add user defined flows that are in the 
imported project but not in the destination file. Answer “Yes” or “No”. This window will not 
appear if there are no user defined flows in the architecture. 

15. Then you are asked if you would like to add the information flows (with source and destination 
elements) from the project being imported into the “Interfaces” tab in the imported Project 
Architecture in the destination file. Select “Yes” or “No”. By selecting “Yes”, ALL flows in this 
window are imported. This will also show any flow aliases that were defined and applied to those 
flows in the source architecture.  The flow alias will appear first followed by the original flow 
name in parenthesis. 

16. The next set of windows concerns the Communications view and asks if you wish to add user 
defined standards, standards profiles, communications solutions, or issues that are in the imported 
project but not in the destination file. Answer “Yes” or “No”. 

17. The next window asks if you wish to add Agreements that are in the imported project but not in 
the destination file. Answer “Yes” or “No”. 

18. The import process is completed and the destination project is built. You must save the 
destination (currently open) database file in order to save the changes from the import. 

19. Finally, the original “Import” window appears allowing you to import another project from the 
source file into the destination file, or to “Close” (exit from Import). 

 
 

Importing an Existing Regional Architecture 
A Regional Architecture may be imported from a source file into a destination file, similar to importing a 
Project Architecture. This is a two-step process, as follows. 
 

1. First, open the source Regional Architecture and convert it into a Project Architecture in the 
source file using the “Region to Project” option on the “Start” tab. Save that file. 

2. Next, open RAD-IT again and create a new Project Architecture.  Now you may import the 
source project architecture into the destination file using the “File => Import” option on the 
“Start” tab. 

You can then make it part of the destination file’s regional architecture by doing a Project-to-Region 
merge.  See steps below in Merging a Project into an Existing Regional Architecture 
 
 

Importing a SET-IT Project 
A project architecture developed in Systems Engineering Tool for Intelligent Transportation (SET-IT) and 
also be imported into RAD-IT as a project architecture. SET-IT is a graphical tool used to create 
customized drawings to represent the physical, communications, and enterprise views for an ITS project, 
including connected vehicle services. 
 
The process works similarly to importing a project from another RAD-IT file. The SET-IT file is 
identified and RAD-IT analyzes the file to determine what needs to be imported and provides the user 
feedback through the process. 
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Steps to Import from SET-IT: 

1. On the Start tab click “New” under Projects to start the creation of a new project architecture. The 
screen on the right changes to add an area to identify a SET-IT project to import. 

 
2. Click the blue hyperlink that says, “Not Set (Click to Browse)” which will open up a Windows 

File dialog box to find the SET-IT project you would like to use. 

 
3. Find the ‘SET-IT’ project you want to import and click “Open” to read the database and format 

the information for RAD-IT.  You may get a “Locked file selected” message if the project you 
want is currently being used by SET-IT.  The message will say, “The selected file appears to 
already be open in another application. Please close the other application so RAD-IT has 
exclusive access to the file.”  If this happens simply close the SET-IT application and try again. 
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4. Once you have the SET-IT project selected, the Start Tab in RAD-IT will change to show the 

SET-IT file name selected. 

 
5. Click “Import” 

6. This will then walk through the information in the SET-IT file to show the information and 
present any changes that are needed to the data before it can be imported into RAD-IT: 

a. Status – shows the default status used in the imported SET-IT file compared to the default 
status used in your RAD-IT file. If it is different then the RAD-IT status value will be used. 
Typically, SET-IT files have a default status of ‘Project’ which means that thing being shown 
will be built or developed as part of the Project in question. RAD-IT files typically use a 
default status value of ‘Planned’ as in, this is what we Plan to do. You can use the pull-downs 
to change the mappings if desired or click “Continue”. 

 

b. Project Overview Import – an information only screen that shows what will be imported to 
populate the start tab, including the project description, scope, developer, maintainer, version 
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numbering, and date. You can select which element of the overview to import using the 
“Perform” checkboxes. Click “Continue”. 

 
c. Stakeholders Import – shows the list of Stakeholders that will be added from the SET-IT file. 

If a stakeholder with the same name already exists in your RAD-IT file this screen will show 
that as well. 

d. Physical Objects Import – shows any user defined physical objects (not defined in ARC-IT) 
that are in the SET-IT file. 

e. Functional Objects Import – shows any user defined functional objects (not defined in ARC-
IT) that are in the SET-IT file. 

f. Elements Import – shows the list of elements that are going to be imported into the RAD-IT 
file from the SET-IT project file. 
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g. Service Packages Import – shows the list of service packages, including the shorthand 
identifier, e.g. TM03, the long name of the service package instance, and the action to be 
taken. SET-IT treats all service packages that are selected and included in a SET-IT file as a 
service package instance. 

 
NOTE: ARC-IT v9.1 now includes a concept of a Service Package Implementation which is a 
subset of a service package that defines an approach for meeting the user needs of a given 
service package. SET-IT allows users to include Service Packages Implementations as a 
starting point for their project. During Import RAD-IT will simply include those as any other 
service package instance.  You may see a name like TM06.1 Dynamic Message Sign to 
indicate that it came from the implementation option of TM06 Traffic Information 
Dissemination that is focused on using Dynamic Message Signs. 

h. Flows Import – this screen will show any user defined physical information flows (not 
defined in ARC-IT) that are in the SET-IT file.  
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If an Alias was defined and/or applied in SET-IT then that will also be imported and noted on 
this screen. 

i. Interfaces Import – this screen shows the list of information flow triples (source element, 
destination element, and flow name) that will be imported. 

 
j. Communications Issues Import – lists any issues or gaps that the imported communications 

solutions may have that are unique from ARC-IT, including any at the standards, profile, or 
solution level. 

k. SDO – lists the Standards Development Organizations (SDOs) that are to be imported that are 
user defined in the SET-IT project. 
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l. Standards Import – lists the standards from the SET-IT project that need to be imported, 
including any that are user defined. 

m. Profiles Import – lists the Data and Communications Profiles to be imported from the SET-IT 
project 

n. Communications Solutions Import – lists several communications related items to be 
imported. First it lists any user defined standards that were defined in the SET-IT project and 
may be needed in the RAD-IT file. Then it lists any Data or Communications Profiles – 
groups of standards that combine to define the standards required to communicate at the 
various protocol layers across an interface. Then it lists any Communications solutions in the 
SET-IT project that may be needed in the RAD-IT file. Then it lists any Communications 
Issues that have been defined in the SET-IT project that may apply to the communications 
solutions or their standards. In some cases, it will say “excluded” since it is not needed in the 
RAD-IT communications tab. Also included will be any standards that are mapped to 
physical objects. You may also see a list of user defined Standards Development 
Organizations (SDOs) that need to be imported. 

o. Need Areas Import –shows the list of Need Areas to be imported. Need areas are groupings 
of needs, usually based on Service Packages. 

p. Needs Import –shows the list of needs, including any customized needs that will be imported, 
organized by the service package to which the need applies. 

  
q. Requirements Sources Import – lists any unique (user defined) sources for the functional 

requirements that are about to be imported from the SET-IT project. 

r. Requirements Import –shows the list of Functional Requirements to be imported.  

NOTE: if a SET-IT project was built to include System level requirements vs. Element or 
Functional Object based requirements then you may not see any requirements after import. 
Currently, RAD-IT only supports Element or Functional Object based requirements.  After 
import you can use the Autoselect function on the Requirements tab to pre-select 
requirements for your project based on the functional objects assigned to your elements. 
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s. Agreements Import – lists the stakeholder agreements from the SET-IT project to be 
imported. 

 
NOTE: SET-IT does not use the field “Lead Stakeholder” but RAD-IT does. During import, if 
that field is blank then the import process will automatically fill in a lead stakeholder for joint 
agreements in which there is only one stakeholder.  You can change this after import on the 
Agreements tab. 

Once all the steps have been conducted one final screen will say “Import Complete”. Click the Close 
button or the “X” in the upper right corner to close this window and an Import Report screen will give 
you an opportunity to create an output report in Word, Excel, or Comma-Separated Values (CSV) Text 
format that lists all the changes made to the file. 

 
TIP: Uncheck the Roll-Up option for import reports – it takes longer and creates giant cells that 
try to include too much. The Excel option works best and you can then use Filtering in Excel to 
inspect any potential issues.  

 
Click the “X” again to close this window after you have exported the report and you will go back to the 
Start Tab. 
 
Now you can go to each tab and see the project information that is now part of the RAD-IT project. 
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Rules of Importing 
These rules apply whether the project was imported from another RAD-IT file or from a SET-IT project. 
 

1. The Project Architecture you imported will be the architecture currently selected in the file. You 
can see this by looking at the title bar and in the info boxes on each tab which will show the 
architecture currently open and selected in the file.  

2. All the elements in the source Project Architecture may not be imported into the destination file. 
If the source project includes inventory elements that are not actually connected into the 
architecture, i.e., no information flows are connected to these elements on the “Interfaces” tab 
after building the architecture via the “Build” button on this tab, then these elements are not 
imported into the destination file.  

3. For each element with a distinct element name the entire set of information was imported – 
element name, element description, stakeholder, status, and project association. 

4. For each element whose name identically matches an element name in the destination file, the 
only piece of information always imported is the association with the new project. NOTE that if 
the element had a different stakeholder, description, or status than in the destination file, that 
information will NOT be imported. 

5. Service packages that are associated with the selected project are imported along with the 
elements and flows from the project. The service package status is imported under the following 
conditions: 

a. The service package is associated with the selected project. 
b. The service package status in the import file is something other than “Not Applicable”. 
c. The service package status in the destination file is “Not Applicable”. 

6. Under these conditions, the service package status in the destination file will be set to match the 
status in the import file. The status in the destination file will never be changed to “Not 
Applicable” during Import. Thus, the service package choices that were made in the destination 
file are preserved, and any new service packages that were associated with the imported project 
are added. 

7. A Service Package / Element pair that is selected before Import will always still be selected after 
Import. In addition, Service Package / Element selections in the destination file are preserved in 
this way. Elements associated with a service package are selected during Import when the 
following conditions are met: 

a. The service package is associated with the selected project. 
b. The element is associated with the selected project. 
c. The Service Package / Element pair was selected in the import file. 

8. Information flows are imported if they are not already used in the destination file. What if the 
flow already exists?  It is assigned to the project being imported. But what about its status?  

a. If the status in the destination file is “Not Applicable”, then the import process will give 
it the status from the source file.  

b. If trying to import a project with a flow that is “Existing”, but the flow is contained in the 
destination file with a status of “Planned”, for example, the status of the flow will not be 
changed in the destination file.  

c. Similarly, if the imported status is “Planned” and the status in the destination file is 
“Existing”, the status will remain “Existing” after Import.  

d. A new project association is added on the “Inventory” tab to the existing Regional 
Architecture element that links to this flow. 

9. Following the “Import”, the “Interfaces” tab will display just the source element / information 
flow / destination element triples that were selected in the original file (but not any of the possible 
flows or interconnects that were “Not Applicable” in the original file). In order to add all of the 
“Not Applicable” flows, you must build the architecture by running the “Conservative Build” step 
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for the imported project either during “Import”, or manually via the “Build” button on the 
“Interfaces” tab after the “Import”.  

Why would you want the “Not Applicable” flows as part of the imported project?   
Maybe there is more customization of the imported project planned in the new file, and 
some of these flows will be required later for additional integration with the other 
projects and the Regional Architecture in this file. 

10. The “Interfaces” tab for the imported project will preserve all customization that was done in the 
source file. 

11. If the project has a unique name, it will be imported into the open database file. If you try to 
import a project that already exists in the destination file, an error message is displayed and the 
import is terminated. If you would like to import a project into a file that already contains a 
project of the same name, you may: 

a. Rename the existing project in the destination file to a name that is different from the 
project that will be imported, or 

b. Rename the project in the source file to a unique name before it is imported. 
12. User defined Physical Objects and flows may be fully or partially imported into the project. 

Source and destination information is imported for user defined flows that are included in the 
imported project. NOTE that only source and destinations that are actually associated with the 
project elements are included. In some cases, this will result in only part of the user defined flow 
source and destination information being imported (if, for instance, the project only maps to a 
subset of the source and destination physical objects). In rare cases, no source or destination 
information could be imported (if, for instance, you build the architecture, then remove the source 
and destination Physical Objects from the project elements). 

 

Tips on Importing 
The importing of a project (either from RAD-IT or from SET-IT) into a file can have some complexity. 
Below are some of the common issues you may run into, and how to handle them.  
 
1. Close the file you want to import from first. RAD-IT may give an error if you try and import from an 

already opened file. 
2. What if you end up with an imported element that has a slightly different name from one in the 

destination file (and you wanted them to be the same)?  First, how would you recognize this?  Look at 
the “Inventory” tab and see if they show up as two elements. So now what do you do?  Probably the 
easiest way to fix this is:  

a. Do not save the destination file (i.e., throw away your import). 
b. Go back to the imported (source) file and change the element name so it matches the element 

in the destination file. 
c. Re-import the architecture with the matching names. 

3. What if you have already saved the destination file (i.e., the import can’t be reversed)?  The fix is not 
quite as simple, but this is what you would do: 

a. Identify all the source element / information flow / destination element triplets involving the 
incorrect element name (the element you imported). You can get a printout of these as part of 
the “Project Architecture” report. 

b. Associate the correct name with the imported project, and unassign the imported name with 
the project. This may be done on the “Inventory” tab. 

c. Build the architecture via the “Build” button on the “Interfaces” tab. 
d. On the “Interfaces” tab, add all flows associated with the correct element, and change to “Not 

Applicable” all the flows associated with the incorrect element. If your project was large this 
could be a lot of flows. That’s why the first approach is usually going to be easier. 
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4. What if some information relating to an imported element was lost because it had the same name as 
an element in the destination file?  Let’s consider two cases here.  

a. The first is that you want the element names to be the same but want the information from the 
imported element. Then go to the “Inventory” tab, select the element, and change its 
description, stakeholder, or status. BUT,  

NOTE:  If you do this for the project you imported it will apply for all architectures in 
the file (both regional and project). This is a “global” (file-wide) change.  

b. What if you really want two sets of definitions, stakeholders, or status?  Then you need to 
define two elements. 

5. Importing just loads the Project Architecture into the destination file. If you want to add this project 
to an existing Regional Architecture, or start to create a Regional Architecture with it, you need to go 
to the “Start” tab and run the “Project to Region” option to merge the Project Architecture into the 
Regional Architecture. 

6. Beware of going back and forth between RAD-IT and SET-IT too much; there may be some issues 
where not everything is always mapped the same way between tools. The import tools will take care 
of most data schema differences but too many ‘round-trips’ may have issues that will need to be 
addressed manually. 

7. A user-defined flow that is imported from a project architecture will, by default, be set to only apply 
to that project. If you want that flow to apply to other architectures in your file, including the regional 
architecture, then use the Add Flows button to bring up the User Defined Flows screen and apply it to 
the other architectures. 

 
 

Questions about Import 
• What if I Make Changes to that SET-IT file?  You can reimport that SET-IT project into RAD-IT 

and RAD-IT will update those same components to reflect the changes. It will basically go 
through all the steps outlined above to import a project and will tell you the places where it will 
“Update per SET-IT file”.  

o But to be able to take advantage of this, you must keep the name of the SET-IT file the 
same. If you were using the filenames to help keep track of your configuration it may be 
better to keep the filename the same and zip it up and put a date or version indicator on 
the zip file name. 

 
 

Output Tables That Reflect Imported Data 
Once the Project Architecture has been imported, the architecture will be opened in the destination file. 
All output tables and diagrams are available for this architecture, but the following reports may indicate 
specific information regarding the imported data. 
 

• Inventory:  shows the elements and the stakeholders associated with them. 
• Stakeholders:  presents all the stakeholders assigned to the project.  
• Project Architecture:  a detailed report of all the elements and information flows in the project, 

including user defined flows.  
• Region to Project Comparison:  lists information flows that are in the region but not in the 

project, as well as flows in the project but not in the region. This report is only available if there is 
a Regional Architecture in the file. This report, if displayed immediately after the Import, will 
show all new flows that have been imported since none of these new project flows will have been 
merged into the Regional Architecture yet. This report should be printed before merging the 
project with the Regional Architecture. 
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• User Defined Flows/Physical Objects:  lists the user defined physical objects and flows and their 
associated elements. This report includes all imported user defined physical objects and flows. 

 

Merging Projects and Regions 
Importing architectures from other files and then merging the projects into a regional architecture are 
powerful tools to help manage complex regions over time and involving different architecture 
maintainers.  
 
As mentioned on the Start Tab discussion there are a couple of buttons to help manage regional and 
project architectures.  
 “Region to Project” – used to turn a region into a project that can be imported into another file 

(RAD-IT or SET-IT) 
 “Project to Region” – used to merge work done at a project level into the region, see below. 

 

Turning a Regional Architecture into a Project Architecture 
This process may be used in several instances: 
 

1. Your design in a previous version of RAD-IT was done using Project Architectures, they were 
merged together into a Regional Architecture, and the Regional Architecture was then customized 
instead of customizing the projects and merging them again into the Regional Architecture. 

2. You are using the suggestions for creating a three-tier architecture (for your state, for example), 
and need to convert the Regional Architectures at the various local and regional levels into a 
project to import to the next higher level. 

3. You are now using an older version of RAD-IT and have a need to import a Regional 
Architecture into another file. 

 
The following is a suggested method for turning a Regional Architecture into a Project Architecture. Here 
the general process is to create a project that includes the entire Regional Architecture. Once we have a 
project that includes the entire Regional Architecture, we can import the project into another file using the 
“Import” process. RAD-IT includes an option to turn a Regional Architecture into a Project Architecture 
and placing it in the same database file. The procedure for doing this follows. 
 

1. In the source file, create, build, and customize the Regional Architecture that is to be converted 
into a project.  

2. Do a “File => Save” to save the original database containing the Regional Architecture. 
3. Now, do a “File => Save As…” to create a new database that will include the rest of the steps 

prior to “Import”.  
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a. Create a new, empty project in this file. The project must be open in order to convert the 
Regional Architecture into it. See “Project S” on the example below: 

 
4. With the project highlighted, Select the “Region to Project” option on the “Start” tab. This option 

is not available unless a Project Architecture is open. 
5. If you are in the new Project Architecture, the regional to project conversion will continue. 
6. The process copies the Regional Architecture into the Project Architecture. 
7. The conversion process places all Regional Architecture inventory elements in the new project, 

associated all service package choices with the new project, and maintained all project-to-element 
relationships from the Regional Architecture. 

8. At this point, you should do a “File => Save” to save the changes to this new (temporary) 
database, and to save the new Project Architecture that is to be imported. This new database will 
only be used temporarily, to hold the Project Architecture that is the same as the Regional 
Architecture. You do not want to overwrite the original file with this change. The reason is that 
the new file now contains the Regional Architecture twice: once as the Regional Architecture and 
once as a Project Architecture. When the import of this project is complete, the second 
(temporary) file can be deleted. Any changes to the Regional Architecture should then be made in 
the original file, or in the imported project. 

9. You have now created a Project Architecture that includes all Regional Architecture information.  
10. Open RAD-IT and use the “Import” Process to import the Project Architecture that you just 

created into the destination file. Once the project has been imported, it can be Merged into the 
Regional Architecture. At this point, you will have successfully imported a Regional Architecture 
from one RAD-IT database into another. 
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Merging a Project into an Existing Regional Architecture 
The “Project to Region” option on the “Start” tab adds all information flows associated with a Project 
Architecture to the Regional Architecture. This option allows you to initially merge a project with the 
Regional Architecture (i.e., populate the Regional Architecture with project data), or to merge the project 
again if it has been changed (i.e., if new customization has been done).  
 
If there is no Regional Architecture in the database and you have defined a Project Architecture, create an 
empty Regional Architecture, then add (merge) the project into it. At this point, the Regional and Project 
Architectures should be identical. Any changes or customization made to either architecture will, of 
course, change the associations between these two architectures. 
 
The following process is used to merge an existing project to an existing Regional Architecture in the 
same RAD-IT database file. Only one project at a time may be merged into the Regional Architecture.  
 

1. Make sure that a Project Architecture has been built (the architecture has been taken through the 
“Build” button on the “Interfaces” tab, and perhaps tailored via the “Interfaces” tab) and is open. 
Open the Project Architecture that you want to merge by selecting the architecture on the “Start” 
tab. Also make sure that a Regional Architecture has been created in the database. The Regional 
Architecture can be an empty architecture. 

2. On the “Start” tab select the project to merge, then “Project to Region”. 
3. A number of screens will appear to walk you through each component of the architecture to be 

merged into the Region. In each case it will list items that are not in the region and need to be 
added to make the region consistent with the project. You have the options to respond Yes or No 
and then click Continue to go to the next architecture component. 

a. Objectives & Strategies 
b. Stakeholders 
c. Elements 
d. Status Values unique to the project but not yet used in the Region 
e. Service Packages 
f. Service Package Status Values 
g. Roles & Responsibilities 
h. Needs 
i. Functional Objects 
j. Requirements 
k. Information Flows – as triples: source, destination, flow name, alias (if applicable); along 

with their status 
l. Communications Elements 
m. Flow Status Values 
n. Standards to be Included 
o. Standards to be Excluded 
p. Project unique entity/flow standards mappings 
q. Project unique element/flow standards mappings 

 
4. By running the “Project to Region” option, the new information flows that were added or 

modified in the Project Architecture will appear in a list to be added to the Regional Architecture. 
Click “Yes” to add them or “No” to cancel the operation. (If there are no new flows or project 
customization to associate with the Regional Architecture, then a message is displayed that there 
is nothing to merge.) 

5. Select “Close” on the “Project to Region” popup window and the operation is completed.  
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Merge Two Similar Elements 
Two elements may be created that have similar names. A common type of problem is that one version of 
the name has imbedded blanks, and the other name includes underscores. Another common problem is 
when one version of the name includes an acronym (TMC, for instance), and the other name is spelled 
out.  
 
If you meant to use the same element name, the process to merge these elements is manual: 
 

1. First, look at all the associations and elements related to both elements with similar names. 
Decide which to keep and which to throw away later. 

2. You may wish to see if the interconnects are identical for the similar elements. The 
“Interconnect” and Information “Flow” diagrams may be displayed and printed by selecting one 
element on the “Element Selection” option of the diagrams pulldown menu, then selecting the 
“Show All” option on the diagrams menu. Either diagram will show the interconnections and data 
that flows between the selected element and all other elements it connects to in the architecture. 
Diagrams for both the element that is to be kept, and the element that you would like to merge 
into it, should be displayed, printed, and checked to see if the interconnections and flows are 
identical. Discrepancies between the diagrams should be resolved before deleting the old 
element(s). 

3. Next, if all associations (stakeholders, subsystems/terminators, service packages, projects, and 
customizations - interconnections and information flows) are the same as the element(s) that will 
be kept, then reassign the element associations on the “Services” tab for the element(s) to be 
deleted to the element(s) that will be kept. Finally, go to the “Inventory” tab, and delete the 
unwanted elements. 

4. If the associated items and related elements are different, decide which you wish to keep, reassign 
the stakeholders, physical objects, service packages, etc., on the kept elements as appropriate, go 
to the “Inventory” tab, and delete the unwanted elements. 

5. Make sure that any customization done on the deleted element(s) is also applied on the element(s) 
that are kept. The links to flows and interconnects must be re-established for the kept element(s) 
and the unwanted element(s), flows, and interconnects deleted. The output tables and diagrams 
should help to re-establish the associations. 

 

Planning Tab – Connect with Planning 
Looking at the RAD-IT screen we continue working our way from left to right across the tabs at the top. 
This section discusses the 2nd tab – the Planning tab. 
 

Planning Tab General Information 
The purpose of the planning tab is to link the objectives and strategies of the transportation planning 
process with components of the regional or project ITS architecture and thus linking the needs of the 
community to the deployment of ITS. The vision and goals of the region establishes the foundation of the 
transportation planning process. Transportation goals may be defined in multiple levels and called by 
different names including goals, objectives, or priorities.  
 
Once the transportation vision and goals are set for a region, improvement strategies to address them are 
identified and evaluated. Both capital strategies to build new facilities as well strategies to operate 
existing facilities more effectively and efficiently are considered. A large proportion of the operational 
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strategies can be implemented with ITS and are covered in the regional architecture. Other non-ITS 
operations include access management and travel demand management. 
 
For example, a region has a goal to “provide an efficient and reliable transportation system”. This goal 
covers a lot including all modes of transportation. One of many objectives that was defined to help meet 
their goal is to “reduce the mean time per incident by 20 percent in 5 years”. The strategies identified to 
meet the objective include: 

• Implement a multi-agency incident management program, 
• Deploy emergency vehicle pre-emption,  
• Develop towing agreements and 
• Provide traveler information on incidents. 

 
To help determine when they have met their objectives the region defined performance measures, 
parameters used to measure the extent to which a program is reaching the desired results. For our 
example, the performance measure for our objective to reduce the mean time per incident by 20 percent in 
5 years is the mean incident response & clearance time. 
 
There is a relationship between the transportation planning process and a region’s ITS architecture. 
Specifically, the ITS operational objectives and strategies & related performance measures are related to 
ITS services and projects of an ITS architecture. ITS services or Service Packages are provided by 
stakeholders for the direct or indirect benefit to users of the transportation system.  
The planning linkage for the ITS Architecture is entered on the Planning tab in RAD-IT  
 
 

Planning Tab Customization 
In RAD-IT, you can enter up to two levels of planning goals. By default the two levels are titled 
“Objectives” and “Strategies” (and we will use these terms generically throughout help to refer to the two 
levels). If desired, these titles can be changed by selecting the Customize button. 
 

 
 
In this window you can select to have one or two levels of planning goals. You provide the titles to be 
used for each level. For each level, you need to provide the singular and plural terms to be used as the 
title. If you only want to enter a set of local Initiatives (so the ITS services of the architecture can be 
related to them) then you select one level (use the “1” radio button) and can enter the terms Initiative and 
Initiatives. After clicking OK to accept the changes, the tabs on the Planning tab are labeled Regional 
Initiatives and All Initiatives. 
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Planning Tab – Using the Tab 
Looking at the Planning tab, with the default Objectives/Strategies hierarchy the left side of the tab shows 
the list of objectives and strategies. Since there are two levels, the higher level objectives are shown as 
folders with the lower level strategies included in them. There are two tabs so you can view only the 
objectives and strategies in the current architecture or all in all architectures in the database.  
 
 

 
 
To add an objective or strategy, you select the New button. To delete one, you highlight it and select the 
Delete button. Following the RAD-IT convention, for the selected (i.e. highlighted) item in the list on the 
left, its attributes are given and can be edited on the right side. The level can be assigned using the Type 
pull down menu. For a lower level strategy, the objective that it supports can be selected from the 
Supports pull down menu. For each objective or strategy, you enter its name. If desired, you can enter a 
number for it which will be used for sorting. You may use a hierarchical numbering scheme. You may 
enter a description for the objective or strategy. You can identify the source of the objective or strategy. 
To enter a source, you just type in the box. You can also identify the performance measures related to the 
objective or strategy. To enter a performance measure, you select the Edit button. You can select the 
service packages (a.k.a. ITS services) that support an objective or strategy. You select the service 
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packages from the All Service Packages tab. Then those selected are listed on the Selected Service 
Packages tab.  
 
If you need assistance in selecting service packages, you can perform a search to identify service 
packages related to an objective or strategy. You perform a search by selecting the Search button to the 
right of the service package tabs.  
 
 

Planning Tab – Performance Measures 
To access performance measures, select the Edit button on the right side of the Planning Tab. To add a 
performance measure you begin typing in the Performance Measure box. If you desire, you can assign 
categories and/or numbers to the performance measures but it is not required. The columns for category 
and number can be shown or not by using the toggle button at the top of the window.  

 
 
You may enter as many performance measures as desired while in the Performance Measures window. 
The Include checkboxes are used to associate each performance measure with the objective/strategy 
shown in the menu bar at the top of the form. When you apply your changes, the performance measures 
and “include” associations are copied from the performance measures form back to the Planning Tab. 
 

Service Package Search 
If you need assistance in selecting service packages, you can perform a search to identify service 
packages related to an objective or strategy. You perform a search by selecting the Search button on either 
the Planning Tab (right side of the tab) or the Services Tab (on the left side).  
 
There are three ways to search for service packages: 

1. First, you can search for service packages that support an ITS goal. There are eight ITS goals 
identified from which you can select one using the pull down menu. Once a goal is selected, you 
press the Go button or combine the Goal Search with the other two criteria. 

2. There are many defined transportation related objectives from which you can select one using the 
pull down menu. Once an objective category and objective has been selected, you press the Go 
button to perform the search or continue to the content based search. 

3. Enter keywords or other text that will be used in a content search of the Service Package titles and 
descriptions. 
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Once the criteria are set, the Go button may be pressed to search for service packages that meet all 
supplied criteria.  
 
Checkmarks indicate which service packages are:  

1) already associated with the current objective/strategy when the search is performed from the 
Planning Tab, or  

2) already included in the architecture when launched from the Services tab. Highlighting one of 
the resultant service packages will cause the description to be displayed in the box below.  

 
Use the Show Diagram button to display a graphic of the Service Package from ARC-IT. Use the Hide 
Diagram to restore the display back. Click or unclick the checkboxes to add or remove the service 
packages. Then click Apply to incorporate the changes into the architecture. Or select Close to exit this 
window and return to the main RAD-IT window. 
 
 

Stakeholders Tab – Managing Stakeholders 
Looking at the RAD-IT screen we continue working our way from left to right across the tabs at the top. 
This section discusses the 3rd tab – the Stakeholders tab. 
 

Stakeholder Tab General Information 
The Stakeholders tab is used to carry out all changes to the architecture’s stakeholder list. The 
Stakeholders tab is used to create, modify, or delete a stakeholder name or group. The stakeholder name 
may be a primary or secondary stakeholder that is to be associated with (in charge of) a center or element 
on the Inventory tab. Stakeholders are also used on the R&R and Agreements tabs.  
 
Stakeholders can be associated with the Regional architecture or one or more Project architectures. 
Shown in the figure above is the list of stakeholders when a project architecture is active. Note the sub-
tabs on the left for Project Stakeholders and All Stakeholders. Clicking on Project Stakeholders would 
only list the stakeholders that are in that project. Clicking on All Stakeholders as shown above shows all 
of the stakeholders in the file and the check marks on the left identify which are associated with the 
current architecture. 
 
The Autoselect button on the Stakeholders tab preselects stakeholders to add to the list by looking through 
the inventory elements associated with the current architecture. If any of the stakeholders associated with 
those elements are not already part of the list of stakeholders for the current architecture they will be 
added to the Stakeholders tab. This feature is useful if you started with the inventory tab to create or select 
a list of elements for this architecture and now want to update the list of stakeholders. 
 
Autoselect has 3 options: 

• Add Stakeholders that support selected inventory elements. 
• Remove Stakeholders that do not support selected inventory elements. 
• Add/keep all stakeholders associated with included stakeholder groups. 

 
A stakeholder group may also be associated with an inventory element. This could be a group of 
stakeholders, such as several emergency services agencies, that may be in charge of an emergency center 
in the Regional Architecture which is actually a group of emergency centers. On the Stakeholders tab, 
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individual stakeholders are represented by the single person icon while stakeholder groups are shown 
using the multiple person icon. Create a Stakeholder Group when you want to associate more than one 
stakeholder with the same element. 

 
 
In the figure above, a stakeholder group is highlighted on the left side of the screen and the Associated 
Stakeholders that make up that group are listed on the right.  
 
 

Stakeholder Tab - Creating a New Stakeholder 
To create a new stakeholder or stakeholder group: 
 

1. On the “Stakeholders” tab select the “New” button.  
2. Enter the name and description of the new stakeholder on the right-hand side of this screen. 
3. If you are creating a new stakeholder group (see also Working with Stakeholder Groups) check 

the “Stakeholder Group” checkbox and associate existing stakeholders with the group. 
4. Click “Apply” to create the stakeholder. If you wish to cancel this change, select the “Cancel” 

button. 
 
Alternatively: You may also create a new stakeholder when creating a new item on the “Inventory” tab. In 
this case, select the “create new stakeholder” option under the stakeholder pull down selection. 
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Modifying an Existing Stakeholder 
To modify attributes of an existing stakeholder name or group: 
 

1. Enter the “Stakeholders” tab. 
2. Select the name of the stakeholder or group from the list on the left-hand side of the window. 
3. The information on the right-hand side of the window may be modified for this stakeholder. This 

includes the stakeholder name and description, and the list of associated stakeholders if this is a 
group. 

4. Select “Apply” to make the changes. Changes will be propagated throughout the database. For 
example, if the stakeholder is renamed in this fashion, all references to the stakeholder name or 
group also receive this new name in the database.  

 
 

Deleting a Stakeholder 
To delete an existing stakeholder or group: 
 

1. On the “Stakeholders” tab, select the name of the stakeholder or stakeholder group from the 
list on the left, then click “Delete”. 

2. A verification screen appears asking if you wish to delete the stakeholder. 
3. Click on “Yes” or “No” to delete or cancel the operation. 

 
This will delete all associations between this stakeholder (or group of stakeholders) and any elements that 
are assigned to it. If the group designation for a group of stakeholders is deleted, then the groups element 
associations are also deleted. However, the stakeholders that were associated with the group still exist - 
only the group name is gone.  
 
It is recommended that the elements assigned to a stakeholder name or group to be deleted be reassigned 
to another stakeholder name or group on the “Inventory” tab before performing the delete. Deleting the 
stakeholder first will result in the interconnect and flow associations being wrong in the diagrams - there 
are many more permutations than there should be. If you reassign these elements to a new stakeholder 
first, the interconnect and flow associations from the first stakeholder are maintained.  
 
 

Working with Stakeholder Groups 
Stakeholder groups are used in those situations when more than one stakeholder may need to be assigned 
or is responsible for a single element, Physical Object, etc. They can be created, modified, deleted, etc. in 
much the same way as individual stakeholders. A stakeholder group can only include individual 
stakeholders, not other groups.  
 

1. To create a new stakeholder group, select “New” on the Stakeholder Tab. Check the “Stakeholder 
Group” checkbox. This name will be marked with a “group” icon to separate it from the others in 
the list. 

2. Enter the name and description of the new stakeholder group on the right-hand side of this screen. 
3. Associate already existing stakeholders from the list on the bottom right with this group 

designator, then click “Apply”. If you wish to cancel this change at any time, select the “Cancel” 
button. Notice that the list on the bottom right only includes stakeholder names, not groups. The 
right mouse button works as on other windows – it expands the list of stakeholders, then another 
right click shrinks the list back to its original size. 
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Inventory Tab – Managing Elements 
Looking at the RAD-IT screen we continue working our way from left to right across the tabs at the top. 
This section discusses the 4th tab – the Inventory tab. 
 

Inventory Tab General Information 
The Inventory tab provides a window where the user may create a new (or view an existing) element, and 
view all attributes associated with it, in the open architecture. A new user defined physical object, 
stakeholder, or project may be created via the pulldown menus or other tabs, and then associated with the 
inventory element on the Inventory tab window. RAD-IT guides the user in characterizing the element in 
terms of ARC-IT physical objects (subsystems, terminators, and user-defined). Physical objects, 
stakeholders, and projects are listed for each element, and items may be added to or deleted from these 
lists via the pulldown menus and other tabs. User inputs of multiple instances of an element are supported 
(e.g., two or more Emergency Management Centers in a region’s inventory).  
 
If the user performed service package analysis then removed a physical object associated with an element 
on the Inventory tab, information flows for this physical object association will still appear on the 
Interfaces tab after a building the architecture. They must be deselected manually on the Interfaces tab if 
no longer needed - items are only added, never deleted, by the “Build” option on the Interfaces tab that 
builds (or rebuilds) the architecture.  
 
Inventory elements can be one of 5 types: Transportation, Communication, Human, Environment. 

 
• Transportation elements are those that have existed since RAD-IT has been around. They 

represent an ITS or non-ITS element in the inventory for a regional or project architecture. They 
are named, associated with a stakeholder, given a status, described, associated with a physical 
object and, perhaps, to a project. They can be Normal, or Instance, or Shared. 
 Instances are used to represent elements that are more detailed versions of other elements. 

For example, a higher-level regional architecture may define roadway elements as simply 
“State Field Equipment” but later you may want to define “State Highway CCTV 
Cameras” and “State Highway Ramp Meters” with different interfaces and functions at the 
project level. Defining an element as an Instance allows you to retain the higher-level 
associations and be able to define different details. 

 Shared elements allow you to reference the fact that some elements may also be defined 
in other architectures, e.g. a statewide architecture. The other architectures are listed on 
the Start tab. 

• Communications elements provide a way to create an inventory element that may or may not 
provide a transportation related service but does supply important communications services to the 
region or project. 
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 Elements that are Communications type can either be Support Class or Field Class. 
Support Class Communications elements can be mapped to one of the following physical 
objects: 
 Data Distribution 
 ITS Communications Equipment 
 Wide Area Information Disseminator 

 Field class Communications elements can be mapped to: 
 Roadside Communications Unit 
 Pathway Communications Unit 

• Human elements are the human operators or users that interact with the system elements and 
devices. While no functionality can be assigned to a human element their interfaces can 
sometimes be instructive to reviewers of an architecture to see how users interact with the ITS 
elements. 

• Environment elements represent the things that the vehicle based or roadway sensors sense – the 
roadway environment, vehicles in traffic, potential obstacles, and vulnerable road users. 

 
Inventory elements can also be one of 5 Classes:  Center, Field, Personal, Support, and Vehicle. These 
correspond to the classes of physical objects that make up the ARC-IT physical view. In ARC-IT, a 
physical object represents a system or device defined in ARC-IT physical view, or a user defined (locally 
defined) object. In RAD-IT, each inventory element represents a physical object. Examples include the 
Traffic Management Center (TMC), the Vehicle Onboard Equipment (VOBE), and the ITS Roadway 
Equipment, corresponding to traffic operations centers, connected automobiles, and legacy ITS field 
equipment. 

• Center: represents the primary Administration or Management “Element”. This may 
often be a physical building (such as a Freeway Management Center) and include one or 
more physical object such as traffic management or transportation information 
functionality.  

• Field: represents the intelligent infrastructure distributed along the transportation network 
which performs surveillance, information provision, traffic control functions and whose 
operation is governed by a center object. Some field objects such as the Connected 
Vehicle Roadside Equipment (RSE) include the wireless communications to 
communicate directly with mobile devices, e.g. connected vehicles. 

• Personal: represents equipment used by travelers and personnel to access transportation 
services pre-trip and en route. This includes equipment that are owned and operated by 
the traveler as well as equipment that are owned by transportation and information 
providers. 

• Support: represents the computer systems required to ‘support’ the transportation related 
services and applications. These may include security, data warehousing, network 
administration, and system monitoring or management systems. 

• Vehicle: includes general driver information and safety systems applicable to all vehicle 
types. Light Vehicle Onboard Equipment (OBE) represents the functionality unique to a 
passenger vehicle or light truck. Specialty or fleet vehicle subsystems (Freight 
Equipment, Transit, Emergency, Commercial and Maintenance and Construction 
Vehicles) add ITS capabilities unique to these special vehicle types. Micromobility 
Vehicle (MMV) OBE represents functions that support efficient, safe, and convenient 
travel for bicycles and other low-powered mobility devices such as e-scooters, powered 
wheelchairs, and power assisted bicycles.  
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As you define inventory Elements in your architecture it will be important to know what class your 
element is a part of because this will be used to determine the specific physical objects to map it to and 
the types of communications that can be used. 
 

Inventory – Creating a New Element 
The RAD-IT Inventory tab is shown below 

 
 
To create a new element on the Inventory Tab: 
 

1. Select the “New” option on the lower left-hand side of the window. 
2. On the right-hand side of the window enter the element name.  
3. Select the type of element:   

a. Transportation (Normal) is the most common since they are completely defined within 
the current architecture.  

b. Transportation (Instance) is used to define an element as being an instance or sub-
element of another parent instance. You could have a fairly generic element defined like 
“ITS Field Devices” and then define Instance elements for Cameras, Signs, Detectors, 
etc. 

c. Transportation (Shared) or related elements are those that are defined in another 
architecture file. The pull-down list of Related Architectures is activated to choose the 
other architecture defined on the Start tab.  

d. Communication is used when you want to define an element that is part of the 
communications domain rather than a transportation system domain.  This would include 
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Data Distribution System elements or basic communication elements in your region or 
project. 

e. Human elements are the users or operators of the system elements. 
f. Environment elements represent the things that the sensors sense – examples include 

other vehicles in traffic, pedestrians or other vulnerable road users, or the roadway 
environment itself. These are important for the automated vehicle and vehicle safety 
service packages. 

4. Select the class (Center, field, personal, support, or vehicle) 
5. Select the Status of the element – does it already exist, is it planned, is it a future or other user 

defined status? See “Customizing Status Values.” 
a. Select the stakeholder. 
b. Enter a description (this is optional but you'll want it for your documentation and/or 

generated website). 
6. Then select the ARC-IT physical objects (subsystems, terminators, or user defined objects) to 

associate with the element. The right mouse button works as on other windows – it expands the 
list of physical objects, then another right click shrinks the list back to its original size. When you 
right-click to expand the list you can also see a read-only description from ARC-IT of that object. 
(See the notes below on assigning elements to physical objects and the section on Aggregation) 

7. Select the project(s) that this new element is to connect to. If working in a Project Architecture, 
the current project should be selected in order to connect the new element to the other elements in 
this project. To connect this element to elements outside this project but in the region, other 
projects in this database file may also be checked. If working in a Regional Architecture, to 
connect this element to elements in various projects in the region, select the appropriate project 
boxes. The right mouse button works as on other windows – it expands the list of projects, then 
another right click shrinks the list back to its original size.  

8. After entering the information on the right-hand side of the window, select “Apply” to add this 
new element to the database, or “Cancel” to abort the element creation. 

 
Stakeholders are now automatically included in a Project when they are created at the same time a new 
element is created for that project.  This way you don’t have to go back to the Stakeholder tab and do an 
Autoselect.  This does that step for you. 
 
Can I assign an element to map to anything and everything in ARC-IT?  Not Quite. RAD-IT is very 
flexible in how an element can be mapped to one or more physical objects from ARC-IT but it does 
impose some limits: 

1. It does not allow system type elements to contain human Physical Objects.  
2. If it is a Transportation type element then it must contain at least one transportation domain 

Physical Object.  
3. You cannot assign Communications domain element to a transportation domain physical object. 

 
Older Turbo and RAD-IT architectures provided more flexibility in this area so conversion will now 
check to make sure the rules above are followed. For example, during conversion, if a transportation 
element (like a TMC) is found that is mapped to only comm domain Physical Objects (like a Data 
Distribution System), the domain for the element will be switched to Communication. 
 
RAD-IT now supports new class level physical objects and allows special level objects to inherit the 
characteristics of the higher-class level objects. For example, there is now a physical object called the 
“Vehicle” and another object called the “Light Vehicle Onboard Equipment (OBE)”.  As a user creates an 
element for a passenger car they will select the Light Vehicle OBE as the physical object or if they are 
defining an element for an equipped transit bus they will select the Transit Vehicle OBE. Under the 
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covers, RAD-IT will also be mapping these elements to the new Vehicle object that will provide 
capabilities like basic safety, navigation, and information provision that any vehicle type will need. 
 
These class-level physical objects will be invisible to the user unless they choose to show them using the 
Options window.  In order to see those class level objects, go to File / Options and check the checkbox to 
“Show class level physical objects”.  

 
Previous versions of RAD-IT included Center and Field physical objects so now there are Vehicle and 
Personal class level objects. 
 
 

Inventory – Assigning a Stakeholder 
The Inventory tab includes a pull-down to assign a Stakeholder to an element. As the screen shows, this 
Stakeholder is the entity or organization that ‘owns’ or has primary responsibility for the existence of this 
element. Click the pull-down and scroll down the list of stakeholders created on the Stakeholders tab to 
find the one you want and click it. 
 

 
 
If you don’t see the stakeholder you want you don’t have to go back to the Stakeholders tab. You can 
simply click “<New Stakeholder>” and it will bring up a form to create a new stakeholder that can be 
used for this or any other element. 
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The “Details” button just to the right of the Stakeholder label on the Inventory tab is to support cases 
where, “It’s complicated.” Perhaps for your element there is an owner today but that is going to transition 
to someone else or you want to describe different roles that stakeholders have with respect to that 
element. For example, you may want to show who ‘owns’ the element but also who ‘manages’ it and go 
even further to identify the organization that will ‘maintain’ that element.  
 
ARC-IT defines 12 roles in the Enterprise View though RAD-IT currently lists Owns or Manages as the 
defaults which are typically what most regional and project architectures will focus on. 
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Again, if you don’t see a Stakeholder you want you can click on “New Stakeholder…” to bring up the 
New Stakeholder screen. From there, you can create and describe a new stakeholder for this element or 
any element in the project. 
 
The Element’s Stakeholders screen allows you to use the Role pull-down to select from various roles they 
could play and the Status column allows you to assign the Owns or Manages status for that Stakeholder / 
Role combination. 
 

  
 

NOTE: With the Element’s Stakeholders screen you can only have one Stakeholder/Role for 
each Status. That means you can’t have 2 planned owners of a center. If you do have the need to 
show a combination of ownership then create a Stakeholder Group made up of the stakeholders 
that will jointly own that element. 

 
 

Modifying an Element 
To modify an existing element: 
 

1. Enter the “Inventory” tab. 
2. Select the element from the list on the left-hand side of the window that you wish to modify. 
3. The information on the right-hand side of the window may be modified for this element. This 

includes the element name and description. If the element is renamed in this fashion, all 
references to the element also receive this new name. Click “Apply” to save your changes. 

 
Normally, elements will only be mapped to Physical Objects of the same class. There may, however be 
times when you need to define an element as being from more than one class. For instance, if your TMC 
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is also acting as a Map Update System for the region, while you are editing an element, change the Class 
pull-down to Support and select the Map Update System Physical object from that class.  
 
When you do this RAD-IT will warn you to make sure this is something you really want to do. 
 

 
 

NOTE: Elements have to be from the same Type/Domain. 
 

Deleting an Element 
To delete an existing element from the system inventory: 
 

1. Select the element on the left-hand side of the Inventory Tab window. 
2. Select the “Delete” button. The element associations are listed on the right, and a confirmation 

window pops up asking if this is really what you want to do. Select “Yes” to actually delete the 
element (and all of its associations) from the database, or “No” to cancel the delete. 

 
NOTE:  Deleting a TMC, for instance, connected with hundreds of information flows, could destroy 
a perfectly good Regional Architecture. It is recommended that you save the current architecture 
before the delete. 
 
 

Physical Element Instances 
The Transportation (Instance) type element is used to depict the relationship between a higher-level 
definition and a more specifically defined element. Choosing any one of the elements in the inventory 
will bring up a window to ask if you want the instance to automatically take on the other inventory 
attributes of the parent: description, stakeholder, status, and physical object mapping. Once you say Yes, 
edit the other attributes as needed and click Apply. Now on the left side of the screen the element that was 
just changed has a different icon to show that this element is now an Instance of some other element in the 
inventory. The attributes on the right side now show the Instance button selected and the name of the 
Parent Element is shown. The attributes of the instance element can also be changed independent of its 
parent by editing as you would edit any other element.  
 
To synchronize other attributes of the instance element, e.g. its service package mappings, functions, etc. 
go to the Tools section of the menubar and click the “Synchronize Elements” tool. Similarly, for Shared 
or Related elements a similar process is followed. The icon between the check-box and the name is now 
changed to represent the type of element chosen.  
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The attributes of this can still be changed by editing as you would edit any other element. For example, 
you may want to revise the description slightly to remind users that it is in another architecture and 
potentially any different interfaces being developed for this deployment that may differ from the 
original/related architecture.  

Physical Element Standards 
Traditionally, standards have been associated with communications interfaces in ITS. Now, ARC-IT 
associates standards with physical objects and these mappings have been made available to the elements 
of your physical inventory.  
 
What is the difference between Physical Standards and Communications Standards? Within ARC-IT, 
communications standards include all standards and specifications that make up part of the 
communications ‘stack’, as defined in the communications viewpoint. That is, any standards dealing with 
signaling (e.g., Ethernet), networking and transport (e.g., TCP/IP), middleware (e.g., HTTPS), 
cybersecurity (e.g. IETF X.509) and application layer specifications (e.g., GTFS). Physical standards on 
the other hand are more concerned with electrical, structural and environmental concerns (power, 
cabinets, temperature ranges etc.) of a particular device or type of device, such as a traffic signal 
controller. 
 
Physical object standards establish requirements for the physical device, including the physical 
workmanship or the functionality of the devices, e.g., ITE Advanced Transportation Cabinet standard and 
the US DOT Roadside Unit Specification. The physical standards also include standards to define 
cybersecurity protections.  
 
On the Inventory tab, a Physical Standards button is shown next to the Stakeholders button. 

 
 
If standards have been defined for the physical objects associated with an element the button will change 
to show a book or document icon: 

 
 
Not every element or physical object will have a physical standard associated with it. Only Transportation 
System type elements can have a physical standard.  
 
RAD-IT will determine what standards to associate with an element based on the physical object mapping 
and then based on the functional object mapping which comes after you have assigned your elements to 
service packages. An example might be a standard for a particular function like work zone traffic control, 
like NEMA’s TS 5 Portable Signals will only be mapped if you have an ITS Roadway Equipment 
element that is mapped to the Service Package MC06 Work Zone Management or TM19 Roadway 
Closure Management that have the Roadway Work Zone Traffic Control functional object.  
 
Highlight an element and to select the physical standards details click the “Physical Standards” button to 
bring up the Physical Standards Details screen. 
 

https://www.arc-it.net/html/methodology/vscomm.html
https://www.ite.org/pub/?id=e269b8d3%2D2354%2Dd714%2D51bb%2D023fbd90ddad
https://www.ite.org/pub/?id=e269b8d3%2D2354%2Dd714%2D51bb%2D023fbd90ddad
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On the Element’s Physical Standards screen you can see the Document # and Title for standards written 
for physical devices and systems. An Include column shows which standards have been ‘included’ or 
associated with this element. You can un-include standards or include standards for your element. As you 
make changes that are different than those imported from the ARC-IT reference the Override column will 
show that the selection is different than the default. 
 
Make your selections and click OK or Cancel. 
 

 
 
If you want to restore changes back to the default, click the “Restore” button and OK.  
 
 

Inventory Tab Tips 
GUIDELINE:  On the “Inventory” tab, the tool forces you to map to a physical object every element that 
is defined, either to an ARC-IT subsystem or terminator, or to a user defined physical object. 
 
GUIDELINE:  If an element or stakeholder name is to be changed or deleted from the Regional 
Architecture, you must return to the Regional Architecture “Inventory” step. 
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GUIDELINE:  In mapping the inventory, if there is a TMC (Traffic Management Center) element defined 
in the architecture, there should also be other elements in the inventory to connect this to, such as an TIC 
(Transportation Information Center) or EM (Emergency Management Center) elements. The 
interconnects between the elements and centers on the “Interfaces” tab will appear correctly if there is 
more than one center. 
 
GUIDELINE:  Inventory elements can either be Normal, Instances, Shared, Human, or Communications. 
At this point, you can only choose one type, so you cannot define a communications element that is also 
an instance or shared. Instances may need to be edited to show how they differ from their parents and 
Shared elements may need to be edited in coordination with the maintainers of the other architecture. 
 

NOTE: When a Human type element is created you won’t need to select a class – just the 
stakeholder and the physical object (terminator). 

 
Creating a Communications element for your regional or project architecture may be important to show 
stakeholders how a significant investment in networking or communications technology is going to be 
related to the Intelligent Transportation System. As a New element is created, given a name, assigned the 
communications type, and the user has completed a description, checked-off the appropriate stakeholder, 
and assigned it to a project(s). The icon between the check-box and the name is now changed to represent 
the fact that this element is a communications type element.  
 
CAUTION: You can change an element from a Human class to a System class (Transportation or 
Communications) but you will get a warning that this will invalidate the choices of physical objects you 
had before. You will need to add new Physical Object mappings or click Cancel to undo the change. 
 

Sorting the Inventory List 
The list of inventory elements may be sorted by element name, stakeholder, or ARC-IT physical object, 
by selecting a radio button at the bottom left of the screen. The default view is sorted by element. 
 
When sorted by stakeholder or Physical Object, the plus and minus symbols may be selected to expand or 
contract the list of inventory elements associated with each stakeholder or physical object. Selecting the 
stakeholder or physical object name also expands or shrinks the list of associated element names, but no 
attributes are displayed on the right-hand side of the window unless an element has been selected. 
 
 

View All Available Projects, and Objects 
All “tabbed list boxes” behave the same way. If you right-click on the box displaying stakeholders, 
Projects, or Physical Objects it expands or grows to allow additional entries to be visible. You may select 
or deselect physical objects by clicking the view Selected, Related, or All projects or physical objects 
buttons. To shrink the list back to its original size simply Right-Click again. 
 
 

Physical Object Aggregation and Replication 
Functionality of physical objects can be aggregated together into one physical center or the functions of 
one physical object from ARC-IT can be replicated across different physical centers within a region. 
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GUIDELINE:  The same element name may be mapped to two different physical objects (subsystems, 
terminators, or user defined). This is not an error. 
 
Aggregation means you can combine the functions of multiple physical objects, i.e., one center may be 
mapped into multiple parts of ARC-IT. 
 
A single computer complex may serve both TMC and EM functions. It still has to do the functions of 
traffic management and emergency management, but it does not have to be two different centers, two 
different computers, or even two different programs. An example of a stereo system comes to mind. A 
stereo system involves the Tuner and Amplifier functions. Some stereo systems have a separate Tuner and 
a separate Amplifier unit, possibly from two different manufacturers. Other stereo systems are based on a 
single unit called a Receiver that implements both functions. There are advantages and disadvantages to 
aggregation. 
 
Elements are mapped, that is linked to, physical objects based on their functions. In the example shown, 
the element “State DOT Freeway Operations Center” has two functions; it manages traffic and provides 
information to the traveling public. Therefore, it is mapped to two physical objects, Traffic Management 
Center and Transportation Information Center. 
 
If you think of the National ITS Architecture (ARC-IT) as a template with generic physical objects, 
mapping is a way to connect a specific, local element with a generic object based on the function of the 
element. 
 

 
 
Replication, another element mapping concept, simply means that a specific implementation of the ARC-
IT physical object may be repeated in different physical locations. That way, regions can have more than 
one of any given type of physical object. Using traffic management as an example, one center may be 
doing freeway management and another traffic management may manage the signals and other functions 
along the arterial streets. 
 
The “Inventory” tab in RAD-IT supports this process of deciding how to aggregate and replicate physical 
object functions across a region.  
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ITS and ITS Communications Objects 
The list of physical objects may show some from an “ITS” class. This means that they have 
characteristics – functionality, interfaces, security characteristics that could be common to any system in 
an ITS architecture. 
 

The ITS Object 
From the http://www.arc-it.net/ website we learn that the general 'ITS Object' includes core capabilities 
common to any class of object. 
 
As shown in the following figure, the ITS Object is at the top of the hierarchy of physical objects. The 
ITS Object includes the core capabilities and interfaces that may be included in any ITS system or device. 
Using the ITS Object, we can define these core capabilities and interfaces once in ARC-IT. Below the 
ITS Object are class-level physical objects that are used to define capabilities and interfaces that are 
common for a specific class of physical objects like “Center”. The specific physical objects like 
“Authorizing Center” and “Traffic Management Center” at the second tier of the hierarchy define the 
specific capabilities and interfaces for that particular ITS system or device. 
 

 
 
This physical object is included in the following Service Packages: 

• SU01: Connected Vehicle System Monitoring and Management 
• SU02: Core Authorization 
• SU06: Object Registration and Discovery 
• SU07: ITS Communications 
• SU08: Security and Credentials Management 
• SU09: Device Certification and Enrollment 

 
The ITS Object has 3 functional objects: 

• ITS Communications Support 
• ITS Management Support 
• ITS Security Support 

 
The mapping to the ITS Object will be transparent to most users. RAD-IT will automatically map the ITS 
Object to your element if it is also mapped to an ARC-IT subsystem physical object. If you have a 
traditional regional ITS architecture you may not notice a difference but if you start including support 
services in your architecture then you may notice some changes. The inventory tab will show the same 

http://www.arc-it.net/
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mappings that you already make to physical objects. The services tab will also be the same. Once you 
start including functionality and interfaces then RAD-IT will start adding mappings to the appropriate 
functional objects that are part of the generic ITS Object as well as the generic Center and Field physical 
objects as appropriate.   
 
For example, if you Autoselect functions (f-objects) then all elements will get the appropriate ‘system 
executive' and ‘system monitoring and diagnostics'. All elements mapped to subsystems get ITS 
Communication Support since they will need that basic functionality to support its interfaces. Because of 
the security requirements of the connected or cooperative ITS environment, any mobile element that 
communicates with any another Onboard Equipment (OBE) or Roadside Equipment (RSE) gets ITS 
Security Support. In addition, any mobile element that communicates with an OBE, RSE or Personal 
Information Device (PID) gets ITS Management Support. 
 
Let RAD-IT take care of these additional mappings to functional objects and requirements. These types of 
functions will be important to the system developers to make sure they are included in their projects in the 
future. These are also mapped to the appropriate standards which will also be important to consider. 
 

ITS Communications Equipment 
The Data Distribution System (DDS) physical object is for the movement and management of data within 
a region or between systems in a project. The ITS Communications Equipment is for when you want to 
show lower level communications – fiber infrastructure, satellite, municipal WiFi, etc. that is needed in a 
region to support ITS. The Wide Area Dissemination System is used to send messages to equipped 
vehicles using wide-area wireless communications such as satellite radio, terrestrial FM broadcast 
subcarrier, or cellular data networks.  Roadside Communications Unit (RCU) is used to provides wireless 
communications between roadside infrastructure and nearby equipped vehicles or mobile devices. It is a 
communications only device where the Connected Vehicle Roadside Equipment takes the 
communications functionality and adds software to support higher-level ITS applications. 
 
Back to the http://www.arc-it.net/ reference architecture, ITS Communications Equipment includes the 
communications hardware and software that supports secure, reliable communications. It provides the 
layered protocols and communications services and includes the physical network plant and network 
hardware that supports ITS communications. It also encompasses security services that protect 
communications and the management services that support network management. This physical object 
allows transportation stakeholders that are implementing their own communications solution to represent 
this implementation in their ITS architecture. The communications capabilities provided by this physical 
object are frequently purchased from a third party provider. When communications is a purchased service, 
the hardware and software included in this physical object are largely transparent to transportation 
stakeholders and may be transparent to the ITS architecture. 
 
This physical object is only included in the SU07: ITS Communications Service Package but that service 
is not available for including in RAD-IT since it is only used in ARC-IT to model communications.  
 
NOTE: RAD-IT does not let a user include service package SU07 ITS Communications in their 
architecture because it only includes ‘super flows’ that are really place holders to include other actual 
flows.  This was created to be able to analyze the communications requirements for physical objects in the 
ITS world. As you can see in the diagram below this service includes the ITS Object and generic flows 
called “ITS Information”.  The Pathway Communications Unit was added in 2023 for version 9.2 to 
represent equipment used to connect devices along pathways for indoors that support vulnerable road 
users or pedestrians going to a destination that may not be on a roadway, e.g., through a park or inside a 

http://www.arc-it.net/
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building. Follow the steps below to include communications equipment and use it on the Interfaces tab to 
show how information can be routed through these types of objects. 
 

  
 

In RAD-IT you can map an element to this type of object by selecting Communications as the Type and 
Support as the Class. Then you can scroll down the list of Physical Objects and click “ITS 
Communications Equipment.” 
 

ITS Communications 
Equipment

ITS Object Other ITS Objects

Wide Area 
Information 

Disseminator System

Roadside 
Communications Unit

Pathway 
Communications Unit

SU07: ITS Communications

9 Physical Mar 22, 2023 NAT

ITS Communications 
Services

ITS Communications 
Privacy Protection

ITS Communications 
Support

ITS Security Support

WAID Broadcast 
Services

RCU Radio 
Communications

PCU Communications local ITS information

 local ITS information  local ITS information

 local ITS information

 ITS information  ITS information

 ITS information  ITS information

ITS information

proxied ITS information

proxied ITS information

wide area broadcast ITS information ITS information

 ITS information

 ITS information

 local ITS information

 local ITS information

 local ITS information relay

The flows on this diagram are 
super-flows that represent all 
of the more specific 
information flows in all of the 
other service packages.  
Super-flows are not used in 
regional or project 
architectures so this service 
package is filtered by RAD-IT 
and SET-IT.
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Then on the interfaces tab you can choose this element as the communications element through which 
your system elements will communicate. 
 

 
 
When you create output diagrams this will appear as a oval shape where the flows between those two 
system elements are routed through the communications element. 
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Reassigning Element/Stakeholder Names 
You can reassign the element and stakeholder names on the “Inventory” tab to different regional physical 
objects (subsystems, terminators, and user defined objects), after initially creating the inventory. ITS 
projects may be reassigned to a different element, resulting in different associations with regional 
subsystems, terminators, and user defined objects. If you reassign portions of the Regional Architecture, 
the tool will be able to detect if conflicts and discrepancies are created only if projects have been created 
or service package analysis has been done. For example, if an element is assigned to one ARC-IT 
physical object, then later reassigned to another, a conflict may have been created. If that physical object 
is tied to a Project Architecture, you may generate the “Regional to Project Comparison” report that will 
warn you about conflicts between the Regional Architecture and the Project Architectures in the database 
file. 
 
You can also reassign the element and stakeholder names to different project physical objects, after doing 
the inventory the first time. You will be able to reassign the ITS project services (service packages) to 
different project elements (and indirectly, to different physical objects). If you reassign portions of the 
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Project Architecture, the tool will be able to detect if conflicts and discrepancies are created only if 
service package analysis has been done.  
 
It is your responsibility to ensure that any reassigning done in the Regional or Project Architecture does 
not conflict with the existing ARC-IT physical objects, and information flows, or with any tailoring that 
may have already been done. Changing the output of preceding steps may affect the entire architecture. 
However, the RAD-IT tool preserves previous customization, so this problem should be minimal. 
 
GUIDELINE:  You are allowed to reassign element and stakeholder names only by returning to the 
“Inventory” step. This may not be done on the “Interfaces” tab. Only the status of information flows, and 
whether or not a flow or interconnect is included in the architecture, may be changed during the 
customization step. 
 
 

Editing a Project Inventory 
The Inventory tab for projects varies in that you can use the left side to Include/Exclude elements in the 
project. Then you can use the Description field on the right to provide a note about the element and why it 
is or isn’t in the project. 
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Remote Access Device 
RAD-IT supports the inclusion of a Remote Access Device which is a subsystem from ARC-IT used to 
show when secure remote communications are being used by center and support system operators to 
access their center/support systems. 
 
To create an element mapped to a Remote Access Device on the Inventory tab, set the Class to Personal 
and then select the Remote Access Device physical object as shown below. 

 
 
Now that element is available to select as a communications device between the human system operator 
and their center or support class system.  See the “Communications / DDS” instructions in the Interfaces 
Tab section for more information. 
 
 

Services Tab – Managing Service Packages 
Looking at the RAD-IT screen we continue working our way from left to right across the tabs at the top. 
This section discusses the 5th tab – the Services tab. 
 

Service Package Basics 
In ARC-IT, a Service Package is a way of looking at subsets of each of the architecture’s view focused on 
a specific service or group of services. Service packages are derived from documentation like ConOps, 
System Requirements, standards, and other documents that have been written to describe parts of the ITS 
environment. It should be noted that this is not an exhaustive list - new services will be developed over 
time and the architecture modified appropriately. Service Packages are a concise, comparatively easy to 
read and follow set of diagrams and text that communicates notions of service delivery, functionality, 
information exchange and concerns related to those concepts. 
 
The “Services” tab allows you to associate inventory elements (and indirectly, ARC-IT physical objects- 
subsystems and terminators) with a service package, which may be represented as “existing”, “planned”, 
“not applicable” or a local status value, for the project or region. When a service package is selected, all 
information and attributes pertaining to that service package in the architecture appears on the right-hand 
side of the window. This includes the element names, project, and status of the service package, as well as 
a user defined comment pertaining to the service package assignments. Instances of service packages can 
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be created to represent the variations that may exist across a region or among projects in the way in which 
a service is implemented.  
 
The “Services” tab includes ITS-related projects and services for a region. The tool guides you in 
characterizing the projects for a region in terms of ARC-IT service packages. When a service package is 
selected from the list on the left, all information and attributes pertaining to that service package in the 
architecture appears on the right-hand side of the window. This includes the element name, project, and 
status of the service package, as well as a user defined comment pertaining to the service package 
assignments. There are also items on this window that may not be changed - service package id, name, 
and description.  
 
On the “Services” screen, stakeholders are not associated directly with a service package. They are 
associated indirectly with service packages via the associations of each stakeholder to the elements on the 
“Inventory” tab. The “Services” tab lists elements and projects selected for each service package. 
 
The “Services” tab may be used in the following situations: 
 

1. The “Services” tab is allowed before or after customization. 
2. In a Project or Regional Architecture, element to information flow associations, plus any 

customization that may have been done in the Project Architectures, will be maintained. 
3. When creating a Project Architecture when a Regional Architecture exists, a set of elements and 

flows (perhaps including customization) has already been selected. The “Services” tab is allowed. 
The “Build” step on the “Interfaces” tab to build the architecture will actually only add new 
interconnects and information flows that may result from associations made on the “Inventory” 
and “Services” tabs. All customization is maintained, and no flows are deleted by the “Build” 
step. Flows may be deselected on the “Interfaces” tab.  

4. When creating a Project Architecture when a Regional Architecture does not exist, the “Services” 
tab is allowed. 

 
You are able to select service packages from several different projects and connect them together in a 
Regional Architecture. In this way, portions of various Project Architectures may be merged into the 
Regional Architecture. 
 
 

Services Main Tab 
The Services tab works in a similar way to the Inventory tab - select a service package on the left, and the 
various attributes of the service package are displayed and (most are) editable by the user on the right. 
Service packages are grouped by the areas of high-level ITS services as in ARC-IT. 
 
The list below shows the ITS Service Package Areas and their abbreviations used on the Services tab in 
RAD-IT: 
 

• Commercial Vehicle Operations (CVO) 
• Data Management (DM) 
• Maintenance and Construction (MC) 
• Parking Management (PM) 
• Public Safety (PS) 
• Public Transportation (PT) 
• Support (SU) 
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• Sustainable Travel (ST) 
• Traffic Management (TM) 
• Traveler Information (TI) 
• Vehicle Safety (VS) 
• Weather (WX) 

 
The left-hand frame has tabs to only show service packages that the user has selected for the current 
architecture (region or project) or to view all service packages by selecting the All Service Packages tab 
on the left-hand side of the window. The “All Service Packages” View allows the user to easily select 
additional service packages for the region or project.  
 
The left-hand frame includes check-boxes to include or uninclude the service package into the current 
architecture. Any changes made on the left hand frame in this way must be applied (click “Apply”) first 
before being able to edit any of their attributes on the right. 
 
The right-hand frame includes the service package id, name, and description for the selected service 
package as a convenience to the user. These come directly from the ARC-IT and may not be changed. All 
other fields in the right-hand frame may be changed by the user. 
 
The right-hand controls allow the user to view or update project assignments, element assignments, status, 
and comments (e.g., why the service package is or is not appropriate for the region or project) for the 
selected service package. 
 

 
 
In the regional view, the selected elements and selected projects are displayed. The user may deselect any 
element or project from the list. Displaying all projects or all related elements may be desirable in order to 
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see all that are available. For elements, the user can click on “Regional Elements” to see the list of all 
elements included in the regional architecture that are appropriate for this service package and decide 
whether to include or un-include them. In addition, there may be some that are in projects but not in the 
regional architecture - that superset list can accessed using the All Elements tab. Similarly, for projects, 
click All Projects to see the complete list of projects that could be associated with this service package. 
 
Once the user makes any change to one of the right-hand side controls, the user is given the “Apply” and 
“Cancel” options. The user can change any or all of the available attributes and then select “Apply” to 
commit the changes to the RAD-IT database file. Selecting “Cancel” aborts the changes and returns all 
attributes to their original state. Once “Apply” or “Cancel” are selected, they are disabled until the user 
makes another change to the right-hand side associations. The left-hand service package list is disabled 
since the user must choose to “Apply” or “Cancel” the changes before moving on. Once the user has 
selected “Apply” or “Cancel”, the list of service packages is again enabled. 
 
The Project Service Packages tab shows which service packages are included in the project and the 
checkboxes are there to change the mappings if desired. On the left-hand pane there is an icon - a blue 
circle with a check mark or an X - to signify whether the service package is also part of the regional 
architecture.  
 
The right side of the screen is also slightly different for a project architecture. The status is the status of 
the service package as it pertains to the current project (not the entire database). The elements area now 
has tabs for Selected Elements, Project Elements, and All Elements. There may be elements selected for 
this service package labeled as “Not in Project”. These are inventory elements that are in the database and 
can be used to support this service package but they are not mapped to this project on the Inventory tab. 
This is OK - think of a project that is adding a few cameras to a larger system where the center is already 
built. 
 
On the Project Service Packages window an additional area is included above the comment to indicate 
whether or not the highlighted service package is part of the regional architecture and if so what the status 
of it is in that other architecture. 
 

View All Service Packages 
To view all service packages, select the “All Service Packages” tab on the left-hand side of the Services 
window. 
 
This allows you to easily select additional service packages for the region or project without leaving this 
screen. You can select any service package on the left and alter the properties on the right.  
 

Instances of a Service Package 
On the “Services” window, notice that two buttons become available at the lower left of the screen. These 
options allow you to create, modify, and delete instances of a service package. RAD-IT allows instances 
of a service package to be defined for a regional (or project) architecture. For example, several traffic 
surveillance service packages could be defined, one for each TMC that provides traffic surveillance in a 
region. Alternatively, different service package instances could be defined for different status (existing / 
planned / local status) levels. Service package instances allow the services that are planned in the region 
to be identified with better accuracy and fidelity, improving support for the DOT regulation/policy. This 
feature allows a Regional ITS Architecture to be reviewed and customized almost entirely using a service 
packages view. 
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GUIDELINE:  It is fine to use service package instances for some service packages and the general ARC-
IT service package for other service packages in your architecture definition. For example, you might 
create instances for service packages that are broadly implemented in the region (e.g., traffic surveillance) 
and use just the ARC-IT parent service package where the service is only implemented by a single center. 
If you decide to use service package instances, it is good practice to remove all element and project 
associations from the related ARC-IT parent service package. The reason to do this is so the general 
relationships defined in the ARC-IT parent service package don’t override or negate the specific 
relationships that are defined in the service package instance. 
 
In other areas of RAD-IT: 
 

• Service package instances are available when enabling the service package based filter which 
provides filtering based on a specific service package instance in the RAD-IT Diagrams, RAD-IT 
Tables, and “Interfaces” tab when selected.  

• Service package instances may also be viewed on the “Service Packages” output tables. 
• RAD-IT uses the specific service package instance information entered to determine the changes 

that are made to the “Interfaces” tab by the build algorithm. 
• RAD-IT conversion preserves service package choices made in previous versions of RAD-IT (or 

Turbo). A single service package instance will automatically be created for each service package 
that is included in a converted architecture. 

 
The following describes the options available to create and delete a service package instance: 
 

• “New” – On the left side of the SP tab, highlight a parent service package and click “New” to 
Create an instance of that service package. Give the instance a name (the default is the name of 
the selected service package with “(Instance <number>)” added). Then you can assign it to 
various elements and projects in the region, enter an optional description, and all other attributes 
as described above. Perhaps an instance of a service package is being created for every element or 
center associated with the primary service package. When the selections are made, click “Apply” 
to accept the additions or changes, or “Cancel” to abort the change. 

• “Delete” - Delete an instance of a service package. Select the instance, click “Delete” (note that 
only a service package instance may be selected causing “Delete” to become available - a primary 
service package cannot be deleted). A popup window asks for verification. Click “OK”. The 
“Delete” option is only available if instances of any service packages exist. 

 

View All Available Projects and Elements 
To view all elements or projects that may be associated with the selected service package right-click on 
the list box. You may then select or deselect an element or project. Right clicking on the list box again 
toggles it back to the original size. 
 
Now you can see many more of the available projects or elements that may be mapped to this service 
package. The projects or elements that are checked are those that are selected for the current service 
package. These are displayed when you select the “Selected Elements” or “Selected Projects” tabs. The 
“All Related Elements” and “All Projects” tabs are used to make other selections within the Project or 
Regional Architecture for the selected service package. The related projects and elements are always 
displayed at the top of the list with other candidates listed below in alphabetical order.  
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The same is true if deselecting a project. This must be done on both the “Inventory” and “Services” tabs. 
A project can apply to more than one service package, or to parts of different service packages. 
 
 

Change a Service Package to Project or Element Association 
Once any change to one of the right-hand side associations for a selected service package is made, you are 
given the “Apply” and “Cancel” options. You can change any or all of the available attributes and then 
select “Apply” to commit the changes to the RAD-IT database file. Selecting “Cancel” aborts the changes 
and returns all attributes to their original state. Once “Apply” or “Cancel” are selected, they are disabled 
until you make another change to the right-hand side associations. The left-hand service package list is 
disabled since you must choose to “Apply” or “Cancel” the changes before moving on. Once you have 
selected “Apply” or “Cancel”, the list of service packages is again enabled. 
 
NOTE: about the association of elements to service packages.  With the introduction of class-level 
physical objects like Center and Vehicle where the lower level or specialized objects like Transit 
Management Center or Transit Vehicle OBE inherit some of the general interfaces and functions of the 
higher level object there needs to be some special handling of what happens an element is mapped to a 
service package.  Behind the scenes, RAD-IT will make the element assignment to service packages 
Physical Object-specific and make the connection based on the Level 2 (or specialty) Physical Object 
mappings whenever possible. For example, if an Element Mapped to Transit Vehicle OBE (level 2), 
‘Vehicle’ (level 1), and ‘ITS Object’ (level 0) is mapped to a service package that includes both a Transit 
Vehicle OBE PObject and a Vehicle PObject (PT12 Transit Vehicle at Station/Stop Warnings for 
example), then the updated algorithm should be updated so that the mapping is made specifically to the 
Transit Vehicle PObject. If there is no Transit Vehicle OBE in the associated SP, then the mapping should 
be made to the Level 1 Class PObject. For completeness, if no Level 1 PObject is available, then the 
updated algorithm should make the mapping based on the ITS Object, but that test case likely won't arise 
outside the support SPs.  All of this is done to avoid incorrect interfaces being created when a build is 
done on the Interfaces tab.  In the situation with PT12 above we don’t want to see an Equipped Transit 
Bus being connected to a private vehicle’s driver or their basic vehicle equipment.   
 
There is also some hierarchy for human based objects. For example, if the user defines a “My Transit 
Vehicle Operator” element that is mapped to the Transit Vehicle Operator Physical Object, then that 
element would also be mapped to the Level 1 “Driver” Physical Object.  This allows the RAD-IT build to 
build interfaces to the Transit Vehicle Operator element even if the triple in question goes between the 
Level 1 Vehicle and Driver in the related SP. 
 

Entering Comments 
The Services Tab has a Comments field on the right side that is optional but allows the user to make a 
comment about a particular service package – why it was included, why it wasn’t included, or perhaps a 
note about what elements may be participating or not in this service package. 
 

“Not Applicable” Status on Services Tab 
NOTE: The status “Not Applicable” is listed on the “Services” tab for a variety of reasons, listed 
in the guidelines below. If a “Not Applicable” service package is associated with an element in 
the architecture (but not with the project), the flows associated with this service package will 
appear as “Not Applicable” on the “Interfaces” tab after a Build. This may or may not be what 
you intended. If it is what was intended, these flows may be included in the architecture later. If 
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this was unintentional, then changing the status of the service package on the “Services” tab and 
re-building will have no effect on these flows (they have already been added, so will not be added 
again). You must change the flow status for each flow (or click the “Include” box) on the 
“Interfaces” tab. However, changing the status of the service package AND assigning the service 
package to this project on the “Services” tab, THEN re-building, will change these flows to 
“Planned” or “Existing” (and the “Include” box will be checked) on the “Interfaces” tab. 

 
GUIDELINE:  If a new service package has been selected for this architecture on the “Services” tab, and 
you simply begin associating elements and projects to it, the status remains unchanged. The status of a 
newly selected service package with no previous associations defaults to “Not Applicable”. This must be 
changed to “Existing”, “Planned”, or a local status, in order for its flows to actually be included later on 
the “Interfaces” tab as part of this project. 
 
GUIDELINE:  “Not Applicable” is available on the “Services” tab so that a list of additional flows may 
be associated with elements in the project on the “Interfaces” tab, creating additional possibilities for 
integration. This status is also available on the “Services” tab so that you may enter a comment about why 
a particular service package is not going to be used in the Project or Regional Architecture. On the 
“Interfaces” tab, these flows are listed as not included in the project - the “Include” box is not checked for 
these flows. These flows may be included later by checking the “Include” box, and the flow status may be 
changed to “Existing” or “Planned”. 
 
One reason “Not Applicable” is available on the Services tab so that the user may enter a comment about 
why a particular service package is not going to be used in the Project or Regional Architecture. On the 
Interfaces tab, these flows are listed as not included in the project - the “Include” box is not checked for 
these flows. These flows may be included later by checking the “Include” box, and the flow status may be 
changed to “Existing” or “Planned” or a local status value. 
 

Add a Service Package Association to a Project 
New elements are created on the “Inventory” tab. However, additional information flows are sometimes 
required later to enhance an architecture, or to make it more complete. These may be added to the 
architecture by selecting a new service package to add to the architecture.  
 
If elements have been created on the “Inventory” tab, then one way to add flows to the architecture is to 
add service package associations for these new elements. Another way to add flows to the architecture is 
to simply make Physical Object (subsystem and terminator) associations on the “Inventory” tab for the 
new elements. This will pull in information flow and interconnect associations from ARC-IT for the new 
elements. 
 
To add a new service package to an element, go to the “Services” tab and select the service package. 
Check the status (“existing”, “planned”, or a local status), then make the element selections. This will 
connect these elements together via the flows that will be added to the architecture by the new service 
package selection. 
 
In addition, if working in a Project Architecture, you must check at least the current project box to add 
these flows to the project (later, on the “Interfaces” tab, the “Include” box will be checked for these 
flows). To connect these flows to elements in other projects in the region, check the other appropriate 
project boxes. For a Regional Architecture, check the projects whose elements are to be connected by the 
new flows. If your database file only includes a Regional Architecture and no projects, then there would 
be no project associations for an element or service package. Select “Apply” or “Cancel”. 
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Finally, to add the new service package and its associated flows to the architecture and to the “Interfaces” 
tab for customization, select the “Build” option on the “Interfaces” tab to build the architecture. 
 
 

Service Package Autoselect 

 
The Planning Tab allows transportation goals and objectives to be defined and related to performance 
measures and service packages. If a user defined goals and objectives on the Planning Tab and related 
them to ARC-IT Service Packages, the user now should come to the Services Tab and use the Autoselect 
button to transfer those service package selections from the Planning tab to the Services tab. The other 
possibility is that the user could have edited the Needs for the architecture on the Needs tab and made 
changes to the service package mappings to Needs. 
 
Pressing the Autoselect button on the Services tab will open the following window: 

 

 
 
The user is provided the option to either Options include whether to Add Services Packages selected on 
the Planning tab or to Remove Service Packages not selected by the Planning Tab. The user can also click 
the Needs Tab Consistency Options button add Service Packages that are selected on the Needs tab or 
remove the ones that aren’t. 
 
Once the user selects the option and selects continue, the next screen will show the service packages to be 
added or removed based on the analysis of the Planning Tab selections. 
 

Service Package Search 
If you need assistance in selecting service packages, you can perform a search to identify service 
packages related to an objective or strategy. You perform a search by selecting the Search button on either 
the Planning Tab (right side of the tab) or the Services Tab (on the left side).  
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There are three ways to search for service packages: 

1. First, you can search for service packages that support an ITS goal. There are 8 ITS goals 
identified from which you can select one using the pull down menu. Once a goal is selected, you 
press the Go button or combine the Goal Search with the other two criteria. 

2. There are many defined transportation related objectives from which you can select one using the 
pull down menu. Once an objective category and objective has been selected, you press the Go 
button to perform the search or continue to the content based search. 

3. Enter keywords or other text that will be used in a content search of the Service Package titles and 
descriptions. 

 
Once the criteria are set, the Go button may be pressed to search for service packages that meet all 
supplied criteria.  
 
Checkmarks indicate which service packages are:  

 already associated with the current objective/strategy when the search is performed from the 
Planning Tab, or  

 already included in the architecture when launched from the Services tab. Highlighting one of 
the resultant service packages will cause the description to be displayed in the box below.  

 
Use the Show Diagram button to display a graphic of the Service Package from ARC-IT. Use the Hide 
Diagram to restore the display back. Click or unclick the checkboxes to add or remove the service 
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packages. Then click Apply to incorporate the changes into the architecture. Or select Close to exit this 
window and return to the main RAD-IT window. 
 
 

User Needs Tab 
Looking at the RAD-IT screen we continue working our way from left to right across the tabs at the top. 
This section discusses the 6th tab – the User Needs tab. The User Needs tab allows you to associate needs 
with your regional or project architecture. It starts by presenting the needs from the ARC-IT database that 
are developed for each Service Package selected in the architecture.  
 
A user need is a capability that is identified to accomplish a specific goal or solve a problem, specifically 
to be supported by the intelligent transportation system. It describes “what” is needed while avoiding the 
implementation specifics, or the “how.” Each need is identified uniquely, contains a description, which 
when worded properly includes a rationale. That rationale may include examples of how the system 
capability may be exercised. 
 
In a systems engineering project a set of needs are part of the Concept of Operations to explain or justify 
what is driving an agency to create a new system or update what they have. Typically, in a Concept of 
Operations the System Needs are designed to answer two basic questions:   

• What does the System need to do? 
• What do users need from the System? 

 
 

Autoselect Needs 
You can use the AutoSelect Button to let RAD-IT pull in the Needs from ARC-IT’s database that were 
written for each of the Service Packages included in your architecture as shown below: 
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The options on the Autoselect tool here allow you to: 

• Add Need Areas 
• Select Needs for new Need Areas 
• Remove Irrelevant Need Areas and Needs 

 
The Options buttons on the Autoselect tool are to either: 

• Update the current architecture (see the white box at the top of the tab area to see which 
architecture is currently selected). 

• Update all architectures in the file. 
 
When you use the Autoselect Need Areas and Needs feature it will add a “Need Area” for each Service 
Package selected. A Need Area is just a way of organizing your stakeholders needs and service packages 
provide a good starting point to that organization. You can also use the New Area button later to add your 
own. 
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Search for Needs 
The Search button on the Needs tab lets you search the database to look for a particular need that may 
match your own region or project stakeholders needs.   
 

 
 
When you click the Needs button you can filter the search by Need Area Type, e.g. Mobility, Safety, etc.  
Then you can enter a string of text to search by.  As you type the table of needs will be populated with the 
Needs from ARC-IT or user defined needs that you may have already written that have that word or 
phrase. 
 
NOTE: to see the entire text of the Need hover your mouse over the field and a tool tip will pop-up to 
show then entire text of the Need.  You can also make the column wider. 
 
If you click the Include box the Apply/Cancel buttons will be activated.   
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NOTE: not every service package is included in the scope of the search. For instance, SU07 ITS 
Communications is excluded from this search function because users are not able to include that generic 
service package in their architecture. 
 
Once you click Apply a new Need Area will be created with the selected Needs. Or you can click the 
Cancel button to undo those selections. 
 
Click the X to close the Search window. 
 
Then back on the Needs tab you will see new Need Areas to indicate the service packages that the new 
needs came from. A comment will show that the needs were selected based on a search, as opposed to an 
Autoselect that is based on service packages then needs. 
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TIP: After doing a Search to add needs to your region/project, edit the name of the Need Area to match 
your region or project. 
 

Customizing Need Areas 
Once you have a need area created by RAD-IT using the Autoselect button you can customize the 
imported Needs by editing the Name, Order, or Description.  
 
What is a Need Area?  A Need Area is just a collection of Needs.  
 
In ARC-IT needs were written for every service package so one way to organize needs is to let RAD-IT 
autoselect the needs and create Need Areas for each service package in your architecture. You can also 
decide to organize your needs differently by creating your own Need Areas. 
 

 
 

NOTE: if you decide to change the Name, Description, or Service Package mapping for a Need 
Area then it may no longer match what RAD-IT generated for you. You can change those settings 
and wording but just beware that it may no longer be consistent. If you want to have Need Areas 
that are different than the ones that RAD-IT automatically generated then create your own Need 
Areas. 

 
Need Areas have an Order number associated with them to know in which order they should be sorted in 
the output tables and documentation. It must contain a number and must not be left blank. 
 
It is possible to change the Service Package mapping for a Need Area. This may lead to undesired 
outcomes since most Need Areas are automatically associated with an ARC-IT Service Package when 
they’re Autogenerated. If you change the service package associated with a Need Area that already has 
associated ARC-IT Needs, then you will get a warning that the ARC-IT needs associated with the Need 
Area will be removed if you decide to continue. This check is smart enough to allow Service Package 
changes without warning if you are simply changing from one instance to another of the same service 
package, if you are creating a new need area, or if you have otherwise not yet associated needs with the 
Need Area. If you are warned and answer ‘Yes’, the Service Package change is made and the ARC-IT 
needs are removed from the Need Area. If you answer ‘No’, you are returned to the tab with ‘Apply’ and 
‘Cancel’ enabled, just like with other validation errors. 
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Customizing Needs 
Once the Need Areas are defined the user can select and customize the needs for the regional or project 
architecture. 
 

 
 
Note as we started typing in the Need text box above the color of the Need icon changed to Green and a 
“User Defined” indicator appears next to the Applicability box. 
 
Customizations made to the text of a need will result in a User Defined need for your architecture. Any 
requirements that had been mapped to the original need will now be mapped to the user defined need on 
the Functions tab. 
 

Needs Tab General Information 
The needs tab is populated with data either using the Autoselect button to pull in Need Areas and Needs 
based on the Service Packages are selected for your architecture – region or project. You can also use the 
“New Area” and the “New Need” buttons to add your own need areas and needs. 
 

TIP: If the Needs tab is blank it is probably because no services packages have been selected; go 
back to the Services tab. Alternatively the Needs tab may be blank because the AutoSelect step 
has not yet been performed for the architecture. 

 
The left side of the screen shows a list of Need Areas as a set of folders. Click each folder icon to expand 
the list and see the Needs for that Need Area. 
 
When you use the Autoselect Need Areas and Needs feature it will add a “Need Area” for each Service 
Package selected. A Need Area is just a way of organizing your stakeholders needs and service packages 
provide a good starting point to that organization. You can also use the New Area button later to add your 
own. 
 
Adding a need to your architecture is done by either Checking the box on the left side of the screen next 
to the need or by Highlighting the need on the left and changing the Applicability on the right to 
Applicable from Not Applicable. 
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This tab works like other tabs in that you can select and make changes on the left of the screen and the 
Apply / Cancel buttons will activate on the left side. Or as you select a need on the left and make changes 
on the right then the Apply / Cancel buttons will activate on the right side.  
 
RAD-IT is pre-loaded with the service package based needs from ARC-IT, the reference architecture. 
You can select and edit them for your region or project’s needs. 
 
Alternatively, you can add Needs to your region or project by simply clicking New on the left side and 
entering the information on the right. 
 
Unchecking a Need Area will un-Include that need area from the current architecture. It may still be 
available for other architectures in the file. When a Need Area is Un-Included the Needs under it are also 
un-included.  
 

Adding a New Need Area 
Click the “New Area” and you can give it a Name, assign an Order to govern how need areas can be 
sorted in the outputs, Type (as in type of Service Packages, see ARC-IT). Service Package, and a 
Description. As shown in the example, you don’t need to assign a service package for a Need Area; in 
fact, it may be a general collection of needs that will apply across the board for a region or project. 
 

 
 
Click Apply to add it to the list or Cancel to cancel the change. 
 

Adding a New Need 
Highlight a Need Area or a Need and Click the “New Button” button. This will set up the right side of the 
screen to let you add a new need to the Need Area you are in. You can also use the pull-down to change 
the Area or leave it where it is. Then you can give the user defined Need a Number, the text of the Need, 
and an optional comment. Use the Applicability pull-down to assign it to the current architecture – the 
choices are Applicable or Not Applicable. There is also room on the form to assign the new need to a 
project if there are any in the file at the time. The Number field is required – it will not let you exit the 
form without a number to support traceability between needs and requirements later. 
 



110 

  
 
Click Apply and the new need will be added in the order it should be based on the number and will show 
a Green “N” to highlight the fact that it is User Defined. 
 
RAD-IT will warn you if it detects a duplicate need. 
 

 
 
The “Delete” key at the bottom of the left side of the screen lets you delete either a Need or an entire 
Need Area from the file. You will be prompted to verify that this is what you really want to do. 
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Roles & Responsibilities Tab (R&Rs) 
Looking at the RAD-IT screen we continue working our way from left to right across the tabs at the top. 
This section discusses the 7th tab – the R&R tab. 
 

Roles & Responsibilities General Information 
An Operational Concept for a Regional ITS Architecture captures each stakeholder’s current and future 
Roles and Responsibilities in the implementation and operation of the region’s transportation systems. For 
ITS Projects, the term “Concept of Operations” may be more familiar but contains essentially the same 
elements - roles and responsibilities for each of the stakeholders as they pertain to the major areas of 
services to be provided. Roles and responsibilities can be generally defined at a region wide level or they 
can be service specific (e.g., SDOT operates and maintains the freeway system and also provides incident 
images to support incident management). Roles and responsibilities can also be defined once for a 
stakeholder group if the same roles and responsibilities apply to each stakeholder in a stakeholder group. 
 
There are a number of ways in which Operational Concepts can be developed and documented. The 
Regional ITS Architecture Guidance Document contains more information on the topic. 
 
RAD-IT provides a flexible user interface for you to identify the major ITS Areas that you will need to 
capture, assign stakeholders to each of those areas, and then write the Roles and Responsibilities for each 
of your stakeholders.  
 
This feature was developed to primarily support Regional ITS Architecture developers that are carrying 
out the requirements of the FHWA CFR 940.9(d)3 and FTA Policy 5.d.3. However, this feature can also 
be used in Project Architectures to document portions of a Concept of Operations for the project. 
 

Role and Responsibility Areas 
The R&Rs tab is where you can enter Role and Responsibility Areas for the stakeholders. RAD-IT 
provides the user with an “Autoselect” tool that will build a default set of areas based on the service 
packages that have been selected and then presents the user with the list of stakeholders that are assigned 
to the appropriate inventory elements. For a new architecture, the users will need to first document their 
stakeholders, develop their inventory of elements (with stakeholders assigned), and select service 
packages on the Services tab.  
 
The buttons on the bottom allow the user to create “New” Role and Responsibility Areas or “Delete” 
them. The more experienced user might opt to create his own areas using the “New” button, instead of 
using the architecture defaults that the “Autoselect” option will provide. 
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When the user makes changes to the name, description, selected service packages, or selected 
stakeholders; the user will need to hit the “Apply” button to save the changes or “Cancel”. 
 
The left hand side of the R&Rs screen shows the Role and Responsibility Areas that have been added for 
this Regional ITS Architecture. For a new architecture, you will need to first document the stakeholders, 
develop inventory of elements (with stakeholders assigned), and select service packages on the Services 
tab.  
 
Once that is done, you may use the R&Rs tab to either develop your own areas or let RAD-IT create a 
default list of areas by clicking on the “Autoselect” button. Options are shown allowing users to decide 
how much to add to the R&R window - new areas, new stakeholders within the new areas, and any 
default roles and responsibilities for those new stakeholders.  
 

 
 
Based on the service package selections and changes made on the Services tab, RAD-IT will fill in the 
left side of the screen with a list of areas for the regional or project architecture based on the Service 
Package selections. Each area that RAD-IT adds roughly corresponds to the major Service Packages or 
groups of service packages: Traveler Information, Freeway Management, Transit Services, etc.  
 
NOTE that RAD-IT automatically builds names for the Role and Responsibility Areas that include both 
the generic area name (e.g., Parking Management) and the architecture name (e.g., Marinara County). 
This allows the same default areas to be used or tailored for both Regional and Project Architectures.  
The user can see only the role and responsibility areas included in the current architecture or see all areas 
that have been defined in the file using the “Regional Areas” for a Regional Architecture, “Project Areas” 
for a Project Architecture, or “All Areas” tabs. 

 
Or  

 
The following is a list of the default Role and Responsibility areas that RAD-IT can create based on your 
service packages: 
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- Commercial Vehicle Operations 
- Data Management 
- Electronic Toll Collection 
- Emergency Management 
- Freeway Management 
- Incident Management 
- International Border 
- Maintenance and Construction 
- Parking Management 
- Road User Payment 

- Security 
- Support 
- Surface Street Management 
- Sustainable Travel 
- Transit Services 
- Traveler Information 
- Vehicle Safety 
- Weather 

 

 
For each Role and Responsibility area, whether created from scratch or added by RAD-IT, you can edit 
the Name and Description on the right hand side of the screen.  
 

NOTE: The “Included in Regional Architecture” box is checked by default for both a Regional 
and a Project Architecture. This box associates the highlighted Role and Responsibility Area with 
the Regional Architecture.  

 
As a R&R area is included in your architecture RAD-IT will also include the stakeholders that own 
elements that are part of the service packages in each area. 

 
The “RR” icon will be displayed over the icon folder if roles and responsibilities have been written for the 
stakeholders within that Role and Responsibility Area. 
 
Below the Description of the Role and Responsibility Area, you can associate one or more service 
packages with each area. When RAD-IT adds the areas it will preselect the service packages appropriate 
to that area (for example, traveler focused service packages are in the Traveler Information area). Only 
service packages that have been associated with the architecture on the Services tab can be selected here. 
 
The Service Packages area has 2 buttons - “Selected” and “All”. If the user wants to add service packages 
to a Role and Responsibility Area, perhaps in addition to what RAD-IT’s Autoselect picked up, use the 
“All” button to check off any service package in the architecture. 
 

 
 



114 

Below the Service Packages list of the “Role and Responsibility Area” is where stakeholders are mapped 
to each area. A default list of possible stakeholders is based on 3 things: 

a) the service packages assigned,  
b) the service package to inventory element associations, and the  
c) inventory element to stakeholder associations created by the user.  

The user must make these stakeholder assignments based on the needs of the region or project.  
 
There are 3 Stakeholder buttons - “Selected”, “Related”, and “All”. “All” stakeholders shows all 
stakeholders that are associated with the architecture, e.g., allowing the user to select other stakeholders 
that are not on the recommended list.  
 
The user may enter more than one stakeholder for each Role and Responsibility Area. “Selected” shows 
the stakeholders that have been selected for the area. “Related” shows only the stakeholders that are 
associated with the selected service package(s). There are some cases when the “Related” stakeholders 
may be blank because RAD-IT cannot determine what the related stakeholders should be. This happens 
when: 1) the user has not associated any service packages with the Role and Responsibility Area, or 2) the 
user changes the selected service packages for the region.  
Below the Stakeholders list on the “Role and Responsibility Area” is the project assignment area. There 
are 2 Project buttons: “Selected” and “All” projects. This is only visible when a Regional Architecture is 
currently selected. 
 
Once the stakeholders have been selected for the “Role and Responsibility Areas”, the stakeholders 
associated with each area are indented under the name of each R&R area. Expand/collapse the display so 
that stakeholders are shown/hidden by double clicking on an area or clicking the “+” and “-” symbols. 
The “RR” icons show the stakeholders which have Role and Responsibility descriptions.  
 
The buttons on the bottom allow you to create “New” Role and Responsibility Areas or “Delete” them. 
 
When changes are made to the name, description, selected service packages, or selected stakeholders; you 
will need to hit the “Apply” button to save the changes or “Cancel”. 
 

NOTE: You may encounter a situation where doing “Autoselect” on the R&R tab didn’t add all 
the areas you expected. For example, if you have an architecture with a lot of Traffic 
Management (TM) related Service Packages (SPs) and do “Autoselect” you will typically get 
both Freeway Management and Surface Street Management areas. If you later delete one of those 
areas and then try to use Autoselect to add it back in you may not get that area to show up again. 
This is because there is some overlap between those two areas, Freeway and Surface Street 
Management, and the Autoselect sees that you already have an area for those service packages. In 
this situation you may need to manually add that R&R area back into your architecture. 

 
 

Defining Stakeholder Roles and Responsibilities 
From the list of Role and Responsibility Areas, when you select one of the stakeholders from the indented 
list, the right side of the R&Rs tab changes to show the roles and responsibility descriptions for that 
stakeholder.  
 
With the Stakeholder highlighted on the left, enter one or more Role and Responsibilities (R&Rs) for 
each stakeholder in each area.  
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The “RR” icon at the top right provides a quick check to show when roles and responsibilities have been 
entered for a stakeholder.  

 
TIP: The stakeholder description and list of inventory elements may assist the user in defining the role 
and responsibility for a stakeholder. 
 
There are two check-box columns in the list of Roles and Responsibilities: 

• In Project/Region:  When working with the Regional Architecture, the check indicates 
whether this particular R&R is included in any project architecture in the file. In a Project it 
indicates that the R&R is included in the Regional Architecture. This gives the user an idea 
that the R&R is used somewhere else and that any changes made to this R&R may affect 
other architectures. 

• Include:  indicates that the R&R is in the current architecture. An easy way to use this tool is 
to select the “All R&Rs” sub-tab and check/uncheck the Include boxes to add or remove 
R&Rs that apply to this area in your architecture. 

 
A 3rd column for the Role and Responsibilities shows “Status”. Here, you can assign a status - existing, 
planned, etc. - for each of your roles/responsibilities entries. 
 
TIP: The status of R&Rs could be used to differentiate between roles a stakeholder plays today with 
current system versus roles it will play once the new system is in place. 
 
The “New”, “Delete”, “Apply”, and “Cancel” buttons at the bottom work as they do elsewhere. 
 
The R&Rs tab for Project Architectures work a little differently in Version 8.0 compared to previous 
versions. Previously, if you selected a R&R area that is part of the regional architecture and start to make 
changes to it - either adding/removing stakeholders or adding/removing/editing the text of a 
role/responsibility you would be warned that a new area will be created that includes your changes. Then 
it would create a new R&R Area based on the original that was being edited and the new default name 
would be the same as the old area with “(Copy 1)” appended to the name. This allowed a project 
architecture to define its unique characteristics without affecting other architectures in the file. 
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Now R&R areas are considered the same for either the region or project within the same file. This 
simplifies the data entry and user experience somewhat but you should keep this in mind as you edit a 
project’s R&R characteristics. 
 

GUIDELINE: to define the characteristics of a project and develop a concept of operations 
(ConOps) for that project it will be best to use SET-IT > it supports more detailed definition of a 
ConOps including Sequences for Operational Scenarios. 

 
On the right of the R&Rs tab is a field that will normally say “Editable” meaning that Roles and 
Responsibilities can be added, edited, deleted but there if the user is working in a Project Architecture but 
hasn’t yet included an area in the project they will see “Locked” for any of the Roles and Responsibilities 
in that area.  
 

R&Rs Q&As 
Here are some tips on how to understand and use the R&Rs Tab: 

1. In the regional view what does the “In Project” check box mean?  
 “In Project” is checked when one or more projects include the R&R. The reason for showing 
the regional architect this information is they may want to know that the edits that they are 
making to an R&R will impact one or more projects. A possible point of confusion is that the 
“In Project” checkboxes are checked whenever the R&R is included in a project, even if that 
R&R is included in a project as part of an R&R Area that is different from the R&R Area that 
is currently being edited. It works this way because edits to the R&R will change the R&R 
everywhere that it occurs - in all projects and in all R&R Areas. If you want to make a change 
to an R&R that does not impact other areas/projects and “In Project” is checked, then you 
should make a copy of the R&R and make your edits in the copy. 

2. Do the checks in the “Include” column mean that these R&Rs are included for the regional 
architecture? 

Yes, almost. The Include checkboxes by the R&Rs mean that these R&Rs are included for 
that stakeholder in that area. Technically, they are not in the architecture until you actually 
include the R&R Area in the architecture by checking the checkbox next to the R&R Area on 
the left-hand side. When you include the R&R Area in the regional architecture, you get all 
the stakeholders and R&Rs associated with that Area, including the two in question. 

3. In the project view what does the “In Region” check box mean?  
The “In Region” column works just like the “In Project” column discussed above. The “In 
Region” column is checked whenever an R&R is included in the regional architecture, even if 
that R&R is included in the regional architecture as part of another R&R Area. The user can 
edit any R&Rs where “In Region” is checked so care should be taken if they are meant to be 
unique to the project. The checkboxes provide a visual cue about why the user is prevented 
from making any edits to these R&Rs. 

4. In both of the views why are the same R&Rs checked under “Include” column? 
“Include” is checked to include an R&R in an R&R Area. The same R&Rs are included in 
the R&R Area, regardless of the architecture that is selected. This is why the R&R Include 
column is the same, whether the project or region is selected. As stated above, you can 
choose to include the R&R Area in one or more architectures using the checkboxes next to 
each R&R Area on the left hand side of the tab. 

  
Think of the R&Rs tab like the Services tab in that the left side of the screen lists the Areas – the big 
things – while the right side lists the individual R&Rs – the smaller pieces. Similarly, on the Services tab 
you have the Service Packages on the left (the big things) and then the Elements on the right that belong 
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to each Service Package. On the R&Rs tab you are using the check boxes on the right to check whether 
the R&R is included in an Area, not in an architecture. To include or exclude something from the 
architecture use the left side to include or exclude the area first. 
 

Functions Tab 
Looking at the RAD-IT screen we continue working our way from left to right across the tabs at the top. 
This section discusses the 8th tab – the Functions tab. 
 

Functions – General Information 
The “Functions” tab supports the development of a description of the tasks or activities (the “functions”) 
that are performed by each system in the inventory. Selecting the functional objects provides a high-level 
way of documenting the share of the work that each system is required to do to provide the ITS services 
for a region or project. System functional requirements are one of the required components of a regional 
ITS architecture as identified in FHWA CFR 940.9(d)5 and FTA Architecture Policy section 5.d.5.  
 
GUIDELINE:  Before writing the first functional requirement, determine the appropriate level of detail 
for your region or project. Requirements should follow directly from the ITS service decisions, 
operational concept and interface choices. Identify which systems need to have functional requirements 
defined – for instance, systems on the boundary of ITS (e.g., financial institutions) do not have to be 
functionally defined. 
 

TIP: As regional architectures are typically too high level and too far looking in terms of their 
time horizon, it is recommended to keep the functional definition at a high-level in the regional 
architecture. Once a project has been scoped out use SET-IT to select and further customize the 
functional requirements for the system elements in a project. 

Functions Tab - Elements View  
The Functions tab identifies the areas of functionality or functional objects for each element. 
   
The left side of the screen on the tab shows the list of elements from the inventory. The list includes all 
elements when a regional architecture is selected or only project elements when a project architecture is 
selected.  
Elements can fall into one of 3 categories which are represented with the small icons to the left of the 
element names.  

1. The beige rectangle means that no functions have been assigned to the element.  

2. The box with the “f” means that functional objects have been selected for this element.  

3. The box with the “f” and a magnifying glass means that functional requirements have been 
defined for this element.  

 
This may vary between regional and project architectures in the same file. For example, functions may 
not be specified for an Event Parking System in one project architecture, but they may be specified in 
another project architecture in the same file. The same element could have three different status values in 
three different architectures. Highlighting one of the elements will cause an enlarged status icon to be 
displayed at the top right side of the screen. 
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The checkbox beside “Specify Functionality” allows you to make a simple yes/no decision on whether 
functionality will be specified, allowing basic scope to be established. Checking the “Specify 
Functionality” box will cause the Related Functional objects to be populated based on the inventory 
element’s mapping to ARC-IT Physical Objects. 
 
Functional Objects represent a group of processes within an element that contribute to the delivery of a 
particular ITS service. For instance, in order to implement the Infrastructure Based Traffic Surveillance 
service package, the ITS Roadway Equipment subsystem must include the Roadway Basic Surveillance 
functional object. In RAD-IT, think of these functional objects as building blocks to help you take into 
account all of the functions that an element of your inventory will need to support. 
 
On right side the screen a list of “Related Functional Objects”, only functional objects that can be 
associated with the element based on its physical object mapping, are shown. The list of functional 
objects is sorted alphabetically with the areas that have already been selected at the top. The check boxes 
allow the user to include/exclude the functional objects with the element. The choices only affect the 
currently selected architecture. 

 
 
Highlighting one of the functional objects will show a brief description of what is included in that area, 
the mapping of that element to ARC-IT, and the type - “ARC-IT”, or “User Defined”. These fields may 
not be edited. 
 

Autoselect Functionality 
The “Autoselect” button will cause another window to appear that selects the functional objects and/or 
requirements to be included for each element based on the service package mapping. Options on the 
Autoselect window allow you to either run the Autoselect for the current element or for the entire 
architecture. You can also decide whether to add and/or remove functional objects. You can also decide 
whether to add and/or remove requirements that are based on the User Needs. 
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Selecting “Continue” will bring up the Autoselect results showing all of the recommended changes to 
your functional objects and gives you the chance decide whether or not RAD-IT should reflect the 
changes on the Functions tab. 
 

NOTE: Autoselect on the Functions tab will not automatically assign functional objects to a 
related element that is an element from a related architecture or adjacent region. You can still 
map functional objects to that element manually. 

 
Selecting “Continue” will first bring up the Autoselect results showing all of the recommended changes to 
your functional objects (Add or Remove) and gives you the chance decide whether or not RAD-IT should 
reflect the changes on the Functions tab.  
 

 
 
Saying No will effectively end the process. Saying Yes will take you to the next stage, Requirements. 
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More about the Requirements below but the Autoselect screen here preselects the functional requirements 
to be added to the architecture based on the Needs and the functional objects in the architecture that are 
supporting the selected set of Service Packages.  
 

Functions Tab – Functional Objects View 
From within the “Functions” Tab window you can select the “Functional objects” button on the left side 
of the screen and get an indented list of functional objects for each Physical Object in your architecture. 
Only functional objects that make sense based on your inventory to Physical Object mapping in the 
architecture are shown; e.g. if an architecture doesn’t have anything mapped to a Commercial Vehicle 
Administration Center (CVAC) then functional objects for CVAC won’t be shown. As in the Elements 
view, the list of functional objects is architecture specific. 
 
Icons show the functional objects that have been included in the architecture. Clicking on the Physical 
Object name will cause the list of functional objects underneath to expand or collapse. Highlighting one 
of the functional objects will bring up the description, architecture mapping, and element mapping on the 
right side of the screen. 
 

  
 
In the “Functional Objects” mode, you can click on “New” at the bottom of the screen to create your own 
functional object. Then you can write a description and map it to a Physical Object. You can also 
“Delete” the user defined functional objects. 
 
You can add a user defined functional object to one of ARC-IT’s terminators – physical objects that do 
not have functionality in ITS.  This may be important to your region if you are expanding the scope of 
your ITS architecture to include the capabilities that lie in something like a DMV or Enforcement Center, 
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currently outside the scope of ITS. Behind the scenes RAD-IT will effectively turn it into a subsystem for 
the purposes of mapping other functions within your region/project architecture.  
 
The Related Elements shows only those functional objects that can be associated with the element based 
on the Physical Object mapping. 
 
The Autoselect button on this Functional Object view works the same as it does from the Elements view - 
It brings up a window to direct RAD-IT to automatically select functional objects based on the service 
package mapping and requirements based on the User Needs either for the element in question or for the 
entire architecture. 
 

 
 

Requirements Details Form 

 
From either the “Elements” View or the “Functional Objects” view of the Functions tab, clicking the 
“Requirements” button will bring up the “Functional Requirements Selection” screen shown in the 
figure below.  
 

 
 

RAD-IT Requirements Overview 
These functional requirements have been developed for each functional object in the National ITS 
Architecture (ARC-IT) to capture the main functions and interface support that is defined in the process 
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specifications and data flow definitions of the national ITS reference architecture. These requirements 
provide a good start for the generation of functional requirements for Regional and Project ITS 
Architectures.  
 
The user interface allows the user to create their own requirements or to customize the wording of the 
provided requirements to suit their own needs. The user may utilize a single requirement for more than 
one element. The user may assign user-defined requirements to ARC-IT functional objects as well as user 
defined functional objects.  
 
An inventory element may be designated to have no defined functional requirements. For example, 
functional requirements would typically not be specified for elements at the boundary of the Regional 
Architecture (e.g., National Weather Service or an adjacent state's TMC) per the guidance document 
process. This type of element can be distinguished in the output diagrams from elements having defined 
functional requirements. 
 

Notes about the Requirements Window 
The top left of the requirements window shows the element in question. The user can use the pull-down 
to select from any element in the architecture that has been assigned functional objects (which causes the 
table to be regenerated for that element).  
 
The other pull-down at the top of the screen displays the functional object. The user can use the pull-
down to select from any functional object that has been assigned to the current element. The user can also 
select “All” which causes all functional objects and their requirements to be displayed with an additional 
column in the table for the functional objects. 
 
The “Limit”, “Details”, “Sort”, and “Present” buttons work just as they do on the Interfaces tab. 
 
The “Needs” button is to manage the mapping between the User Needs and the functional requirements. 
This is a future capability. 
 
The columns in the table are described as follows: 

• Functional Object:  Only visible when the pull-down is set to “All”. This is a read-only column. 

• Number:  Unique number for each requirement within a functional area. Read only but see the 
“Tailor” button below. 

• Requirement:  Text of the requirement. Read only but can be tailored (see below). 

• Status:  Pull-down menu similar to the Interfaces tab. Default status is automatically selected when 
the user clicks on “Include”. 

• In Region: When viewing a project architecture this indicates whether this requirement is being 
used by the regional architecture in the same file. 

• Include:  Check box to include the requirement, similar to the Interfaces tab. 

• User Defined:  Indicates whether the requirement has been created or modified by the user (i.e., 
user-defined). Not directly editable. 

 
Click the Details button to pop up a screen just for that one highlighted row to see the text of the 
requirement, its functional object, any comments made about it, and how it traces back to the user needs. 
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If no requirements have been selected or defined yet for an element then the Details button will be greyed 
out. 
 

 
 
Back on the Requirements window, the “New” button at the bottom allows the user to create a custom 
(user defined) requirement. Also, if the user selects the “Tailor” button when an ARC-IT requirement is 
selected, RAD-IT makes a copy of the requirement for tailoring, and the “Type” becomes “User 
Defined”. “Delete” is only available when a tailored, user-defined, requirement is selected. The user is 
warned before the requirement is deleted. 
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Tailoring or creating a new requirement will bring up another window in which the user can edit the 
requirement text. 
 

 
 
In the “Tailored Functional Requirement” window, the requirement number is automatically selected by 
RAD-IT to be the next number in sequence. The user can change this, but the number must be unique. 
 
The “Functional Object” is also preselected by RAD-IT based on where the user was in the 
“Requirements” window. The user may change this to any other functional object that is associated with 
the element. 
 
The “Requirement” text can be anything that the user types. The “Regional ITS Architecture Guidance 
Document” and the Architecture Use section of the http://www.arc-it.net/ website has some tips on how 
to write good functional requirements for ITS architectures. Feel free to make use of the “Tailoring” 
option to edit the default requirements to make them match your needs – take out the phrases that will not 
apply to your situation, modify the text so that your stakeholders can better understand some of the terms. 
 
The “Applies To” choices allow the user to decide whether this tailored requirement will show up on the 
lists for other elements. This allows the user to reuse general requirements without cluttering up lists with 
specific requirements that only apply to a single element. 
 
The Needs area of the Tailored Functional Requirement window is for reviewing and editing the mapping 
of the requirement to the user needs that were defined and edited on the User Needs tab. The Needs listed 
are the needs for the functional object(s) to which the element is mapped that support a set of services on 
the service packages tab. Here you can Included or Exclude a mapping between a Need and a 
Requirement. There is a Review Your Architecture table that you can generate to make sure all User 
Needs are covered by at least one requirement and that all Requirements are mapped to at least one User 
Need. 
 

http://www.arc-it.net/
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The user hits the “Apply” or “Cancel” button when they are done and ready to go back to the 
“Requirements” window.  
 

NOTE: RAD-IT will display a message to the right of the screen when tailoring the text of an 
ARC-IT requirement to indicate that it has created a copy of the ARC-IT requirement that you 
can tailor and include in your architecture. 

 
 

Interfaces Tab 
Looking at the RAD-IT screen we continue working our way from left to right across the tabs at the top. 
This section discusses the 9th tab – the Interface tab. 
 

Interfaces Tab General Information 
The Interfaces tab allows the user to define the interfaces between the transportation system elements in 
the region or project. The two major controls on this tab are:  

(1) The toolbar, which runs across the top of the tab and includes tools that can be used to 
control the interface information that is displayed on the tab, and  

(2) The interfaces table that makes up the bulk of the tab and allows the user to review and edit 
transportation system interfaces for the region or project.  

 
These two basic features, along with the command buttons at the bottom of the tab, are all the tools that 
are required to define interfaces for the region or project.  
 
The figure below shows the tab when it is first opened, before any interfaces have been added for the 
region or project. The various views and customization options are described later in this section. 
 

 
 
NOTE:  ARC-IT includes physical objects, service packages and flows from regions outside the United 
States, such as Australia, Canada, and the European Union. When building the interfaces RAD-IT will 
only include flows based on the regions selected on the Options / General menu. 
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Uncustomized Architecture 

Adding Interfaces (Building the Architecture) 
When the user first enters the Interfaces tab, no rows will be displayed in the interfaces table. A “build” 
must be performed to add interfaces to the tab. The “Build” button (the leftmost button on the toolbar) 
initiates the build function. 
 
The user may build the architecture if the architecture includes, at a minimum, a set of Inventory elements 
and Services.  
 
The “Architecture” that is created by the “Build” function is a set of source elements, destination 
elements, and the information flows between them. The tool contains logic to create an initial set of 
interconnections and corresponding information flows based on the service packages selected on the 
Services tab and their assignment to elements from the Inventory. In all cases, the set of interconnections 
and information flows that this logic selects will need to be reviewed and customized by the user. The 
“Build” logic in RAD-IT is fairly inclusive. After all, the idea of creating an architecture is to identify 
opportunities for integration. This step is necessary in order to populate the database with the initial 
selections prior to actual customization. The step of building an uncustomized architecture is described in 
more detail in the following sections. 
 
GUIDELINE:  The user should repeat the “Build” step whenever additions are made to the inventory or 
changes are made to the service package selections after the initial architecture build. Subsequent 
architecture builds will make additional flows available for customization on the Interfaces tab.  
 
GUIDELINE:  If a “Build” is done after some customization has taken place, the customization is not 
undone by the new “Build”. In order to remove undesired interconnects or flows (for example, if a service 
package has been removed), the user must uncheck the “Include” box for each interconnect or flow on the 
Interfaces tab.  
 
 

How to Build an Uncustomized Architecture 
To build the architecture: 

1. Select the “Build” button at the top of the Interfaces tab. 
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2. Click “Yes” or “No” to view a report comparing the Inventory and Service Package selections 
before building the architecture (this output table is also available on the list of standard RAD-IT 
tables on the “Output” pulldown menu, even before a “Build” is done). Generating this table may 
take several minutes for a large architecture. The “Build Settings” option also allows you to 
compare the number of flows that will be added to the Interfaces tab for selection and/or actually 
added to the architecture using the various settings, before committing them to the architecture.  

3. If the output table was generated in the preceding step, click “Exit”, or the “x” in the upper right-
hand corner of the window, to close the Excel file. Back in RAD-IT you will be asked if you 
would like to continue with the “Update to the Interfaces tab”, i.e., the “Build”. Click “Yes” or 
“No”.  
a. When the table is displayed, if nothing new has been added to the architecture in the 

“Inventory” or Services tabs, then the “Build” operation will not display any new flows to be 
added to the architecture. However, if a user defined flow or new element (or new service 
package association) has been created, and no other changes or additions have been made, the 
“Build” will pick up this (these) flow(s).  

b. The first time that a “Build” is done the entire architecture will be listed in this table.  
c. Making a change and running “Build” again to build the architecture will only display a 

shorter list of flows and interfaces in the table for the additions made to the architecture. 
NOTE again that no flows will be deleted from the architecture, and customized flows will 
not be touched. 

4. The table on the “Build Interfaces” screen is now populated with source element, information 
flow, destination element, and status columns. The first column states what the suggested action 
will be when the user selects the “Yes” button to build the architecture. The possible actions are 
“Add to Architecture” or “Add to Interfaces Tab”. These actions are described later in this 
section. 

5. This “preview and accept” step on the “Build Interfaces” screen is important since an architecture 
build can add thousands of flows to the user's database with the push of a button. There are ways 
to minimize the number of flows that are actually generated by the “Build” step. By reviewing 
this screen, the user may identify major problems during the preview and abort the architecture 
“Build”.  

6. Click the “Yes” button to actually add the flows to the Interfaces tab and/or the architecture, or 
“No” to cancel the uncustomized architecture generation. If you are testing how many flows will 
be selected with each “Build Setting”, you may wish to build with each setting, then select “No” 
to not save the changes till you are ready, and have decided which “Build Setting” will work best. 

 
In the simplest scenario, the user completes the Inventory and Service Package choices and then invokes 
the “Build” for the first time. The tool also supports more complex scenarios in which the “Build” is 
invoked more than once for the same architecture. This is necessary, for instance, when new items are 
added to the inventory after an architecture has already been built and customized. The user will have to 
invoke the “Build” step again to make the flows that connect the new Inventory items available on the 
Interfaces tab. The “Build” logic is careful not to impact or modify areas that the user has already 
customized when subsequent architecture builds are performed. 
 

When to Generate Your Architecture 
The Build command may be used as soon as you have defined at least two elements that should be 
interfaced, but you may want to spend the time to define more of your inventory and identify the ITS 
services to be included in the architecture before doing your first build.  
 
After the initial “Build, if you have made no changes in the “Inventory” or “Services” tabs, zero rows will 
be generated by a subsequent “Build”. You should view (and perhaps modify) the “Inventory” and 
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“Services” tabs before entering the “Interfaces” tab to build or customize the architecture. If a user 
defined flow is created, and no other changes or additions have been made, the “Build” step will pick up 
this flow. 
 
Although it wouldn't hurt to generate an uncustomized architecture for every architecture in a file, it is not 
absolutely necessary. For instance, consider the case where there is an existing Regional Architecture and 
you want to build a Project Architecture that is a subset of the Regional Architecture. You could go 
directly into the “Interfaces” tab (with the Project Architecture selected), and begin to manually select the 
interconnects and flows for the project. (The only minimum requirement is that in the Regional 
Architecture, you have identified at least the element(s) and services that are associated with the project. 
This information is used to determine the set of flows that might apply to the project on the “Interfaces” 
tab.)   
 
If you chose instead to assign one or more service packages to the project, and then do an architecture 
build, a preliminary set of flows would already be selected for the project. If the RAD-IT Architect has 
tailored the Project Architecture on the “Interfaces” tab, a “Build” in the Regional Architecture will not 
regain consistency between the Regional and Project Architectures. The Project must be merged into the 
Regional Architecture again to regain consistency.  
 

Initial View of the Build Step 

 
 
In the “Build” option on the Interfaces tab, the user steps through the process of generating, reviewing, 
and approving, an uncustomized architecture. You will notice that the “Build” step is a little different 
from the other tabs and windows since it does not allow the user to do any data entry.  
When the “Build” option is first selected, the tab is blank and the user is presented with the Add 
Interfaces window and a couple of options. First, he may select a setting level, discussed in the next 
section. Next, the RAD-IT architect should select the option to review the reconciliation report that 
crosschecks the Inventory and Service Package selections (the title of the report is “Inventory to Service 
Package Comparison”). This explicit recommendation is made because it is easier to fix Inventory and 
Service Package selection problems before an uncustomized architecture is generated. If the user selects 
“Yes”, the reconciliation report is displayed. If he selects “No”, the report is not displayed and the 
architecture may be built next.  
 
The Inventory to Service Package Comparison report opens in a separate Microsoft Word window. It will 
highlight several issues: 

- The element does not participate in any Service Package 
- No element is defined for the Physical Object(s) 
- The element is not selected in the Service Package 

 
You can use the results of this report to decide to go back to the Inventory tab and add elements for 
certain physical objects or go back to the Service Package tab and add elements to the service package. 
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You can also review the report and decide that your architecture is the way you want it and can continue 
with Build process. 
 

“Build” Settings 
The Build Settings window is displayed when the user chooses the “Settings…” button on the Add 
Interfaces window. It contains two slider bars to select from different settings that govern how many 
interfaces should be included on the Interfaces tab and how many RAD-IT should go ahead and select as 
being included in the current architecture. Those settings will be described next. There is also an 
“Override” option that will also be explained. Together these choices control the number of flows selected 
by the “Build” algorithm, thus allowing the user to control the type of “Build” that is performed.  

 
 
The settings for the first slider, Include on the Interfaces Tab, control how many flows to include on the 
Interfaces tab and, going from left to right, include the following: 

• Only Selected Flows, where flows will only show up on the tab if they have been selected to be 
included (given a status of something other than Not Applicable) in the current architecture. All 
unselected flows will be removed from the display. This is useful to present as clean an Interfaces 
tab as possible - just show me what I have. On large regional architectures this may help sort out 
exactly what you are starting with and can then edit out what you don’t need. 

• Related Flows, where all the flows that are somehow associated with the selected service 
packages will be shown on the interfaces tab. This may result in some extra Not Applicable flows 
being displayed which presents some additional options to consider. The clutter is minimized in 
that these extra flows are at least traceable to a service you have already selected. 

• All Possible Flows, where the most information flows will be added to the tab - this goes to 
ARC-IT and pulls out any and all flows that go to or from your elements based on how they are 
mapped to ARC-IT Physical Objects. This may be useful for smaller architectures where you 
aren’t exactly sure what services you need and just what to see all the possibilities. This is not 
recommended for a large inventory as it could reach into the tens of thousands of possible flows. 
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The next slider bar, Flow Selection, governs what flows to actually select to be included in your 
architecture and has the following settings: 

• Conservative, where fewer information flows will be selected for the architecture and the 
Interfaces tab. This setting adds flows to the list on the Interfaces tab if they are included in a 
service package in the current architecture, but they are not actually included in the architecture, 
i.e. the status is “not applicable”. If this setting is selected, the “Override Previous Builds” option 
is unavailable. 

• Moderate, where a medium number of information flows will be selected for the architecture and 
the Interfaces tab. This selects a flow if BOTH the source and destination elements are mapped to 
a service package that includes the flow. This setting also looks at the functional object 
assignments for any user defined flow. If your architecture includes those functional objects, 
established on the Functions tab, then the user defined flows between those functional objects 
will be added. The differences between “Moderate” and “Aggressive” are not always easy to see, 
depending on how extensive the service package to element mapping is. 

• Aggressive, where the most information flows will be selected for the architecture and the 
Interfaces tab. This selects a flow if EITHER the source OR destination element is mapped to a 
service package that includes the flow. 

 
Do a “Conservative Build” after an “Import”, where the project has been customized and flows deleted. 
The user would not want to see these deleted flows re-introduced after “Import”, which is possible with 
an “Aggressive Build” on the imported architecture. The “Conservative” or “Moderate Build” can be used 
after the initial “Build”, when an “Aggressive Build” would add too many flows to the semi-customized 
architecture.  
 
The RAD-IT build algorithm at the moderate or aggressive build setting automatically includes 
information flows in the current architecture only if the flows are included in a selected service package 
and the flows connect elements that are included in the same service package instance.  
 
The “Override Previous Builds” check box is only for regional architectures - it will be grayed-out for 
project architectures. If this option is turned off, then an Aggressive or Moderate build performed after a 
Conservative build will ONLY add in the flows associated with the new element or service package and 
not add in all flows ignored by the initial Conservative build. The “off” setting will also not change flows 
already on the Interfaces tab. This is the DEFAULT. If the “Override” option is turned on, then ALL 
corresponding flows for all elements and service packages will be added by a Moderate or Aggressive 
build. In addition, the “on” setting may change flows already on the Interfaces tab from “not applicable” 
to another status value).  

NOTE that the “Override” option WILL NOT override the settings of any flows that have been 
manually tailored.  

 
For example, if you do a Conservative build, add no new elements or service package associations, then 
perform an: 
 

• Aggressive build without “Override” - Nothing new will be selected by default. 
• Aggressive build with “Override” - New flows will be selected for inclusion as if the 

Conservative build was never performed. New flows added for an unselected interconnect will be 
“Not Applicable”.  

 
NOTE that user tailoring is NEVER overridden by the “Build”, regardless of the option selected. 
Subsequent more aggressive builds will only affect changes on the Interfaces tab that are associated with 
new inventory, service package choices, and user defined extensions. Every flow associated with an 
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interconnect is marked by the software when the interconnect is deselected. This prevents interconnects 
from being added back in when a more Aggressive build is done after interconnects are tailored. 
 
The “Build Settings” window also includes “OK”, “Cancel”, and “Apply” options. While changes are 
pending on the Build Settings tab, the “Yes” and “No” commands on the “Add Interfaces” window are 
disabled so that builds cannot be initiated until a settings change is applied or canceled. The header on the 
preview window will indicate the “Build Setting” as a reminder, e.g. “Chicago Architecture Aggressive 
Build Results - 132 Flows Added”. 
 
To help the user be consistent with their “Build” strategy, the “last build setting” in the RAD-IT Database 
will be saved and will be used the next time the user does a “Build”. NOTE that this approach means that 
the “default” build strategy can change when the user opens a different RAD-IT database. The settings 
should always be reviewed before starting a “Build”. 
 
 

Completing the Build Process 
Once the “Recommended Interface Updates” build screen is populated with flows, the uncustomized 
architecture “Build” preview step is complete. All changes that will be made to the “Interfaces” tab or 
added to the architecture are presented. You may want to cancel out of the “Build” process by selecting 
“No” if you see something you do not like (e.g., RAD-IT wants to add in 10,000 new flows because too 
many service packages and/or element to subsystem associations have been identified). 
 

Stakeholder Bound Interfaces 
The “Build” process takes the stakeholder assignments for elements into account to minimize some of the 
combinations of interfaces selected. If the State DOT owns TMC-A and some A-Devices in the field and 
the City owns TMC-B and some B-Devices in the field then the Build process will identify all of the 
possible combinations of flows but it will only recommend including the flows between TMC-A to the A-
Devices and between the TMC-B and the B-Devices.  
 
Table 1. Physical Objects Involved in Stakeholder Bound Interfaces 

Physical Object 1 Physical Object 2 
Basic Commercial Vehicle Commercial Vehicle OBE 
Basic Emergency Vehicle Emergency Vehicle OBE 
Basic Maint and Constr Vehicle Maint and Constr Vehicle OBE 
Basic Transit Vehicle Transit Vehicle OBE 
Basic Vehicle Vehicle 
Commercial Vehicle OBE Fleet and Freight Management Center 
Connected Vehicle Roadside Equipment Traffic Management Center 
Driver Vehicle 
Emergency Management Center Emergency Vehicle OBE 
ITS Roadway Equipment Traffic Management Center 
Transit Management Center Transit Vehicle OBE 
Transit Management Center Traveler Support Equipment 
 
Note that in order for RAD-IT to take stakeholders into account you must make sure stakeholders are, in 
fact, assigned to those elements. Otherwise, RAD-IT will treat a null stakeholder like a wildcard and it 
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may still try to connect that element with other elements you don’t want.  This means, even a Driver 
needs to have a stakeholder and it needs to be the same as the element mapped as that Driver’s vehicle 
element. 
 

Build Results Screen 
On the final “Build” window, the flows are presented in two groups:  
 

1. Those flows that RAD-IT thinks are the best fit for the architecture. These flows will be included 
in the uncustomized architecture if you select “Yes” to complete the “Build” step. The status of 
these flows will be either “existing” or “planned” or a local status value. 

2. Other valid information flows that you may also want to consider. The second category of flows 
will be made available on the “Interfaces” tab, but will not be included in the architecture that is 
built by the “Build” step by default. These flows initially appear as “Not Applicable” on the 
“Interfaces” tab. You can change the status of these flows from “Not Applicable” to “Existing” or 
“Planned” (or a local status value) on the “Interfaces” tab, and the “Include” box may be checked 
(to include a flow in the current Project or Regional Architecture) and added to the architecture 
there. 

3. A third group of “Remove from the Interfaces Tab” may be shown if Only Selected Flows was 
chosen on the upper slider bar or if there were invalid flows in the existing file. This may happen 
with an older file or whenever mappings have changed for an element to physical objects or 
service packages. Every build does a complete validity check on all information flow triples on 
the Interfaces tab, regardless of the architecture that is being built. 

 
If you select “Yes” to complete the “Build” step, the flows are loaded into the “Interfaces” tab and a 
message is displayed directing you to the “Interfaces” tab to do architecture tailoring. If you select “No”, 
the “Add Interfaces” window exits and the “Interfaces” tab is again visible. No new flows or 
interconnects have been added to the architecture or to the “Interfaces” tab. 
 
 

Customized Architecture 

Customizing the Architecture 
The “Interfaces” tab allows you to make information flow by information flow (or interconnect by 
interconnect) changes to Regional and Project Architectures. In the typical scenario, this is where you 
would go after building the architecture via the “Build” button on the “Interfaces” tab. At this point, after 
generating an element inventory and making service package selections, you should obtain stakeholder 
input into the process and determine the interconnects and flows that should be selected or deselected on 
the “Interfaces” tab. 
 
 

Introduction to Customizing Your Architecture 
Once the uncustomized architecture has been created, the next step in the creation of an architecture is to 
customize it. By this we mean adding or deleting source element / information flow / destination element 
“triplets” from the architecture. This step is done on the “Interfaces” tab. This tab allows you to view your 
architecture either as a set of interconnects (a list of the elements that interface with each other) or as a set 
of information flows (exactly what information is exchanged between two elements). For a large 
architecture it is usually easier to begin your customization by looking at the interconnects and deciding 
which ones belong and which do not. For this reason, the default view shown when you first enter the 
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“Interfaces” tab for an architecture is the Interconnect, or “Connect”, view. Within the same RAD-IT 
session, however, if the view is changed to the “Flows” view, then this will be the default view if another 
architecture or file is opened. Customization may involve changes beyond the “Interfaces” tab. It may 
also mean adding, modifying, or deleting elements or information flow definitions themselves. For 
example, you may want to add an information flow (which is not currently defined) between element A 
and element B. This is done via the “Tools” pulldown (to create user defined physical objects and flows) 
on the menubar. 
 
When defining a Project Architecture from an existing Regional Architecture, regional flows may be 
selected or deselected for the project. A comment can be entered on the “Interfaces” tab using the “Info” 
button concerning the reason for selecting or deselecting certain flows.  
 
Input to customization includes the initial element and stakeholder inventory in terms of ARC-IT physical 
objects (subsystems and terminators) and user defined physical objects, as well as, ARC-IT service 
packages related to the initial projects and services. From the “Build” step, the source element, 
information flow, and destination element are included on the “Interfaces” tab as described below. The 
tool indirectly allows you to modify the subsystems, terminators, and information flows for the region or 
project based on the initial subsystem, terminator, and service package characterizations by selecting or 
deselecting a flow. 
 
The “Interfaces” tab includes two views: “Connect” (showing the interconnections between elements) and 
architecture “Flows”. Initially, the window will be displayed in “Connect” mode by default. You may 
move from interconnect to flow or from flow to interconnect views during the customization process.  
 
GUIDELINE:  Once the user enters the Interfaces tab and begins to customize the architecture, he may 
return to the Inventory or Services tabs to change element/stakeholder mappings and service package 
selections. Note again that a new “Build” will only add new interconnects and flows from the selections 
made on these tabs.  
 

Interfaces Tab Display Options 
On the “Interfaces” tab window, the toolbar at the top allows you to control what is displayed in the main 
table on the form. You select and deselect flows in the table using check boxes at the far right or by using 
a pulldown menu that allows changing the status of each row between “existing”, “planned”, “not 
applicable”, and local status values. Working from left to right across the toolbar, the following options 
are available: 
 

• Element Selection box 
• Build Option - see previous section on building the uncustomized architecture 
• “Connect” and “Flows” Display buttons 
• Style Options: Group, Sort, Present buttons 
• Filters Options: Filter, Elements, Limit, and New Flows buttons 
• Information Details Option 

 
Any time flow names are shown the flow Alias will also be shown for any flow for which the Apply Alias 
button has been checked on the Flow Aliases screen. 
 

Element Selection Combo Box 
This pull-down acts like a filter for the grid. You can either view all elements or view the interconnects 
and flows for a single element using this selection box. 
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Flows and Connects Buttons 
These buttons allow you to switch between the “Connect” (interconnects) and information “Flows” views. 
In interconnect view, no information flow information is provided and each check box in the table adds or 
deletes an entire interconnect (including ALL its flows) for the current architecture. You cannot switch 
between these two views when changes are pending (changes have been made to the table, but “Apply” or 
“Cancel” have not been selected). Pending changes must either be applied or canceled. Then, all options 
and rows are again available. 
 

Group Option 
This is a toggle that lets you view the displayed list with only one element name listed when an element is 
used multiple times and sorted alphabetically. The “Group” button combines adjacent cells that have the 
same values in the source and destination columns which simplifies the display, but makes no other 
changes (e.g., the number of rows in the table stays the same.)  
 

Sort Option 
This option allows the user to select the order in which the columns will be sorted.  
 
Sort Options available on Connects View: 

• Include, Elements 
• Elements, Include 
• Column Sort 

 
Sort Options available on Flows View: 

• Include, Source, Destination 
• Source, Destination, Flow Name 
• Flow Name, Source, Destination 
• Destination, Source, Flow Name 
• Interconnect Sort 
• Column Sort 

 
It may be used to see all instances of a flow, or to list common or similar information flows. When the 
user has selected a single element from the pulldown list at the top left of the window, there is an 
additional sort option for “Interconnect” sort. This option will sort all flows for an individual 
interconnect. For example, flows for Element A to Element B will immediately be followed by flows for 
Element B to Element A. In addition, the user may use “Column Sort” to control sorting and sort based 
on any of the columns displayed. After the user defined sort is applied, the remaining columns are sorted 
in the order they are displayed, from left to right.  
 

Present Option 
This toggle option enables the “Interfaces” tab to be more visible to group presentations, such as during a 
training class or stakeholder Workshop. This option could also be used to illustrate to the stakeholders the 
customization that has been done, or is planned, for a region, or to tailor interconnects in front of a group. 
The “Present” option increases the visible font size by 50%. 
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Filter Option 
This option allows you to display the list of interconnects or information flows using the same filters 
selected on the “Output => Filtering” menubar pulldown menu. This option enables the output filters so 
that flows that would be filtered from the diagrams and output tables are filtered in this table. This allows 
you to ignore human interfaces, for instance. Right-click the “Filter” option to display the filter settings 
window. 
 

Elements Option 
This option allows you to control the display of interconnects or information flows using the same 
Element selections on the “Output => Filtering” menubar pulldown menu.  

 
Click the little arrowhead under the icon to bring up the element selection window. 
 
This option limits the displayed list of information flows to only the elements listed on the “Element 
Selection” window. This includes the “Project Elements” and “Show All” options on that window. To 
control the number of elements displayed on the diagrams, set the element selection for a diagram/list of 
interfaces.  
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The elements and their interconnections that appear on the “Interconnect” and “Flow” views of the 
Interfaces tab may be customized in the following manner: 

 
1. To see all elements and all connections between them in the entire architecture, make sure all element 

boxes are checked on the “Element Selection” window. The “Select All” option on this window may 
be used to easily select all elements. Select “OK” when finished then click the main part of the 
Elements button itself on the Interfaces tab to see the results.  

 
2. To see only the connections between selected elements, bring up the “Element Selection” window 

again (click the arrowhead under the Elements button) then make the appropriate element choices. If 
many elements need to be removed from the list, the “Clear All” option is available. Then select the 
required elements. Select “OK” when finished then click the main part of the Elements button itself 
on the Interfaces tab to see the results. For instance, using the StateTown example, to produce a 
diagram showing just the flows that go between the TMC and the Transit Dispatch, then … 

a. Open the “Element Selection” window. 
b. Select “Clear All”. 
c. Select “StateTown TMC” and “StateTown Transit Dispatch”. 
d. Uncheck, if necessary, the “Show Communications Elements”. 
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e. Select OK. 
3. To see all of the connections into or out of selected elements, bring up the “Element Selection” 

window again (click the arrowhead under the Elements button) then make the appropriate element 
choices. If many elements need to be removed from the list, the “Clear All” option is available. Then 
select the required elements. Select “OK” when finished then click the main part of the Elements 
button itself on the Interfaces tab to see the results. This is the equivalent of a Context Diagram you 
can generate from the outputs section. Using the StateTown example, to produce a diagram showing 
just the flows that go into or out of the TMC, then … 

f. Open the “Element Selection” window. 
g. Select “Clear All”. 
h. Select “StateTown TMC”. 
i. Check the “Show All Interfaces” box. 
j. Uncheck, if necessary, the “Show Communications Elements”. 
k. Select OK. 

 
NOTE about the Show All option: If you are only interested in viewing the connections between selected 
elements, turn off the “Show All” option. If “Show All” is selected, all flows associated with the selected 
elements are included, even if the flows begin or end at an element that is not selected. This option 
applies to reports, diagrams, and the Interfaces tab.  
 
Examples of the “Show All” option:   

a. You select one element and “Show All”. The interfaces tab and diagram will display all 
connections to and from this element. These are sometimes called “Context Diagrams” and can 
be very useful to show an individual stakeholder how their systems relate to the region. If you 
turn off “Show All”, the tab will be blank. On the diagram generator, a popup appears saying that 
the diagram is blank – nothing is displayed.  

b. If you select two or more elements and “Show All”, the diagram will display all connections 
between these elements and to and from these elements to other elements in the architecture. If 
you turn off “Show All”, only the connections between the selected elements are displayed.  

 

Limit Option 
On the Interfaces Tab the Limit option acts like a filter to cut the displayed list of information flows to 
only the interconnections or flows that are present in the current architecture, i.e., the rows selected in the 
“Include” column. After initial customization, you can use this mode to avoid being bothered by other 
“valid” flows that do not apply to the architecture.  
 

New Option 
This option lists all new interconnects and information flows that have been added to the architecture by 
the last “Build”, or by the conversion process from a previous version of RAD-IT. The information on 
this screen may change based on new information - if a new “Build” has been done that added a few 
flows, then these flows will appear replacing the data from a previous “Build” or from converting this 
architecture. Previous data will then be available only on the main lists of interconnections and flows 
(with the “New” option turned off). 
 

Info Option 
This option, available in the “Flows” view only, displays a form that gives you more information about 
the selected information flow. The only field that you may edit is the “Comment” field. The information 
flow name, description, associated projects, and whether this flow is in the ARC-IT, is a user defined 
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Physical Object, or is a discontinued flow (based on the current version of ARC-IT) are also displayed on 
this window. You may add a comment about this flow, why it is planned or not, the flow's characteristics, 
or other pertinent information. 
 

 
 
A project is listed in the “Associated Projects” field if the flow is found on the “Interfaces” tab for a 
project. When looking at the Regional Architecture, this field is also filled in for the projects that the flow 
is associated with. This has nothing to do with whether or not the source and destination elements are 
associated with the project. 
 

Interconnects View 
The default “Connect” view (showing the interconnections between elements) includes all 
interconnections (source and destination elements) in the architecture that is currently being customized. 
The interconnections were generated during the “Build” step. 
 
In addition to the data filters available on the “Output => Filtering” pulldown (these are also available on 
the “Interfaces” tab), you can select an element in the selection box in the upper left-hand corner of the 
window. This will limit the interconnects displayed to include only those associated with the selected 
element. The table illustrates element to element rather than source/destination ARC-IT Physical Objects 
associated with the element). The “Connect” view illustrates the elements in a directionless manner, 
unlike the “Flows” view, where direction is shown. You will notice that the header row in the “Interfaces” 
table is different between the two views of the architecture. 
 
The “Connect” view omits the information flow column with a corresponding reduction in the number of 
rows displayed. Both views are closely related. Making a change to included flows in the “Flows” view 
will change the corresponding interconnect in the “Connect” view, if no other flows are involved in the 
interconnection between the two elements. The reverse is also true - deselecting an interconnect is 
reflected in the “Flows” view.  
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Communications / DDS 
The Communications column allows you to select the communications element that is assigned to the 
interconnect. This includes objects that have been created for your architecture that are of the 
Communications Physical Object type from ARC-IT that are specific to communications: 

• ITS Communications Equipment 
• Wide Area Information Disseminator System 
• Roadside Communications Units (Field class) 
• Remote Access Device (Human Interfaces to Centers or Support elements) 

 

 
 
The DDS column allows you to select a Data Distribution System (DDS) element will act as a pass 
through for the information. DDS’ collect, aggregate, and distribute or publish data to subscribed 
destinations. There are numerous technologies in the market for data distribution depending on the needs 
of the project.  
 
NOTE: With the Communications and DDS columns you will notice that not every flow has a Comm or 
DDS option. This is because there are some rules that determine the eligibility of what can go through 
Communications equipment and what can go through a data distribution system. For instance, Roadside 
Communications Units are field class objects and as such are not eligible for center-to-center interfaces. 
Wide Area Information Disseminator System is for the broadcast of information over a wide area so 
information flows containing interactive data such as requests or time-sensitive controls cannot use a 
WAIDS. Remote Access Devices (RAD) are available for human interfaces between a human operator 
and a Center or Support class subsystem. 
 
This may be an area that won’t be known during the development of a regional architecture and that’s 
OK. It can and will be decided during the project development. 
 

Selecting/Deselecting Interconnects 
When you select or deselect an architecture interconnect or, optionally, select an associated 
communications element, and then hit “Apply” to save changes to the architecture, the architecture is 
updated in the following ways: 
 

1. Regional Architecture:  
a. Select a new interconnect that was not part of the architecture:  All valid information flows 

associated with that interconnect (in both directions) are selected as part of the architecture.  
b. Deselect an interconnect:  All information flows associated with that interconnect (again, in 

both directions) are deselected.  
c. Deselect, then select an interconnect before clicking “Apply”:  No change is made to the 

underlying database. This preserves any information flow level tailoring that has already been 
done on the interconnect. NOTE that if you deselect an interconnect and click “Apply”, and 
then select the same interconnect and click “Apply”, any flow level tailoring will be lost and 
all flows for that interconnect will be selected.  

2. Project Architecture:   
a. Select a new interconnect:  If there are information flows on the interconnect that are part of 

the Regional Architecture, then only those flows are selected as part of the project. If there 
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are not any Regional Information flows on the interconnect, all valid flows on the 
interconnect are selected as part of the project.  

b. Deselect an interconnect:  All associated information flows are deleted from the project 
(analogous to Regional Architecture operation above).  

c. Deselect, then select an interconnect before clicking “Apply”:  No change is made to the 
underlying database. 

 
 

Selecting Part of an Interconnect 
If in an architecture (either regional or project), you only want a portion of an interconnect to be selected, 
i.e., only certain flows from an interconnect are required in this architecture. Review the ARC-IT website 
for information on the flows associated with an interconnect (subsystem to subsystem or terminator). 
 
Correct way to accomplish this: 

a. Enter the “Interfaces” tab, “Connect” button. 
b. Deselect the interconnect, since not all flows are required. This deselects ALL the flows 

associated with this interconnect. 
c. Click the “Flows” button. 
d. Select only the flows that are required in the architecture for this interconnect, and assign 

their status of “existing”, “planned”, or a local status value, if not already correct. By 
selecting a flow associated with an interconnect, the interconnect is again selected 
(“included”) on the “Connect” screen. 

e. Do not go back and deselect or reselect the interconnect as this will deselect or reselect ALL 
flows associated with it. 

 
Wrong way: 

a. Enter the “Interfaces” tab, “Flows” button. 
b. Deselect the flows not required for this interconnect. Leave the others as “existing”, 

“planned”, or a local status value. 
c. Click on the “Connect” button. 
d. Deselect the interconnect. This deselects ALL the flows associated with this interconnect, 

even the ones that had not yet been deselected. This is NOT what you intended.  
e. This may also occur if you deselect a flow, deselect the interconnect, then reselect the 

interconnect - ALL its flows are again selected. You need to be aware of this type of 
synchronization issue between interconnects and their associated information flows. 

 

Customize Flows 
The Flows view for the Interfaces tab displays a table that illustrates the Regional and Project 
Architecture associations. As in the “Connect” (interconnects) view, in the box on the upper left-hand 
side of the screen a pulldown list of all the elements currently defined in the architecture is displayed. 
This is either the list of the project elements for the Project Architecture that is open, or all elements in the 
Regional Architecture. Select one element or the “ALL” option. A table is then created with all the 
information flows into (or out of) the element selected (or with all flows listed).  
 
The Source Element, Information flow, Destination Element, In Region (for Project Architecture only), 
Status, and Include, will appear in the table.  
 

NOTE: that some flows may appear with an asterisk after the flow name. This indicates that 
these are discontinued flows from the conversion.  
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The default sort for these columns is set based on the following order:  Include, In Region, Source 
Element, Destination Element, Information flow, and lastly, Status. The sort order may be changed by 
selecting the “Sort” button at the top of the window. 
 
When looking at a Regional Architecture, “Included” flows are either “Existing”, “Planned”, or a local 
status value. Conversely, “Not Included” flows are “Not Applicable”. When looking at a Project 
Architecture, “Included” flows must also be either “Existing”, “Planned”, or a local status value. 
However, “Not Included” flows can be any state since the flows may be part of another architecture in the 
file. If the “Include” box is not checked, the status of this flow defaults to “Not Applicable”.  
 
The flow status on the Interfaces tab in the Regional or Project Architecture is set equal to the flow status 
that is displayed in the “Build” step (i.e., the “Build” option on the Interfaces tab). There is one 
EXCEPTION to this. The flow status in the architecture will not be changed if the flow already exists on 
the Interfaces tab, and the software determines that some customization work has already been done on 
the flow. This exception prevents user customizations from being lost during subsequent builds. 
 
When the “Include” box is checked, the status is changed from “Not Applicable” to either: 

• The default status if the status has never been manually changed for the current flow, or 
• The last status selected in cases where the default status was overwritten before the flow was 

deselected. 
 
In either case, click on the status field and change it. If you change it to “Not Applicable”, the “Include” 
box is automatically deselected. The last actual deployment status is stored in the database for all flows. 
When a flow is selected, this last actual status is displayed on the Interfaces tab. This means that you can 
accidentally toggle the “Include” box on a flow without inadvertently changing the deployment status. 
 
NOTE that the columns on the Interfaces tab may be moved or the column width stretched. For instance, 
you may wish to move the “Include” column next to the “Flow Name” column when trying to decide 
whether or not to deselect a flow. 
 
NOTE that for a Project Architecture, additional flows that are not part of the project will be included on 
the “Flows” view of the Interfaces tab. These additional valid flows are included so that the user can 
select additional flows for the project. This may include flows associated with other projects (or the 
Regional Architecture) to present all valid flows, giving the broadest set of choices. The “Limit” filter is 
also available to selectively limit the Interfaces tab to the flows that are selected or “directly applicable” 
to the project.  
 
GUIDELINE:  A project may apply to more than one service package or to parts of different service 
packages. This is accomplished in the customize “Flows” view of the Interfaces tab by selecting or 
deselecting information flows connected to this project and element. 
 

Flow Aliases 
A flow alias is a way to use a customized name for an information flow while retaining the mappings to 
the ARC-IT reference model for that flow.  For example, if you are doing a connected vehicle project to 
collect probe data from passing vehicles for surveillance purposes you may want to just show the term 
“BSM” for the basic safety message defined in the SAE 2735 standard rather than the full name of the 
ARC-IT information flow, “vehicle location and motion for surveillance”. 
 
From the Home menu bar, click on the “Flow Aliases” button. 
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This will open a new form with a list of the information flows used in your architecture as well as all the 
flows from ARC-IT or user defined flows that may not be selected for your architecture yet. 
 
The Flow Alias screen has 4 or 5 columns depending on whether the regional architecture or a project 
architecture is selected.  
 
Region Mode: 

 
 
Project Mode: 
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The first or first 2 columns indicate whether a flow is already included in the selected architecture.  If 
neither are checked that means it is one of the flows imported from the ARC-IT reference model or a user 
defined flow that haven’t been included in the architecture yet on the Interfaces tab.  The next column is 
the official name of the flow, either from ARC-IT or as the user defined flow name.  This column is read-
only. Next, is the Alias column.  Here will notice that there may already be some aliases entered. There 
are some default aliases typed in but you can change those however you want.  Next, is the Apply Alias 
checkbox.  This will not be checked until you decide to use it.   
 
Once the Apply Alias checkbox is checked and you click OK then the alias will appear to replace the flow 
name on all diagrams and output reports and tables.  On the Interfaces and Communications tab you will 
see that once the Apply Alias is checked that the flow names change on the screen to show the alias and 
the regular flow name in parenthesis.  

 
 
 

Communications Tab 
Looking at the RAD-IT screen we continue working our way from left to right across the tabs at the top. 
This section discusses the 10th tab – the Communications tab. 
 

Communications Tab General Information 
ITS Standards address interfaces between ITS elements. When stakeholders have reached consensus on 
the interfaces (information flows) between each pair of elements in the Regional or Project ITS 
Architecture, then a set of standards can be identified for many of these flows. A report identifying ITS 
Standards supporting regional and national interoperability is a required component of the Regional ITS 
Architecture as identified in FHWA CFR 940.9(d)7 and FTA National ITS Architecture Policy Section 
5.d.7. The “Regional ITS Architecture Guidance Document” includes recommendations on how to 
approach this topic as it pertains to a Regional Architecture. 
 
ARC-IT maintains a mapping of information flows to ITS standards development activities. Refer to the 
Communications View pages of the ARC-IT website for the latest mapping between ARC-IT and the ITS 
communications standards. RAD-IT accesses this mapping information and makes it available for 
customization and tailored standards activity tables. 
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Not every region will use every applicable standard and often local “standards” will be identified where 
no national standard is yet available. To address these needs, you can now select the standards (tailor the 
list of standards) that actually will be used in the region so that the “Standards Activities” report will more 
accurately reflect the intent of the region and/or projects. Editing can be done for a region or project on a 
standard-by-standard or interface-by-interface basis. Also, you are able to add user-defined standards to 
the list and link the user-defined standards to information flows that will be included in the standards 
report. 
 
GUIDELINE:  Get your architecture to the point where you already have a good understanding of your 
services and interfaces, i.e. customize the flows first. When you get to this point, gather the key 
stakeholders together to make ITS Standards choices that will apply to any architecture in the region. 
 

Communications Tab Entry 
The “Communications” tab in RAD-IT provides the opportunity to decide which of the Communications 
Solutions and their Standards activities best applies to your situation.  
 
Communications Solutions represent the newest addition to the regional architecture toolkit with version 
9.0 of ARC-IT and the RAD-IT/SET-IT software suite. You may be wondering, “What’s a 
Solution?” This is all based on the information that makes up the Communications View of ARC-IT.  
 
According to the http://www.arc-it.net/ website:  
 

The Communications Viewpoint provides a framework for identifying the protocols necessary to 
implement an information flow between Physical Objects (as defined in the Physical View or in 
RAD-IT’s case – on the Interfaces tab). These protocols need to meet interoperability, 
performance, functional, security, and environmental requirements, as well as address operational 
challenges and relevant policies (such as an assurance of pseudonymity for mandatory data 
provision). 
 
The Communications Viewpoint enables the project systems engineer to answer questions such 
as: 

• What is the set of communications protocols that provides a complete interface solution 
that meets mission needs? 

• Are there any issues with using a given protocol for a given triple? How serious are those 
issues? 

• If multiple protocols exist to satisfy an interface, how do we choose between them? 
• Are there gaps in data usage and definitions, communications functionality, security, or 

management? 
• What protocols address critical system-wide security issues, such as the provision for 

protection of data confidentiality, protection of message integrity, defense against in-
transit manipulation? 

• What organizations are responsible for the maintenance of data, communications, 
security and management standards and specifications? 

 
The result is a really detailed set of analysis organized into Communications Solutions that a project 
system engineer can use to know what standards to focus on for a given interface as well as what 
questions to ask and what other information will be needed to fill in the gaps. 
 

http://www.arc-it.net/
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The key word is “Solution” which is the combination of the Data profile and the Communications profile 
needed to fully define an interface. The data profile includes the ITS application information layer 
standards to define the data – data dictionary, message set, etc. The communications profile is what is 
needed to communicate at all the layers of the Open System Interconnect (OSI) model along with the 
management and security standards needed. 
 
Once you have ‘built’ and customized (selected/deselected) the interfaces for your architecture on the 
Interfaces tab, click the Communications tab to see which communications solutions and the standards 
they include are associated with the interfaces in your architecture. 
 

 
 
The Communications tab is arranged like the Interfaces with a menubar at the top to change how the 
information is presented and to see more details on a row. 
 
The default layout of the Standards tab shows the “Current Architecture Solutions” but will appear blank 
for the first time through a new architecture. You will first need to do a “Build” as with the Interfaces tab.  
 
Either the first time through the architecture or anytime you have made significant changes to the 
architecture’s interfaces you should click the “AutoSelect” button in the Build area of the menubar. 
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The Autoselect Communications Solutions window comes up to let you decide how the selection should 
work. Do you want it to just focus on the current architecture (the one you selected on the Start tab) or all 
architectures in the file – the regional and any project architectures?  You can also use the Override 
Options to preserve all changes that have been made previously – any solutions that have been purposely 
deselected before won’t be selected again and vice versa. Or you can tell it to restore all defaults based on 
the information from the ARC-IT model. 
 
Click the Autoselect button and a number of queries will run to determine which set of communications 
solutions are the most viable for your region/project architecture. 
 

 
 
You can also use the “Solutions Selection” pull-down in the top left of the window to choose to show a 
listing of “All Solutions” in the ARC-IT communications view database as shown below. 
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The columns on the Communications tab include:  

• Solution name 
• Description of the communications solution 
• # of Triples that have been mapped to that solution. Recall that a ‘triple’ is a combination of the 

source and destination elements and the flow between them. 
• In Arch to indicate that it has been included in the selected architecture 
• Readiness (more on that below) 
• User Defined to indicate that a user defined solution has been selected. 

 
NOTE: Currently with RAD-IT you are not able to create a user defined Solution but if you import a 
project architecture from SET-IT you may see user defined Solutions created in that tool. 
 
The user can change the display of the Communications window using the buttons at the top of the 
screen: 

• Display:  These buttons include the “Comm Solutions” button or the “Solutions by Interface” 
button.  

o The default is the “Comm Solutions” display as shown above. 

o “Solutions By Interface” shows the selected solution mapping by source element-
information flow-destination element triple based on the inventory of elements and 
interfaces in the current regional or project architecture. 

 
Solutions by Interface lets you change the selected Solution if an alternative is available. 
Use the pull-down in the Solution column. If an alternative solution is available and you 
pick it then you will see a checkbox appear in the “Override” column. As you make 
changes to the Solutions you will see the Apply and Cancel buttons activated. 

• Group: Works like it does on the Interfaces tab, groups cells of the table together that have 
identical contiguous content.  

• Sort:  The sort options available on the Communications tab varies by the Solutions Selection 
choice 

o For Comm Solutions, the Sort options are:  
 In Arch, Solution (default)  
 Solution; Readiness 
 In Arch, Solution 
 #Triples, Solution 



148 

 User Defined, Solution 
 Column Sort 

o For Solutions by Interface, the Sort options are:  
 Source, Destination, Flow(default) 
 Override, Source, Destination, Flow  
 Readiness, Source, Destination, Flow  
 Flow, Source, Destination 
 Readiness, Flow, Source, Destination 
 Column Sort.  

o As on the Interfaces tab, with Column Sort just click on any column header and the 
screen will sort by that column. OR, if in any other sort mode, click on a column header 
and the “Column Sort” option is activated. 

o Also like the Interfaces tab, if Flow Aliases are applied on the Flow Aliases window then 
the alias will be listed with the flow name in parenthesis. 

• Present: Makes the characters 50% bigger to make it suitable for engaging in a group discussion 
by projecting the Communications screen at a stakeholder meeting. 

• Filter: Works when in the “Solutions by Interface” display mode. It works the same as the Filter 
screen on the Interfaces tab and Outputs menu.  

• Elements: Works when in the “Solutions by Interface” display mode. It works the same as the 
Filter screen on the Interfaces tab and Outputs menu. 

• Limit: As on the Interfaces tab, this will limit the display to just the Solutions that have been 
included. This only works in “Comm Solutions” display mode. 
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• Info:  With one of the Comm Solutions or Solutions by Interface highlighted, clicking the “Info” 
button will display information describing the communications solution. An example is shown in 
the figure below. 

 
In the lower part of the Solution Details screen there are 2 sets of tabs. The upper 3 tabs – Standards, 
Issues, and Information Flow Triples – govern what is shown below.  

- The default is to highlight the Standards and then the lower set of tabs include the selected 
standards for each protocol layer.  

- Clicking the Issues tab displays a list of issues or gaps that have been identified by the ARC-
IT communications team regarding the solution or standards within the solution and their 
severity. The issues are available as a resource to the regional or project architect to see how 
viable a given solution may be or how ready it might be for deployment.  

- Clicking “Information Flow Triples” displays the list of interfaces assigned to this triple 

NOTE: The details window is currently READ-ONLY in RAD-IT. 
 

Customizing the Communications View 
The Communications View for an architecture is more relevant to a project architecture – deciding which 
communications solution are best for a given set of interfaces, seeing their mapping to individual 
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interfaces, etc. These are questions that will make more sense and need to be factored in once decisions 
are being made for the project.  
 
SET-IT is the better tool to customize the communications solutions for a project so once a project is 
ready to be defined out of the regional architecture use the steps to define a project from the regional 
architecture, see “”, then import that project into SET-IT to customize the communications solutions in 
more detail. 
 
That said, there may be times at even the regional architecture stage when certain things are known about 
what types of communications are going to work in a region and some that won’t. In this case, select 
“Solutions by Interface” display mode and use the solution pull-down for a given information flow triple 
and change the solution, if there is a choice. As you make the change you will see the checkbox in the 
Override column checked. 
 
As you make changes to the Solutions you will see the Apply and Cancel buttons activated. 
 

Solution Readiness 
The Solution Readiness column on the Communications tab is an indicator of the overall readiness of this 
solution to be deployed and reflects the issues that have been identified for the collection of standards that 
make up the solution.  
 
The Readiness values are shown in the table below in terms of their readiness or suitability to deploy: 
 
Readiness 
Level Readiness or Suitability Description 

Highest Suitable for wide-scale deployment when applied to the triples it supports. 
High A small number of minor issues. For existing deployments, consider addressing issues as 

needed as part of maintenance or upgrade activities. For new deployments, the solution is 
likely suitable for wide-scale deployment when applied to the triples it supports, though the 
noted issues should be considered and a path to addressing them developed, if needed, 
either as part of design or subsequent maintenance or upgrade activities. 

High-
Moderate 

One significant or possibly a couple minor issues. For existing deployments, the chosen 
solution likely has identified security or management issues not addressed by the 
communications solution. Deployers should consider additional security measures, such as 
communications link and physical security as part of these solutions. They should also 
review the management issues to see if they are relevant to their deployment and would 
require mitigation. For new deployments, the deployment efforts should consider a path to 
addressing these issues as a part of their design activities. The solution does not by itself 
provide a fully secure implementation without additional work. 

Moderate Two significant or one significant and several minor issues. For existing deployments, the 
chosen solution is likely deficient in security or management capabilities and the issues 
should be reviewed and upgrades developed as needed. For new deployments, the solution 
may be viable for pilots when applied to the triples it supports; such pilot deployments 
should consider a path to addressing these issues as a part of their design activities. The 
solution does not provide sufficient interoperability, management, and security to enable 
proper, full-scale deployment without additional work. 
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Readiness 
Level Readiness or Suitability Description 

Moderate-
Low 

Multiple significant and minor issues. For existing deployments, the chosen solution is 
likely deficient in security or management capabilities, and the issues should be reviewed 
and upgrades developed as needed. Some solutions in this category may also be becoming 
obsolete from an interoperability perspective and if this is the case, then upgrades should be 
planned as soon as possible. For new deployments, the solution may be viable for pilots 
when applied to the triples it supports; such pilot deployments should consider a path to 
addressing these issues as a part of their design activities. The solution does not provide 
sufficient interoperability, management, and security to enable proper, full-scale 
deployment without additional work. 

Low One serious or several significant issues. This category often includes proprietary or partial 
solutions. The communications solution may fail to provide even a base level of 
interoperability and security. Consider alternative solutions or define specific revisions or 
upgrades that would provide a level of interoperability or security that are needed for the 
deployment. 

Lowest Many serious issues. This category includes solutions that have not been standardized, or do 
not have a basic level of interoperability or security. Consider selecting a different 
communications solution or if this is not possible (e.g., a pilot of a new application that has 
not been standardized), take additional measures to provide an acceptable level of security 
or interoperability. 

 

Data Distribution Solutions 
If an interface is eligible to us a data distribution system then you may notice a solution, either selected as 
the default or as a choice for the information flow triple that involves a data distribution system. Recall 
from the discussion on the Interfaces tab that not every flow is eligible depending on the type of data 
included in the interface or the type of communications involved – broadcast vs control vs interactive 
communications. If the flow had a data distribution system element selected in the DDS column on the 
Interfaces tab then a DDS solution will be shown in the Communications Solutions. If it did not have a 
data distribution system element selected then you may still see it as choice if you use the Solution pull-
down on the Communications tab.  
 
The Solution Details form will show whether the solution applies to interfaces with or without a DDS as 
an intermediary or if they can use DDS at all. This can be accessed from the “Solutions by Interface” 
view on the Comm Tab and selecting the “Info” button for a particular interface. 
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What’s a Standards Bundle? 
The Communications tab includes Communications Solutions that are defined by a set of standards – 
either for the data/message or for the communications protocols. In the list of standards for a given 
Solution you may notice the term “Bundle”. In the ARC-IT Communications view a “Bundle is a group 
of Standards. A group of Standards is used when there are more than one standard that are needed to 
define how best to implement an interface. See the ARC-IT website (http://www.arc-it.net/) for more 
information.  
 

Thoughts on Communications Tab Usage 
GUIDELINE:  Use the Communications Tab in RAD-IT to see the full list of communications solutions 
that are part of the architecture and to generate outputs for your regional or project architecture when you 
are required to list the ITS standards being considered for the region’s or project’s interfaces. But use 
SET-IT to be able to see and customize the full interface protocols and communications solutions 
associated with each interface. 
 
GUIDELNE: When you are developing a project architecture use SET-IT to build the physical view (e.g. 
customized service package diagram with elements and flows) and then use the Communications View to 
review the ARC-IT defined communications standards for each layer of the relevant communications 
solutions. 
 

I Just Need a List of Standards for My Region/Project 
If you are required to produce a list of standards, perhaps to fulfill requirement 23CFR940.9 d.7 – 
“Identification of ITS standards supporting regional and national interoperability,” then you can generate 
a table from the Outputs menu. 
 
Go to the Outputs menu, select Tables, click to expand the Interfaces & Standards section, and select 
“Communication Solution Details”.  In the list of fields on the lower left box select the following fields: 

- Standard 
- Standard Number 
- Standard Title 
- Standard Version 

 

http://www.arc-it.net/
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The results can be exported to Word or Excel where they can be reformatted for your final reports. 

 
 
 

Agreements Tab  
Looking at the RAD-IT screen we continue working our way from left to right across the tabs at the top. 
This section discusses the 11th tab – the Agreements tab. 
 

Agreements Tab General Information 
Agreements among different stakeholder agencies and organizations are required to realize the integration 
shown in the regional or project architecture, and to provide project interoperability. The 
stakeholder/agency in charge of the architecture development should ensure that all stakeholders are 
aware of the required agreements and their status.  
 
Using the Agreements tab in RAD-IT, a list of the required agreements can be compiled, either 
agreements already in place or new agreements that are needed. Each agreement will have a user-supplied 
number, name, type, description, and status and be related to two or more stakeholders that are identified 
in the architecture. RAD-IT output tables will show the list of agreements and (optionally) the specific 
relationship of each agreement to the architecture. 
 
Any agreements (existing or new) required for operations, including at a minimum those affecting ITS 
project interoperability, utilization of ITS related standards, and the operation of the projects identified in 
the Regional ITS Architecture, are required in FHWA CFR 940.9(d)4 and FTA National ITS Architecture 
Policy Section 5.d.4. 
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Each connection between systems in the Regional ITS Architecture represents cooperation between 
stakeholders and a potential requirement for an agreement. Of course, this does not mean that hundreds of 
connections in the architecture will require hundreds of new agreements. One agreement may accomplish 
what is necessary to support many (or possibly even all) of the interfaces identified in the architecture. 
More on that in the “Agreements by Project or Interface” section below. 
 
The Agreements tab for a Regional architecture, as shown in the figure above, lists all the agreements in 
the file. They are all listed on the left and an area at the bottom right of the screen shows with which 
projects they are associated.  
 
With a project architecture you can use the 2 radio buttons at the top of the left side to choose between 
“Project” and “All”.  
 
With “All Agreements” selected, you can select “New” or “Delete” at the bottom of the window to create 
a new agreement or delete one of the existing agreements. If you are working with a project architecture, 
use the checkboxes on the extreme left of the screen to quickly associate an agreement with the project. 
 
The left side shows the agreement “Number” and “Title” and there are buttons at the bottom to choose 
which columns will be shown:  “Number”, “Title”, or “Both”. You may hide either the name or number 
column for the displayed agreements. By clicking on the top of each column the window can be sorted by 
that column, in either ascending or descending order. 
 
Highlighting one of the agreements will populate the right side of the screen with the information for that 
agreement. These attributes may be modified, then “Apply” or “Cancel” selected. Clicking the “New” 
button will allow you to start from scratch and fill-in any of the information on the right. 
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The “Status” field allows you to pull-down and select from any of the status values that are valid for the 
selected architecture. 

 
The “Type” field is another pull-down that allows you to select from one of the Types that have already 
been defined. Agreement types include general and interface/architecture specific. General agreements 
typically apply to a group of stakeholders in a region or on a project, like an MOU or Blanket Agreement 
for the project. Specific agreements are more about 2 stakeholders needing to agree on a specific interface 
in order for a service to work.  
 
General Agreement Types include: 

• Funding Agreement 
• Handshake Agreement 
• Interagency Agreement 
• Master Agreement 
• Memorandum of Understanding 
• Project Blanket Agreement 
• Shared Operations Agreement 

 
Specific Agreement Types include: 

• Information Exchange Agreement 
• Information Exchange and Action Agreement 
• Information Provision Agreement 
• Security Credentials License and Usage Agreement 
• System Maintenance Agreement 
• System Usage Agreement 
• Warranty 
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NOTE: Unspecified is also selectable as a type of agreement to be used early on when you may not 
be sure what type of agreement will be needed.  

 
NOTE: For Older Architectures, previous versions of Turbo Architecture and RAD-IT allowed users 
to enter their own agreement type. Now RAD-IT is based on ARC-IT’s Enterprise view with a 
predefined set of agreement types. If you converted an older architecture into RAD-IT then you will 
see those previous custom types changed to “Unspecified”. You should go and change those to one of 
the ARC-IT supported types to ensure compatibility with other RAD-IT architectures and SET-IT 
projects. 

 
See the “Regional ITS Architecture Guidance Document” and the http://www.arc-it.net/ website for more 
information. Agreements take a long time to execute. Build consensus early with simple agreements such 
as MOU’s, while final agreements are being developed. 
 
The “Description” field can include any text to describe the nature of the agreement, who is likely to be 
involved, over what time period it is effective, or any other pertinent information. 
 
The “Lead Stakeholder” (agency) is a pull-down to select from the list of Stakeholders defined on the 
Stakeholders tab. There can only be one selected - if more than one is really the lead then go back and use 
the Stakeholders tab to create a Stakeholder Group. Below the “Lead Stakeholder” a series of check boxes 
provides a way for other stakeholders to be identified. 
 

 
 
As shown above, the Stakeholders area has 3 buttons to help see just the “Selected” stakeholders, the 
stakeholders that are part of the selected architecture, or “All” of the stakeholders in the database. 

http://www.arc-it.net/
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Finally, when you are editing the regional architecture the Agreement can be associated with one or more 
projects that have been defined in this RAD-IT database. Right clicking in the “Projects” area will expand 
the list to allow the user to view more projects. Right clicking in the “Stakeholders” area works the same. 
Right click a second time to return the list to the smaller size. (This works in the same way as on other 
tabs.) 
 
This information can be output using the “Agreements” table that provides a number of sorting and 
include option settings. 
 

Agreements by Project or Interface 
You can now associate an agreement with a specific service package or interface. There is also an 
Autoselect feature to let RAD-IT create agreements for you based on your architecture.  
 

Autoselecting Agreements 
This feature, available as a button at the top of the agreements tab allows you to let RAD-IT look at your 
architecture and come up with a starting set of agreements – either based on the service packages or 
interfaces.  
 

 
 
Pressing the Autoselect button on the Agreements tab brings up a window with several options. On the 
left side you can check whether to add agreements that are supported by flows (the information flows 
listed on the Interfaces tab) or if you want to remove extraneous agreements.  
 

AutoSelect – Add 
If you have checked “Add agreements per options” left side of the AutoSelect screen then on the right 
side you can click Options to tell it whether it should … 

a) Create agreement(s) per stakeholder pair. 
b) Create 1 agreement per service package. 
c) Create 1 agreement for the entire project (blanked out if the regional architecture is selected). 

 
How does it do this?  This goes all the way back to the Inventory tab when you associated a stakeholder 
as the ‘owner’ of an element. RAD-IT now uses that information to see which stakeholders are involved 
in an interface or service package.  
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It also uses the other roles related to an element in order to create additional agreements like a 
Maintenance or an Operations agreement. 
 
So, for a new TMC we may have several stakeholders involved as shown below: 

 
 
The TMC with separate stakeholders identified for who Manages, Owns, Maintains, and Operates the 
center will result in 3 separate agreements when you select “One agreement per stakeholder pair: 

- A system Maintenance Agreement between the owner and the maintainer,  
- An Operations Agreement between the owner and managers, 
- And a System Usage agreement between the manager and operators. 

 

 
 
Once they are created and added to the Agreements tab you can customize and edit the title and 
description to better reflect how your region would describe these. Autogenerate will also add a generic 
description for the new agreements. 
 
For interface related agreements it looks at the stakeholders who ‘own’ elements on both sides of each 
interface in the architecture. If they are the same, then no agreement is necessary, such as when the State 
DOT is sending configuration data from its center down to its field equipment. On the other hand an 
agreement is needed if the State DOT is sharing control with another DOT center. The agreement types 
and the generic text are from ARC-IT’s Enterprise View. The Enterprise View in ARC-IT describes the 
relationships between organizations and the roles those organizations play within the transportation 
environment. Some agreement are needed for one organization to provide information to another; some 
agreements need to be defined in such a way that not only is information provided but an action is 
expected to take place with the information. These are among the agreements that ARC-IT will define and 
will show up when Autoselect Agreements is run. 
 
The ‘Agreement(s) per stakeholder pair’ option also adds agreements that are based on elements such as a 
Joint Operations agreement or a common element where multiple stakeholders have different roles with 
respect to a single element.  Another type of agreement is a Joint agreement where it is a Group of 
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Stakeholders that owns, operates, etc. a particular element.  These agreements will show up with a single 
stakeholder – the name for the group. 
 
For Service Package related agreements (second button above), RAD-IT looks again at the stakeholder to 
element assignments to see what stakeholders are involved in each service package and creates a Blanket 
Agreement for that service package. 
 
Once the agreements tab is populated you will see that the names, description, type, and stakeholders 
have all been populated. You can use the Lead Stakeholder pull-down to decide which stakeholder will 
take the lead in developing each agreement. 
 

TIP: Once autoselect has added agreements to the Agreements tab you will probably want to edit 
both the numbers and names of the agreement because they will be fairly generic. The numbering 
scheme is really simple: 1, 2, 3, etc. for each agreement by type in the file. The naming of the 
Autogenerated agreements can be fairly long and hard to recognize at first. Customize them based 
on the stakeholders involved and your regional needs. 

 

AutoSelect – Removal 
AutoSelect also lets you Remove agreements that are no longer necessary.  After the new agreements 
have been identified and added the next screen will list any agreements that it recommends removing. 
 

 
 
In the example above several agreements are listed as ‘potentially extraneous’, probably because 
interfaces between elements owned by these stakeholders were removed from the Interfaces tab.  Click 
Yes or No and the listing in the Agreements tab will change. 
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Service Package Agreement 

 
 

Interfaces Based Agreement  

 
 
For the Interfaces related agreements you can also press the “Applies to Interfaces…” button and see a 
new form pop-up that shows which information flows are associated with that agreement. 

 
 
Use the radio buttons at the top of the form to view the interfaces or information flows for just the 
currently selected agreement or click All Agreements to see all the agreements and which flows are 
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included. This allows you to control which specific information flows are ‘on the table’ when it comes 
time to negotiate an agreement.  
 
How do I use this?  You may decide that certain interfaces need to be hashed out at the individual 
information exchange agreement level between 2 parties but decide that other information flows can be 
left as part of a blanket MOU for the project. 
 

Elements Based Agreement  
In the screenshot below a Joint Management agreement is highlighted. 

 
 
In the Joint Management Agreement above the Lead Stakeholder and the Selected Stakeholder is the 
stakeholder group that was assigned the role of ‘Manages’ on the Inventory tab. 
 
Notice that for agreements like this that pertain to an element rather than an interface the button changed 
from ‘Applies to Interfaces…’ to ‘Applies to Elements…’. 
 
Click the ‘Applies to Elements…’ button to show the list of elements with which this stakeholder group is 
associated: 
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The Agreeme nts listing shows the elements that apply to the agreement selected on the Agreements 
tab.  It shows the list with checkboxes beside each element with Include All and Clear All buttons at the 
bottom. 
 
Another group of agreements related to elements rather than interfaces would be the Common Element 
agreements where multiple stakeholders have different roles with a single or common element.  A System 
Usage agreement is shown below: 
 

 
 
The example above is a System Usage Agreement that was driven by the owner and the operators for the 
Department of Public Works’ (DPW) GARLIC information system. 
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Toolbar Features 
Now looking above the tabs of the RAD-IT screen we’ll look at the other features available at the top of 
the screen from the “Home” menubar. 
 
Several tools are available to review and check your architecture as well as extend the basic set of ITS 
physical objects and flows provided by ARC-IT to support your unique needs. 
  

 
 
 

Clipboard Tools  
Now looking above the tabs of the RAD-IT screen we’ll look at the other features available, starting with 
the Clipboard at the top left of the screen from the “Home” menubar. 
 

 
 
These options work as in other tools:   

1. Select a word or phrase (for instance, in the description of an element).  
2. Click “Cut” (to delete the phrase from the selected field and copy it to the clipboard) or “Copy” 

(to copy the phrase elsewhere).  
3. Select another element, stakeholder, or similar item that allows a description or comment.  
4. Click “Paste” to insert the phrase in a user editable field. 

 
Keyboard shortcuts also work for these options, similar to other Microsoft tools as does Right-Click from 
a text box: 
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NOTE: These options on the “Edit” pulldown only work for window fields that may be edited. You may 
not select a portion of a report using “Edit => Copy” to insert into another document. You must save the 
entire report to a file, then open and manipulate it in the selected editor. 
 
 

Architecture Tools 
RAD-IT provides several tools to help you keep elements in sync, to add customized status values, extend 
the architecture model in terms of physical objects as well as physical information flows. 
 

Synchronizing Parent and Child Elements 
The Synchronize Elements tool is used to match up the functional objects and service package mappings 
between an inventory parent element and any element instances. The Inventory tab where element 
instances are created included an option for the new instance to inherit the attributes of the parent but that 
was only the attributes that are available on the Inventory tab.  

 
 
Once other aspects of the architecture have been captured like the services and functions then it may be a 
good idea to sync the parent and child elements. It may also be useful This window is accessed by 
selecting “Tools => Synchronize Elements” from the menu bar.  
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Select the elements to be synchronized: a Parent on the left side and an Element Instance using the pull-
down list on the right. Then decide which direction to synchronize the information with the radio buttons 
on the bottom-left of the window:  either to copy from the instance up to the parent or the other way 
around, to copy the parent’s attributes down to the instance.  
 
You can also decide if these changes should apply to just the current architecture or to all architectures in 
the file.  

NOTE: about the scope of Synchronization. Certain mappings are already file-wide, like service 
package mappings and Physical Object-to-Element assignments. This means that depending on 
the type of changes clicking or unclicking the "Only make changes to the current architecture" 
may have no apparent differences. Checking the “Limit” checkbox does impact the Service 
Package to Element assignments, as long as there are different parent element/element instances 
associated with different architectures. For instance, a region that has the parent element and 2 
projects that each have an instance of the parent. 

 
Once you have made the selections of what to synchronize and selected “Continue”, RAD-IT will look at 
the following areas to see what, if any, changes are needed:   

• Physical Objects 
• Service Packages  
• Functional Objects 

 
At each step if there are changes to be made, RAD-IT will show what changes are recommended and ask 
whether to make the changes. 
 
If you select “Yes” RAD-IT will confirm that the changes were incorporated and give an opportunity to 
continue to the next area of synchronization or to close the operation and return to the Synchronize 
Elements window. 
 
Once RAD-IT has completed synchronizing the service packages and functional objects it will return to 
the original Synchronize Elements window where another pair can be selected or select “Close” to return 
to the main RAD-IT screens. 
 
 

Customizing Status Values 
The window to add, modify, or delete a status value allows you to generate your own locally defined 
values as attributes for the timeframe of deployment for various parts of the architecture. Bring up this 
RAD-IT feature from the Tools area of the Home ribbon by clicking on the “Update Status” button. This 
option allows a region to define up to 7 local status values that will be available when creating or 
modifying an architecture or inventory element or center, mapping a service package to an element, or 
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customizing information flows for the open architecture. Status values are global to all architectures in the 
file, so the list will be available when working with any of the architectures. 
 
The initial status values that come with the RAD-IT tool are “existing”, “planned” (default), and “not 
applicable”. The names and descriptions of these values may be changed, but “not applicable” must 
remain last even if its name has been changed (the tool will not let this value be reordered). The others 
may be reordered by selecting the value, such as “planned”, then clicking on the “re-order” up or down 
arrow on the left. The default value may also be changed by checking or unchecking the “Make this the 
default Status value” checkbox on the right. 
 

 
 
To work with local status values: 
 

1. There are four buttons on this form: 
a. New - Create a new local status name. 
b. Delete - Delete a status name from the RAD-IT database. If this status value has been 

assigned to an architecture, element, service package, or information flow, then a window 
will popup stating how many items have been assigned to this status, and that he must 
reassign them before being able to delete this status value. 

c. Apply -- Save the changes made to the selected status value - save the new status value to the 
database. 

d. Cancel - Cancel the action. This option toggles with “Close” to close the window when no 
actions are pending.  

2. To create a new status value, select “New”. Enter the name and description of the new status 
value on the right-hand side of this screen, select the “default” checkbox if applicable, then click 
“Apply”. If you wish to cancel this change, select the “Cancel” button. 

3. To delete an existing status value, select the name of the status value from the list on the left, then 
click “Delete”. A verification screen appears asking if you wish to delete the status. Click on 
“Yes” or “No” to delete or cancel the operation. If this status value has been assigned to an 
architecture item, a different popup window appears asking you to reassign those items to another 
status value before the selected status may be deleted. Click “OK” on this window to return to the 
“Status” window. 

4. To modify an existing status value, select the name on the left, then enter the new name or 
(modify the) description on the right. The default status may also be changed. Click “Apply”. If 
you wish to cancel this change, select the “Cancel” button. 
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When you are on the “Inventory” tab and edit status values on the “Status” window, modifications, 
additions, or deletions that are made on this form, then saved (by selecting “Apply”), are immediately 
reflected in the status list box on the “Inventory” tab (and all other tabs and windows where available).  
 
 

Add Physical Objects 
In order to create a new user defined physical object, i.e., extend the architecture to add a subsystem- or 
terminator-like object.  

 
1. On the menubar, select “Add Physical Objects” from the Tools group of buttons 
2. Click the “New” button.  
3. After selecting “New” to create a new user defined Physical Object, enter the name and 

description of the user defined Physical Object. The Physical Object may be associated with 
existing elements in the architecture.  

4. Next, select the “Class” and “Type” of Physical Object that is being defined.  
5. Finally, click “Apply” to create the new user defined object, or “Cancel” to cancel the object 

creation. After “Applying” the change, the “Cancel” button again switches to “Close”. 
6. Click “Close” to exit from the window, or “New” or “Delete” to continue creating or deleting 

user defined physical objects. 
7. Now use the Inventory tab to associate this new Physical Object with new or existing elements. 

They will appear at the bottom of the list. 
 

TIP:  It is important to provide a good description for user defined physical objects since these are 
unique to your architecture. That way others that review the architecture or future maintainers of the 
architecture will know what this is. 

 
NOTE: You may notice that when selecting “New”, the elements button switches to the “All 
Elements” button. The reason that you cannot switch back to the “Related Elements” button is that 
there is a change to the related elements that is pending. This change must be applied before the other 
button can be selected. Both buttons are again available when the change is “Applied”, i.e., the new 
object is saved. This behavior is consistent throughout RAD-IT among all windows that include the 
All/Related buttons. 

 

Modifying User Defined Physical Objects 
If there are user defined physical objects already listed, they may be modified on the User Defined 
Physical Objects  window by selecting the object on the left, and changing the appropriate information on 
the right. There is also a “Delete” option to delete an existing user defined object. 
 

The “Kind” field in the “Physical Objects Attributes” section has two values: 
a. When creating a new user defined Physical Object, the “Kind” is set to “User Defined” and 

cannot be changed.  
b. After converting a RAD-IT file from a previous release version, certain Physical Objects 

(subsystems and terminators) in ARC-IT may have been discontinued between versions of 
the architecture. These are represented as “Discontinued”. You can choose to modify a 
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discontinued Physical Object. The result is a “User Defined” Physical Object (the “Kind” 
switches from “Discontinued” to “User Defined” when the Physical Object is modified). The 
User Defined Physical Object CANNOT be changed back to “Discontinued”. The additional 
category for user defined flows, “ARC-IT”, does not appear on the “User Defined Physical 
Objects” window. All discontinued Physical Objects from the conversion that you wish to 
keep are also loaded into the “User Defined Physical Objects” window. This gives you a 
convenient way to review and manage all extended physical objects using the same tool. 

 
 

Add Information Flows 
In order to create a new user defined flow, i.e., extend the architecture to add an interface that is not part 
of ARC-IT you enter the flow name and description as well as the directionality between subsystems, 
terminators, and user defined physical objects.  

 
Definition of the user defined flow also requires explicitly defining the type of source and destination 
physical object that is tied to the flow. This is required on the “Add Flows” window.  
 

 
 
The “Flow Kind” field in the “Flow Attributes” has three values: 

1. When creating a new user defined flow, the “Flow Kind” is set to “User Defined” and cannot be 
changed.  

2. After converting a RAD-IT file from a previous release version, certain flows in ARC-IT may 
have been discontinued between versions of the architecture. These are represented by a “Flow 
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Kind” called “Discontinued”. You can choose to modify a discontinued flow. The “Flow Kind” 
switches from “Discontinued” to “User Defined” when the flow is modified. All discontinued 
flows from the conversion that you wish to keep are also loaded onto the “User Defined Flows” 
form. This gives you a convenient way to review and manage all extended flows using the same 
tool. 

3. The third type of “Flow Kind” is called “ARC-IT”. See the notes below for more explanation. 
 
The “Build” logic will ignore “Discontinued” flows and “ARC-IT” information on the “User Defined 
Flows” window. Only user defined flows will be added to the “Interfaces” tab when you build the 
architecture following conversion. “Not applicable” unsupported flows will be removed from the 
“Interfaces” tab list during a “Build” (discontinued Physical Objects and flows will not be removed). We 
do not want to propagate discontinued flows or non-standard applications of ARC-IT flows on the 
“Interfaces” tab. 
 
To create a user defined flow: 

1. On the menubar, click “Add Flows”. 
2. To create a new user defined flow, click “New” and enter the name and description of the flow. 

Notice that the “Flow Kind” is now set to “User Defined”, as expected. 
3. Optionally, add an Alias for this flow and decide whether or not you want to apply it.  This is not 

typical for a user defined flow but it may be helpful to your audience. 
4. Next, map the user defined flow between architecture physical objects. The screen asks for source 

and destination Physical Object. These must be selected from the available list - they may not be 
typed into the fields. A user defined flow can connect two user defined Physical Objects, a user 
defined Physical Object with an ARC-IT Physical Object, or two ARC-IT Physical Objects. On 
the “Inventory” tab, the architecture Physical Objects are associated with architecture elements, 
so the new user defined flow is indirectly associated with these elements. These are shown later 
on the “Interfaces” screen. 

5. Choose which Functional Objects to assign to this new flow. 
6. Decide to which architectures in your file this user defined flow should be assigned.  You can 

choose “All” for the regional plus any and all project architectures or press the “Select” button 
and use the checkboxes to choose which architectures can use this flow. 

7. Next, decide if you want your user defined flow to replace an existing ARC-IT flow. After 
selecting a source and destination click the “Replaces” pull-down and choose from one of the 
flows that are currently defined between those physical objects. 

NOTE:  You can create more than one user defined flow to replace the same ARC-IT 
flow. When you do a build you will see both flows between the applicable source and 
destination pairs. This may be useful if you want to split a complex flow into multiple 
parts, e.g., basic data and advanced data. 

8. Click “Apply” to create the new user defined flow, or “Cancel” to cancel the flow creation. Then, 
click “Close” to exit from the window, or “New” or “Delete” to continue creating or deleting user 
defined (and discontinued) flows. After “Applying” this change, the “Cancel” button switches 
back to “Close”.  

9. Build the architecture again on the “Interfaces” tab to add the new user defined flow and its 
source and destination elements to the architecture and to the “Interfaces” tab. The new user 
defined flow will appear with the status of the elements to which it is connected, usually 
“existing”, “planned”, or a local status value. If the user defined flow appears as “not applicable”, 
then one or both of the elements to which it is connected may be associated with a service 
package that is “not applicable”. A “Conservative Build” may also result in the user defined flow 
being “not applicable”.  



171 

10. Visit the “Interfaces” tab to review/modify the connections around the new user defined flow. 
Use the “Flows” view of the “Interfaces” tab to select or deselect the new user defined flows 
associated with source and destination elements (these may be indirectly mapped to a new user 
defined Physical Object). 

 
The element to Physical Object mapping provides a level of abstraction above the user defined flow to 
Physical Object mapping. For instance, the Clatsop County Roadside Equipment element could map to 
both the ARC-IT ITS Roadway Equipment subsystem and a new user defined Physical Object called 
“Flood Monitoring System”. Both user defined flows associated with the Flood Monitoring System and 
ARC-IT standard flows associated with the ITS Roadway Equipment would be available on the 
“Interfaces” screen. 
 

NOTE:  Concerning the ARC-IT “Flow Kind”, in certain rare cases, you may have defined a user 
defined Physical Object or the associated flow in a previous release version of RAD-IT that now 
has the exact same name in RAD-IT as a new ARC-IT flow or Physical Object. During the 
conversion, the user defined flow with the duplicate name is converted to the ARC-IT flow, 
which works fine as long as the user defined flow is associated with the same source/destination 
entity pair as in the current ARC-IT. When this is not the case, the source/destination information 
for the ARC-IT flow is retained on the “User Defined Flows” form.  

 
When an “ARC-IT” flow is selected on the “User Defined Flows” form, you have very few options. You 
cannot convert the flow to “User Defined” and cannot alter any other attributes. Also note that the 
“Delete” command button changes to “Remove”, signifying that this button works differently with 
“ARC-IT” flows than with the other flows on this form. When you “remove” a flow, the flow is only 
removed from the “User Defined Flows” form, the national flow is still defined in the database and still 
included on the “Interfaces” tab unless you specifically tailor the flow out. In contrast, when you delete a 
“User Defined” or “Discontinued” flow, it is completely removed from the database. One way to resolve 
these identically named flows that are marked with “Flow Kind” of “ARC-IT” after the conversion is to 
simply recreate the flow in the converted architecture using a different name, on the “User Defined 
Flows” form. Then remove the original flow on this form. 
 
 

Flow Aliases 
A flow alias is a way to use a customized name for an information flow while retaining the mappings to 
the ARC-IT reference model for that flow.  For example, if you are doing a connected vehicle project to 
collect probe data from passing vehicles for surveillance purposes you may want to just show the term 
“BSM” for the basic safety message defined in the SAE 2735 standard rather than the full name of the 
ARC-IT information flow, “vehicle location and motion for surveillance”. 
 
From the Home menu bar, click on the “Flow Aliases” button.  See the Flow Aliases section in the 
Interfaces chapter of Help for more information. 

Review Tools 
RAD-IT provides several ways to review and check your architecture from the Review section of the 
Home toolbar.  

- Check Flows  
- Check Spelling  
- Review the Architecture  
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Checking Flows 
Available from the “Review section of the Home menubar, the “Check Flows” button on the Home menu, 
the window illustrates inconsistencies between related information flows in the current architecture. 
 
Flows can usually be associated with a particular information flow in the following ways –  

• Depends on (where one flow depends on the existence of another flow),  
• Interactive (where one side will expect feedback based on information provided) 
• Request/Response (typical control flow where a request triggers a response) 

  
The Check Flows tool allows you to view a list of inconsistencies between flows and information flows 
that are included in an architecture and allow RAD-IT to automatically reconcile issues with either the 
Interactive or the request/control flows and to remove identified discrepancies.  
 

  
 
On the “Related Flows” area at the top of the screen: 

1. Lists the flows that should be included in your architecture but aren’t (based on the defined 
Interactive or Request/Response relationships in the database) 

2. The “Include” and “Include All” options will add flows to the current architecture that may be 
necessary to support the included information flows. 

 
On the “Flows Included” section at the bottom, just the opposite happens: 

1. The “Remove” and “Remove All” options will remove information flows that are included in the 
current architecture but are supported by their related flows (listed above). 
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Another way to use RAD-IT is to use the Filters on the “Output => Filtering” window. The autoselect 
feature automatically selects all request/control flows associated with information flows that are included 
in the architecture. This will possibly save 20% of the time that is normally spent on the “Interfaces” tab 
selecting and customizing information flows. 
 

Spell Checking your Architecture 
A Regional or Project ITS Architecture is to be used by many stakeholders. It is important that as that 
architecture becomes circulated among a broad and diverse audience it must provide an overall level of 
quality that gives the readers confidence that the architecture is their architecture. The Spell Check feature 
provides a mechanism to review the cells within a tab that contain text and verify whether they are spelled 
correctly. 
 
Spell checking of the current tab may be initiated by selecting Spell Check from the Review menu. RAD-
IT displays a “Spelling” window very similar to that provided by Microsoft Word. Each cell on the tab is 
spell checked in turn and the user is given the opportunity to select from spelling suggestions or provide 
their own corrections. The spell check continues until all text on the tab has been spell checked or the user 
cancels the operation. User corrections may be added to a custom dictionary for future use. Individual text 
boxes may also be spell checked by right-clicking the text that appears to have a red squiggly line under 
it. 
 
You can also get to Spell Check by Right-clicking in a text box and selecting Spell Check 

 
 
If you click “Spell” that will bring up the Spelling dialog box that will give you more suggestions and 
give you the options to change the word to one of those or to something else.   
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This allows you to quickly review the architecture as you go. 
 

Local and Global Spell Check 
 
Another option is to check all of the spelling across the entire architecture.  At the top of the RAD-IT 
screen click the caret under the Spelling icon and choose “Global Spell Check”. 

 
That will check all of the text on all of the tabs at once. 
 

Dictionary Manager 
Lastly, you can add and remove words from your custom dictionary by clicking the “Manage Spelling 
Dictionary” icon at the top of the RAD-IT screen.  This will bring up a new window called the Dictionary 
Manager. 
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Here you see the custom words that have been added previously and remove them or you can add words 
to your custom dictionary by typing them into the space provided and clicking the Add button. 
 

NOTE: if you have both RAD-IT and SET-IT installed on your computer then this custom 
dictionary will be available to both tools. Words added to the dictionary in one tool will be 
available to the other tool.  Also, words removed from the dictionary in one tool will not be 
shown in the other tool. 

 

Architecture Checking / Review Tables 
 
There is a series of Tables that can be generated using the same process as other 
Output/Tables that are all about Reviewing Your Architecture.  
 

RAD-IT software lets the user have as much flexibility as possible and does not try to prevent the user 
from creating the architecture the way they want. However, as you work on one part of the architecture 
(say, adding or deleting flows) you could be introducing inconsistencies with other parts of the 
architecture (inventory or services). The Review section of the menubar has a shortcut to those tables.  
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There are 2 categories of reports – “Check Your Architecture” and “Region to Project Comparison” as 
shown below. 
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This screen works just as the Output Tables screen. Select the type of Check you want to run, select the 
Columns you want to include, and either save it to a file or open the Office application. Each of the 
reports has a hint or hovertext that will display to show you what the report does.  
 
See “Check Your Architecture Tables” below for a listing and description of the tables you can generate 
to help you debug issues with your architecture. 
 

Generating Outputs 
This section describes ways to use RAD-IT to generate outputs from your regional or project architecture, 
including diagrams, tables, documents, and web pages. 
 

 
 
 

Introduction to Outputs 
Once you have customized your architecture the development process is really complete. However, it is 
important to create outputs that represent the architecture and can serve as vehicles for transferring 
information to the stakeholders. The “Output” toolbar allows creation of diagrams, tables, web pages, and 
documents pertaining to the architecture created. 
 
From this menu you are able to produce these outputs for a completed or partially defined Regional or 
Project Architecture. Settings are available that control the data to be output and the format of each 
output.  
 
 

Data Filtering 
You may choose to filter the data that is output in selected diagrams, tables, and documents. The same 
filters also impact the Interfaces tab so that the impact of interface filtering can be previewed. These data 
filters will limit the types of interfaces to be considered, and should be used for large tables and diagrams. 
The filtered data will not appear on the outputs, but is still included in the architecture. The filters may 
include such types of data as human interfaces, acknowledgment or request flows, etc. 
 
The filters are identical for output tables, diagrams, and the “Interfaces” tab. There are four types of 
filtering:  “Physical Objects”, “Interconnects”, “Flows”, and “Service Packages”, and a fifth tab, 
“Summary”, that indicates if any of the filters are selected. 
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The four types of filters are: 

1. Physical Objects:  Sets filters that control the elements displayed in output tables, diagrams, and 
on the “Interfaces” tab. “Class” indicates subsystems and “Type” indicates Human, System, and 
the “Other System” type of objects which represent additional peer systems that usually lie on the 
periphery of a regional architecture. 

2. Interconnects:  Sets filters that control the types of interconnects that are displayed, including 
permutations of center, field, traveler, and vehicle interconnections. The RAD-IT interconnect 
filters are based on Source and Destination class because that is information that is available for 
all RAD-IT triples, including user defined triples.  

3. Flows:  Sets filters that control the information flows displayed in output tables, diagrams, and on 
the “Interfaces” tab. Deployment status (existing, planned, etc.) and type of flow (information vs. 
request flow) may be selected. 

4. Service Packages:  Sets a filter that limits output tables and diagrams to a single service package 
or service package instance, or all service packages may be displayed. 

 
The “Filters” window may be displayed in a variety of ways, from the “Output” menubar pulldown, the 
“Diagrams” and “Tables” windows, and by clicking the little arrow at the bottom of the Filter button on 
the “Filter” option on the “Interfaces” tab. Then to activate the filters just click the main part of the Filter 
button. These methods result in the same filters being applied to the tables or diagrams and on the 
“Interfaces” tab. A change to a filter in one place also changes it in the other windows.  
 
Checking the boxes on the Filters window will result in the physical objects, flows, or interconnects being 
selected. If the box is not checked, the items of that type will be deselected. Both “Apply” and “OK” save 
your filter settings to the database. “Apply” leaves the window open; “OK” closes the window. “Cancel” 
allows you to cancel out of the window without committing any filter changes to the database.  
 
Where multiple filters apply to a single Physical Object or flow, the software will filter pessimistically. 
That is, if any filter that you have selected (by leaving the box unchecked) applies to a Physical Object or 
flow, then this Physical Object or flow will be deselected on the “Interfaces” tab, or not appear on a report 
or diagram.  
 
NOTE: This may result in zero flows being displayed on the “Interfaces” tab, output tables, and 
diagrams. 
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Physical Object Filters 
The Physical Objects tab of the Filters screen lets you select or deselect the different Classes of physical 
objects as defined in ARC-IT: Center, Field, Personal, Support, Vehicle, and the ‘super-class’ known as 
ITS. You can also select and deselect the Types of physical objects to display: Human, Other System, and 
System. This could be useful to unclutter your diagrams to not include human interfaces.  
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Interconnect Filters  
The interconnect tab on the filters screen lets you select and unselect the interfaces to be shown on the 
interfaces tab or the outputs based on the class of the source and destination.  

 
 

Flows Filters 
The Flows tab of the Flows screen lets you choose whether to show just the Information flows or both the 
Information and the Request flows and filter by type of flow – system, human, or from an environmental 
terminator. This tab is also where you can narrow down to show the interfaces by their deployment status 
– existing, planned, etc. 
 

 



181 

 

Service Package Filters 
The Service Packages tab on the Filters screen lets you down-select and display the flows based on a 
single service package.  

 
 
As noted before selecting multiple filters may result in no flows being shown in either the Interfaces tab 
or the outputs. Check the Filters to see if something should be unchecked. 
 

Element Selection 
To control the number of elements displayed on the diagrams, set the element selection for a diagram. 
The element selections are identical for output tables, diagrams, and the “Interfaces” tab. This option is 
available in a variety of ways.  

• On the menubar, select “Output => Element Selection…”. 
• On certain output tables and diagram windows, and on the “Interfaces” tab, there is an 

“Elements” button that provides this option. 
 
The elements and their interconnections that appear on the “Interconnect” and “Flow” Diagrams may be 
customized in the following manner: 
 

1. To see all elements and all connections between them in the entire architecture, make sure all 
element boxes are checked on the “Output => Element Selection” window. The “Select All” 
option on this window may be used to easily select all elements. Select “OK” when finished then 
select “Preview” on the diagrams window to view the output.  
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2. To see only the connections between selected elements, select the “Elements” button on the 
diagrams window then make the appropriate element choices. If many elements need to be 
removed from the list, the “Clear All” option is available. Then select the required elements. 
Select “OK” when finished then select “Preview” on the diagrams window to view the output. 

3. When working with a Project Architecture, the “Project Elements” option is available. This will 
show only the elements that are in the project inventory when a particular project architecture is 
selected. For large architectures, it is difficult to tailor project unique elements when all elements 
are listed. This option applies to output tables, diagrams, and the “Interfaces” tab. This is not a 
toggle. If many elements have already been selected for a diagram or report, be careful not to 
select the “Project Elements” option, because it is not possible to return to the previous list except 
by using the “Select/Clear All” buttons and selecting the required elements. 

4. To see all connections in and out of certain selected elements, as well as the elements that they 
are connected to, use the “Show All” option on the “Elements Selection” window. Then, select 
the desired elements. “Preview” the diagram. If you are only interested in viewing the 
connections between selected elements, turn off the “Show All” option. If “Show All” is selected, 
all flows associated with the selected elements are included, even if the flows begin or end at an 
element that is not selected. This option applies to tables, diagrams, and the “Interfaces” tab.  

5. To see Communications Elements in your outputs, select the “Show Communications Elements” 
checkbox. New rows are added for the communications elements and a new column is added to 
distinguish between the Transportation elements and the Communications elements. 

 

Diagrams 

List of Diagrams 
Once you select “Output => Diagrams…” from the menubar, a main diagram dialog menu is displayed. 
From this dialog, one of the available RAD-IT diagrams can be selected.  
 
NOTE: If you are using a cloud-based or network based storage system like OneDrive or Drop Box that 
try to synchronize your local files over a network then you may get a message that you have a “Locked 
File Selected” and “The selected file appears to already be open in another application. Please close the 
other application so RAD-IT has exclusive access to the file.” If this happens, you can still close RAD-IT 
and your information is still stored. To avoid this message go into the settings for the file sharing 
program, e.g. Drop Box, and pause synchronization until you are done generating the diagrams. 
 
There are three types of diagrams that may be displayed or printed by the RAD-IT tool: 

1. Subsystem:  The “Subsystem” (Communications) Diagram for a region or project illustrates the 
methods that are used to communicate between the subsystems selected for that region or project. 
These include fixed-point to fixed-point, wide area wireless, dedicated short range, and vehicle-
to-vehicle communications. Only the ARC-IT subsystems and communications methods appear 
on this diagram. Terminators do not appear. 

2. Interconnect:  The “Interconnect” Diagram for a region or project illustrates the interconnections 
between element/stakeholder pairs selected for that region or project. This diagram captures the 
physical object interfaces with a single “direction-less” line.  

3. Flow:  The Information “Flow” Diagram for the region or project illustrates the flow of data 
between the element/stakeholder pairs selected for the region or project. The flow of data appears 
as physical information flows (one or many) connecting the elements to each other. The direction 
of the flow of data also appears between the information flows and the elements.  
NOTE: if Flow Aliases are applied – see Flow Aliases – then they will be shown on the flow 
diagrams. 
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Three different types of diagrams are available for the “Interconnect” and “Flow” diagrams: 

• Full Information Flow or Interconnect Diagram for the region or project. 
• An Information Flow or Interconnect Diagram that illustrates the connections surrounding a 

single element/stakeholder. Also called a “context” diagram. 
• An Information Flow or Interconnect Diagram that illustrates the connections between multiple 

(user selected) element/stakeholder pairs.  
 
 

Diagram Options and Buttons 

 
The “Interconnect” and information “Flow” diagrams include a feature to display or print a subset of the 
architecture, either the interfaces to a single element, or to multiple elements.  
 
Displaying thousands of connections may cause problems, both in the generation of the connections and 
in the display.  
 
Use the Filters and Elements buttons to control what is shown in the diagrams. See Data Filtering and 
Element Selection above for more information.  
 
The various options on the “Preview” diagram pulldown menus include: 

1. The diagrams may be displayed by selecting on the menubar:  Output => Diagrams… => 
<diagram name> => Preview.  

2. The diagrams being “Previewed” (“Subsystem”, “Interconnect”, and “Flow”) may be saved to a 
file by selecting on the “Preview” menu: File => Save. A popup window asks for the directory 
and file name where you want to place the diagram. The file can be saved in EMF, GIF, JPG, 
PNG, TIF, and BMP formats that may be input to any tool that reads this format (Visio, 
PowerPoint, etc.).  

3. The display of the “Interconnect” and “Flow” Diagrams may be zoomed in or out by using the 
“Zoom” option on the menubar of these “Preview” diagram windows. Several zoom options are 
available, from 50% to 400%.  

4. The diagrams may be printed to a connected printer by using the “Start => Settings => Printers” 
option to select or set up the printer on your machine. To print the diagram, select “File => Print” 
from any “Preview” diagram window.  

5. The “Preview” diagrams may be closed by using the “File => Close” option on these windows, or 
by selecting the “x” in the upper right-hand corner of the display window. 
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Information in Diagram Boxes 
On the “Subsystem” Diagram, you may click on a subsystem and see a list of all related elements for this 
subsystem in the region or project.  
 

 
 
The boxes on the “Interconnect” and Information “Flow” Diagrams contain the element and stakeholder 
names. For “Interconnect” diagrams, the lines are codified (e.g., solid/dashed and different colors) to 
distinguish between “Existing”, “Planned”, and local status value interconnections. Where an interconnect 
supports information flows with different status values, the interconnect is identified as the status value 
that is of higher priority, or nearer term. “Flow” diagrams include directed information flows and are also 
codified to distinguish between different status values.  
 
The placement of boxes on the “Interconnect” and “Flow” Diagrams:  The diagram layout algorithm 
positions the most connected block in the middle and then positions blocks in decreasing numbers of 
connections, spiraling outward. This algorithm reduces the number of crossed flows that would be plotted 
with an “alphabetical order” or other ordered diagram layout algorithm. 
 

Customize Diagrams 
You may choose to customize the information presented on the “Interconnect” and “Flow” Diagrams. 
Physical Objects and flows may be filtered or specific elements selected for the diagrams for the Regional 
or Project Architecture. The filters are the same for the “Interfaces” tab, diagrams, and tables. The shape 
and color of the diagram boxes and the line style and color may be changed via the Diagram “Settings” 
option. The “Subsystem Diagram” cannot be customized. 
 

Filtering Diagrams 
For the “Interconnect” and “Flow” Diagrams: 

1. To set the filters for a diagram, select on the menubar: “Output => Filters.” This may also be 
done directly on the “Diagrams” window for the “Interconnect” and “Flow” Diagrams:   
Output => Diagrams… => <Interconnect or Flow> => Filters  (button on the window). 
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2. To set the Element selection for a diagram, select on the menubar: Output => Element 
Selection…. This may also be done directly on the “Diagrams” window for the “Interconnect” 
and “Flow” Diagrams: Output => Diagrams… => <Interconnect or Flow> => Elements (button 
on the window). 

 
The elements and their interconnections that appear on the “Interconnect” and “Flow” Diagrams may be 
customized in the following manner: 
 

1. To see all elements and all connections between them in the entire architecture, make sure all 
element boxes are checked on the “Output => Elements Selection” window. The “Select All” 
option on this window may be used to easily select all elements. This window is also available 
under:  Output => Diagrams… => <diagram name> => Elements. Then preview the diagram:  
Output => Diagrams… => <diagram name> => Preview. 

2. To see only the connections between selected elements, select the “Elements” button on the 
diagrams window then make the appropriate element choices. If many elements need to be 
removed from the list, the “Clear All” option is available. Then select the required elements. 
Select “OK” when finished then select “Preview” on the diagrams window to view the output. 

3. To see all connections in and out of certain selected elements, as well as the elements that they 
are connected to, use the “Show All” option on the “Output => Diagrams…” window. Then, 
select the desired elements on the “Output => Diagrams… => <diagram name> => Elements” 
window. The elements may also be selected first on the “Output => Element Selection” window, 
then “Show All” selected on the diagram window. Preview the diagram. If you are only interested 
in viewing the connections between selected elements, turn off the “Show All” option.  

 
CAUTION – Filters can be set so that your outputs may end up blank or empty. If you are trying to 
generate an Inventory table and it is blank it could be because you have a filter set to filter out all objects 
that are in your architecture.  
 

Diagram Settings 
For the shapes and lines in the “Interconnect” and “Flow” diagrams, you may change the appearance of 
element boxes and the lines representing the status values.  
  
To change the shape of an element box in either the “Interconnect” or “Flow” diagram: 

1. Select the type of diagram: “Interconnect” or “Flow” on the “Diagrams” window.  
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2. Select the “Settings” option.  

    
3. When changes are made to the right-hand side attributes for a shape, they are immediately 

displayed in the shapes on the left but are not saved until “Apply” or “OK” is selected. 
4. On the Shapes tab, the default for Transportation elements with defined functions is a rectangle 

with blue title bar while the default for Transportation elements with no defined functions is a 
rounded yellow rectangle with rounded corners. The default for Communications elements is a 
oval-type shape, known as a sausage. These can be changed by clicking the radio button for the 
box on the left and select from the “Shape Style” list box on the right.   

5. The “Include Stakeholder Title” checkbox is checked by default for subsystems (elements with 
defined functions). If the stakeholder name is not required at the top of the element boxes in the 
diagrams, uncheck this box. However, it will then not be possible to recognize the stakeholder 
names in the diagrams. It is recommended to leave this box checked.  

6. The colors selected for the background and text of the “Title” and “Body” of the element boxes in 
the diagrams may be changed. Click on the colored box and change the color from the palette that 
appears. These colors may be changed separately for elements with and without defined 
functions. Select each box on the left and change the colors on the right.  

7. You can also click “Use ARC-IT Colors” and the boxes will be colored based on the class of the 
element to closely match the colors used in the service package diagrams used on the 
http://www.arc-it.net/ website. Orange for Field, Green for Centers, etc.  If you click that then 
you can’t customize the colors for the Title or Body. 

8. Click “OK” or “Apply” to accept the change, or “Cancel” to abort the change. NOTE that you 
may make changes to both shapes and lines before selecting “Apply”. “Close” toggles to 
“Cancel” once editing begins. 

 

http://www.arc-it.net/
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To change the line style in either the “Interconnect” or “Flow” diagram: 
 

1. Select the type of diagram: “Interconnect” or “Flow” on the “Diagrams” window. 
2. Select the “Settings” option. 
3. On the “Lines” tab, all status values are listed on the left with a default line style and color on the 

right. 

 
4. To change a line style and color: 

a. Select the status value on the left (“Existing”, “Planned”, or a local status value created 
via the “Tools => Update Status” option on the menubar). Each status value is 
represented by a different line style. 

b. Select a line style from the list box on the right. 
c. Click on the “Line Color” box on the right and select a color from the color palette that 

appears. 
5. Click “OK” or “Apply” to accept the change, or “Cancel” to abort the change. 

 
 

Batch Generation of Diagrams 
The “Batch” feature of the “Diagrams” window allows you to generate many diagrams with a single 
command. For example, all interface diagrams or context diagrams for every element may be generated in 
batch mode based on user specified parameters. All Service Package diagrams can also be printed in 
batch mode. 
 

1. Select the type of diagram to be batch generated: “Interconnect” or “Flow” on the “Diagrams” 
window. 
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2. Select the “Batch” option. 

  
NOTE: it will display the number of diagrams to be generated just above the Elements button. To 
reduce the number of diagrams you my use the Elements window to down-select some of them or 
go back and use the Filters. 

3. To select the inventory elements to be included in the diagrams to be batch generated, select the 
“Elements” button, choose the elements, click “OK”. These will be the elements that define the 
context or interface diagrams that are to be printed. If all elements are selected, then there will be 
a diagram printed for each. 

4. Specify whether context diagrams or interface diagrams are to be batch generated.  
a. “Context Diagrams” show the interfaces between one element and all other elements.  
b. “Interface Diagrams” show the interface between a single pair of elements. 
c. “Service Package Diagrams” show the interfaces pertaining to a particular service 

package. 
d. “Project Architecture Diagrams” show all of the interfaces pertaining to each project 

architecture in the file.   
5. Select “Print” to print the diagrams. 

a. Select the “Print All” option. 
b. The “Print” option will display a “Print” dialog box listing available printers and initiate 

batch printing of all diagrams of the selected type. 
6. Select “Save” to save the diagrams to a file. 

a. The “Save” option allows you to select a directory where the diagrams are to be stored.  
b. A “Short” or “Long” name style may be selected for the file names of the saved files, or a 

“Prefix” to the long or short names may be entered.  
c. The short names are typically a number, while the long names represent the inventory 

element names in the architecture.  
d. All name styles identify whether the file contains a context or interface diagram. 
e. Select the “Save All” option. 
f. The files are saved in “.emf” (Enhanced Metafile), GIF, JPG, PNG, TIF, or BMP format.  
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g. If a file already exists, you are given the option to replace or not replace the existing file. 
7. “Close” closes the “Diagram Batch Processing” window. 

 
TIP: Use the Saved Diagram Size pull-down and change to “Scale – Medium” or “Scale – Large” when 
generating large complex diagrams. This will create more legible outputs when importing them into a 
Word document or presentation. 

Tabular Output 
RAD-IT includes tools to let you generate reports or outputs in tabular form that you can use to generate 
documents or presentations about your project. These Output Tables provide a means to output the 
content from the main tabs into tabular formats that can be imported into other Microsoft Office 
automation products. 
 
NOTE: If you are using a cloud-based or network based storage system like OneDrive or Drop Box that 
try to synchronize your local files over a network then you may get a message that you have a “Locked 
File Selected” and “The selected file appears to already be open in another application. Please close the 
other application so RAD-IT has exclusive access to the file.” If this happens, you can still close RAD-IT 
and your information is still stored. To avoid this message, go into the settings for the file sharing 
program, e.g. Drop Box, and pause synchronization until you are done generating the tables. 
 
 

Output Tables Window 
From the Outputs tool bar, click Tables to bring up the Output Tables window.  
 
Click the 1st pull-down to Select Table. You can traverse through the categories to find the report you 
want. 
 
In the 2nd area select from the Available Columns which will vary depending on the table selected in the 
first step.  
 
Use the left arrow to select individual columns to include (they will then move to the Selected Columns 
table). You can also use the double left arrow to include all the columns. 
 
The Filters and Elements buttons work exactly as they do on the "Interfaces" tab and the Diagrams 
screen. They are only activated for tables for which they would apply, e.g. inventory, interfaces, etc. 
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The Output Tables window has a pull-down to select the type of table to be generated. Once the selection 
is made, the left side of the screen is populated with the fields that can be included in that table. The user 
can select the arrow or multi-arrow buttons in the middle of the window to move fields to be included in 
the output. The user can also use the lower two arrow buttons to remove fields that aren’t desired for the 
table. 
 
The next step is to decide whether to save the output to a file or to open the application. You must have 
the application (e.g. Word, Excel) installed on your computer to create output for Word or Excel. The 
final step is to press one of the buttons to create the output either to Word, Excel, or a text based comma 
separated variable (CSV) output. 
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The checkbox to “Roll up multiple rows into a single row” is used to combine cells together such as 
combining all Elements together that are mapped to the same Physical Object. This can save space and 
help tell the story easier. You can decide what’s best for what you are trying to do. 
 
If there is nothing to display for a particular table then a message will appear in the left area of the Tables 
screen saying there is nothing to display.  
 
For example, if I have not done anything on the Planning Tab to create Objectives or Strategies when I 
select the Planning table the message in the Available Columns area will say, “The planning tab includes 
no defined items for the current architecture.” 
 

CAUTION – “What if my tables are blank?” Filters and Element Selection can be set so that your 
outputs may end up blank or empty. If you are trying to generate an Inventory table and it is blank 
it could be because you have a filter set to filter out all objects that are in your architecture. Click 
the Filters and Elements buttons to see what is set and make adjustments. 

 
 

List of Output Tables 
The tabular reports included on the “Tables” screen consist of the following: 
 

Summary / File Info Tables 
Summary information about the regional and project architectures contained in this file. 
 

• Architecture Summary –This table presents summary information for all Regional and Project 
Architectures that have been defined in the file. This table has settings for displaying the 
description of each architecture, entries made on the “Start” tab for each architecture, and the 
region (US, Canada, EU, Australia) for which the architecture applies. 

 
• Architecture Summary Details – builds a table of statistics about the architectures in your file, 

regional and any projects.  For each architecture it lists the number of unique service packages, 
service package instances, elements, information flows, possible flows shown on the interfaces 
tab, interconnects, agreements, user defined physical objects, user defined flows, and the number 
of projects in the file. 
 

• Change Log - A record of the changes made to the selected architecture as recorded by the user. 
Each entry includes timestamp, name, version, and change description. 
 

• Status Values – List of status values (existing, planned, etc.) defined for this file. 
 

• Stakeholder Summary – list of stakeholders in each architecture 
 

• Inventory Summary – list of inventory elements in each architecture 
 

• Service Package Summary – list of service packages in each architecture 
 

• Filter Settings – list of the current filter settings for the file 
 

The 4 summary reports are good when you have multiple architectures in your file and you want one table 
that shows them all.  
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TIP: This may work best if you don’t include every column. For instance, a summary table may 
be too long if you try to include the description fields.  
 
TIP: To generate a listing of Service Packages by project include the Architecture Type, 
Architecture, and Service Package. Then in the output filter out or remove the rows pertaining to 
the Regional architecture. Then use the Architecture and Service Package column for your final 
report. See an excerpt below from the Marinara sample file: 

Architecture Service Package 
MCDOT Saucelito Traffic Coordination TM07: Regional Traffic Management 
MCDOT Traffic Monitoring Expansion 
Project 

TM01: MCDOT Traffic Monitoring Upgrade 

MCDOT V2I Safety Initiative SU01: Connected Vehicle System Monitor 
MCDOT V2I Safety Initiative SU04: Map Management with Connected Vehicles 
MCDOT V2I Safety Initiative SU08: Security and Credentials Management 
MCDOT V2I Safety Initiative SU10: Field Maintenance 
MCDOT V2I Safety Initiative TI07: In-Vehicle Signage 
MCDOT V2I Safety Initiative VS05: Curve Speed Warning 
MCDOT V2I Safety Initiative VS08: Queue Warning 
MCDOT V2I Safety Initiative VS09: Reduced Speed Zone Warning / Lane Closure 
TOMATO PM04: Regional Parking Management 
TOMATO SU04: Map Management 
TOMATO TI01: Broadcast Traveler Information 
TOMATO TI02: Personalized Traveler Information 
TOMATO TI04: Infrastructure-Provided Trip Planning and 

Route Guidance 
TOMATO TI05: Travel Services Information and Reservation 

 
 

Stakeholder Topics Tables 
Information about the stakeholders – groups, organizations, enterprises, and the institutional activities that 
are associated with this architecture. 
 

• Planning – Planning elements such as objectives and strategies, performance measures, and their 
relationship to the architecture. This table can be configured to show Service Packages mapped to 
the objectives/strategies. 

 
• Stakeholders - Shows identified stakeholder names, descriptions, and associated elements. If 

there is a contact name, it should be included in the description in order to be displayed in the 
report. This can also identify stakeholder groups and their members.  
 

• Roles and Responsibilities – Shows the roles and responsibilities, i.e., an operational concept, 
based on service package choices defined for the currently selected architecture. This table 
displays information in line with CFR 940. This can be sorted in various ways: by stakeholder 
name, with a description of the roles and responsibility area, or by displaying the service 
packages associated with the area, listing members of a stakeholder group, and listing available 
status values. 
 

• Agreements - Listing the set of Agreements defined on the “Agreements” tab for the current or 
selected architecture. These are agreements between stakeholders or agencies, and are added as 
attributes of the architecture in line with CFR 940. Each agreement is defined by a number, type, 
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title, status, lead stakeholder, and may include associated stakeholders, elements, and service 
packages.  
 

• Interfaces to Agreements – Listing the mapping between the Agreements and the Information 
Flows. Applicable if the interface level agreements were created. 
 

 

Physical Components & Services Tables 
Physical objects, elements, service packages, and included functionality that make up the architecture. 

• Inventory – Presents all identified inventory elements with associated physical objects, 
stakeholders, and projects, including user defined physical objects and flows. It shows the 
element inventory for the selected architecture, either project or regional. If in a Project 
Architecture, the entire Regional Architecture inventory does not appear.  
 

• Services - Shows ARC-IT service packages, your service package instances, and their selection 
status related to the initial projects and services. This will appear differently for Regional and 
Project Architectures. You can also include Comments and a list of the Included Elements. 
 

• Needs - Shows the need areas and needs defined for the currently selected architecture based on 
the service package choices and the customizations made for the architecture.  

 
• Requirements – Report showing the functional objects and requirements defined for the 

currently selected architecture based on the element mappings and service package choices. 
Requirements are defined by a number, text, status, source (ARC-IT or user-defined), an optional 
comment, and their mappings to physical and functional objects. A higher-level listing of the 
functionality of the elements in a region or project can be created by simply including the 
functional objects and their descriptions for each element. 
 

• Functional Objects - Shows the functional objects defined for the currently selected architecture 
based on the service package choices. The functional objects directly relate to the Functional 
Objects in ARC-IT.  
 

• Physical Objects - Subsystems and terminators from ARC-IT that are included in the selected 
architecture along with any user defined physical objects. This also lets you include the type, 
class, kind, domain, and description of the physical object. 

 
• Inventory to Service Package Comparison - Compares Inventory and Service Package 

selections and identifies possible Inventory and/or Service Package selection gaps. This identifies 
ARC-IT and user defined physical objects and inventory elements that are not assigned to any 
Service Package, and physical objects and elements that are not assigned to a Service Package 
where it is possible to include them. 
 

• Needs to Requirements – Provides a traceability table that maps the User Needs to the 
Functional Objects and Requirements.  
 

• Service Readiness – Provides the relative readiness an architecture’s service packages for wide-
spread deployment based on the collection of issues related to each of the flows in that service 
package.  NOTE: this can be a large complex output and may take a long time to generate. 
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TIP: Don’t generate this for an entire regional architecture; this output is more useful for small 
focused projects.  Only include the flows when you need to know which interfaces are driving 
certain issues. 
 

Interfaces & Standards Tables  
Interconnects, flows, and standards activities for the current architecture. 

• Interconnects - Shows the interconnected elements and their status values for the interconnects 
in the current architecture, similar to the “Interconnect” diagram. It can also show what 
communications elements the interconnect is using. 

 
• Information Flows - Shows the permutations of element interfaces included and not included in 

the architecture with the source, destination, and their status value. This table can also show the 
Service Package instances associated with a flow. Use the Filters and Elements button to select 
what is included.  If you want to create a report that shows the flows for each service package 
simply reorder the fields so that Service Package comes before the source, destination, and flow 
name. 
 

• User Defined Flows - lists the custom or locally defined flows created by a RAD-IT user as 
opposed to the flows imported from the ARC-IT reference architecture.  This output can include 
the flow Name, the physical and functional object assignments for the source and destination, and 
whether it replaces an existing ARC-IT sourced flow. 
 

• Flow Definitions - presents the information flows and definitions for this architecture, including 
an alias and whether that alias has been applied. 
 

• Communications Solutions per Interface - Identifies the selected communications solution for 
each interface in the architecture. It includes the information flow triple info, solution name, 
solution description, and issues that are assigned at the triple solution (or profile) level. Can be 
filtered by filters/element selection to make it easy to subset. 
 

• Communication Solution Details - Presents the detailed definition for each communications 
solution associated with the current architecture. It identifies the included standards and all issues 
assigned at the standard, profile, or solution level. As a companion output for Comm Solutions 
By Interface, it can also be filtered by filters/element selections so the two outputs will be 
consistent. Issues include things like the standard is not yet complete or doesn’t include key 
interfaces pertinent to the architecture. These issues are assigned a severity score and the lower 
the score the better or more feasible it will be to deploy using that standard or communications 
solution. 
 

• Physical Standards - Presents all relevant physical standards and their relationship to the current 
architecture. Some standards have been identified that are mapped to physical and/or functional 
objects. This output will let you see the Element to which those standards apply. 
 

NOTE: Users should refer to the Communications View on the ARC-IT website for more 
information about communications solutions and the standards they include. For projects, users 
should use SET-IT that will then generate a set of Comm View solutions that can be customized to 
meet the project’s needs. 
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Check Your Architecture Tables 
Identify inconsistencies and potential errors in your architectures 
 

• Inventory to Service Package Comparison - Conflict resolution report that compares Inventory 
and Service Package selections and identifies possible Inventory and/or Service Package selection 
gaps. This report identifies ARC-IT and user defined physical objects and inventory elements that 
are not assigned to any Service Package, and physical objects and elements that are not assigned 
to a Service Package where it is possible to include them. 

 
• Discontinued Flows - Report showing the discontinued information flows between elements that 

are included in the converted Regional and Project Architectures. This is a report created during 
the conversion of an architecture from a previous version of RAD-IT. The report is available 
during the conversion and from the list of standard RAD-IT reports. There are no settings for this 
report except report title. 

 
• Unsupported Flows - Report identifying Regional and Project Information flows that are not 

supported by current element to entity mappings in the current version of ARC-IT or user defined 
flow definitions. This report shows the flows that are ignored by the conversion (i.e., they are 
included “as is” in the converted architecture), but that must be addressed by you in the converted 
architecture. For example, information flow “ElementA => asset restrictions => ElementB” 
would be an unsupported flow unless ElementA is mapped to the “Asset Management” 
terminator and ElementB is mapped to MCMC. Many existing architectures include these flows 
on the “Interfaces” tab because element to entity mappings have changed over time. As part of 
the conversion from previous versions, unsupported flows that are “not applicable” are 
automatically removed. There are no settings for this report except report title. 

 
• Interfaces to Inventory Inconsistencies – Report identifying the list of inventory elements that 

are not connected to any other inventory elements in the architecture as well as interfaces on the 
Interfaces tab where the source or destination (or comm element) are not included on the 
Inventory tab. This report includes the architecture in question (regional or one of the projects), 
the element and the issue. 

 
• Unconnected Stakeholders - Report identifying the list of stakeholders that are not associated 

with any inventory elements in the architecture. This report has settings for displaying a 
description of each stakeholder and listing members of a stakeholder group. 

 
• Suspicious Information Flow Status Values – Report identifying where information flows with 

older status go between elements with newer status. Say, for example, you started an architecture 
where everything was planned or future but then as you or your stakeholders were reviewing the 
information flows you started to see places where things already existed so you started changing 
the status of the flows to Existing. Because you hadn’t gone back to the inventory tab to change 
the status of the elements that were sending or receiving that information you created a situation 
where elements that haven’t been developed yet are already sending/receiving information. This 
is illogical and this report will point that out. 

 
• Suspicious Request / Response Status Values – Report identifying request information flows 

that have a different status values than a corresponding response flow. This report has a setting to 
display the available status values. 
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• Planning Gap Analysis – Report identifying the differences between the service packages 
associated with planning (on the planning tab) and service packages (on the services tab) included 
in the architecture. There is a setting to display the description. This includes parent service 
packages or instances. 

 
• All Potential Needs – Report identifying all needs associated with all of the service packages in 

the architecture; use the Applicability column to see which are assigned to the project. 
 

• Elements with complex Physical Object mapping – Report identifying potential issues with 
inventory elements that are mapped to too many or to the wrong physical objects. For instance, a 
center mapped to both a Traffic Management Center and a piece of field equipment. 

 
• Suspicious Project Status Values – Report identifying inventory elements, service packages, 

functional objects, and information flows that have newer status values than the current project 
architecture. This report has a setting to display the available status values. 
 

• Physical Object - Functional Object Inconsistencies – Report identifying elements with 
mappings to functional objects (Functions tab) that are not consistent with that element’s physical 
object mappings (Inventory tab) 
 

• Service Package - Interface Inconsistencies – Report that calculates the percentage (%) of 
information flows, called ‘triples’, that are included in each service package. Triples is the 
shorthand way of saying source/destination/information flow combination. Use this report to 
debug places where you may not have as many elements as you want from the Services tab 
participating in that Service Package or if you did not include as many flows on the Interfaces tab.  
 

Triples Included% Service Package 
0 SU04: Map Management 
10 TI02: Personalized Traveler Information 
13 TI01: Broadcast Traveler Information 
20 PM04: Regional Parking Management 
25 TI04: Infrastructure-Provided Trip Planning and Route Guidance 
34 TI05: Travel Services Information and Reservation 

 
TIP: Focus on the top rows of the table since those are most likely places where you have an 
issue with your element mappings to the service package. This report will be sorted from 
lowest percentage to highest. 
 
For example, if you gone through the first pass of most of the tabs and run this report it might 
show a traveler information package with only 10% of the flows included. This may be a clue 
that you may have forgotten to include a source of data like at transit center. On the other 
hand you may look through the report and review your architecture and decide you wanted it 
that way. This report just arms you with the information to make that decision. 

 
• Needs to Requirements Mapping Issues – Report identifying issues with mappings between 

needs and functional requirements (Functions tab) - Needs that aren't covered by any 
Requirements or Requirements that don't trace to any Needs. 

• Need Areas to Service Package Mapping Issues – Identifies need areas where the mapped 
service package is not included in the architecture. 
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Region to Project Comparison Tables 
Identify inconsistencies and potential issues between the Region and any projects in your file 
 

• Compare Inventory – Identifies any inventory differences between the regional and project 
architectures. 

• Compare Services (Service Packages) – Identifies any service package differences between the 
regional and project architectures. 

• Compare Needs – Identifies any differences in the needs defined between each of the projects 
and the regional architecture. 

• Compare Communications Solutions – Identifies differences in communications solutions 
selected for the same information flow triples between the regional architecture and any of the 
project architectures. It also lists information flow triples that are assigned to one or more projects 
that are not included in the region. 
 

 

Documents 

Document Output - General 
RAD-IT includes a method of generating a Word Document directly from the data stored in the RAD-IT 
database. This feature supports documents for regional architectures or project architectures.  
 

TIP:  Select the architecture on the Start Tab before selecting the Output/Document… feature. 
 
The user has the option to create the document or the diagrams or both. The user then can select Elements 
to be included or to set Filters just as with other outputs. The user then selects Setup to tell RAD-IT how 
to generate the document. Then the Create button will run the generator and the View button will launch 
the document in Word. 
 

NOTE:  One must have Microsoft Word installed on their computer for this feature to work. 
 

NOTE: If you are using a cloud-based or network based storage system like OneDrive or Drop 
Box that try to synchronize your local files over a network then you may get a message that you 
have a “Locked File Selected” and “The selected file appears to already be open in another 
application. Please close the other application so RAD-IT has exclusive access to the file.” If this 
happens, you can still close RAD-IT and your information is still stored. To avoid this message 
go into the settings for the file sharing program, e.g. Drop Box, and pause synchronization until 
you are done generating the documents. 

 
 

Document Output – Setup and Creation 
Much like the Web Page generation setup, the user has access to a number of settings that determine the 
content and format of the document that is created. 
 
The General tab is used to specify where the document will be created, the document filename, and the 
Microsoft Word template file that will be used for document creation. Once the directory is identified for 
document creation, select Apply to create the directory structure and enable access to more detailed 
settings on the Content tab.  
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The General Tab provides access (use the Edit button) to the “ArchDocTemplateRegion.dot” template 
that is used by RAD-IT to control the format and layout of the created document.  
 
RAD-IT Document generation uses bookmarks to know where to insert content from the database into the 
document template.  RAD-IT will analyze the template and determine if it is out-of-date or has some 
issues with the bookmarks used to generate the document. The user may be warned that they need to click 
the Restore Template button on the Document Setup window before generating the document.  The 
Restore Template button is also useful anytime you no longer wish to use the customizations that have 
been and you want to go back to a clean version supplied by RAD-IT. 
 

 
The “Use Template” checkboxes are used to determine whether the content in the RAD-IT Database 
should be used or the content in the template should be used for things like the title page and chapter 
headings. 
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Before you create the document, you should edit the introductory text in each chapter of the template and 
update the document styles as desired. As you edit this template, you should maintain some minimal 
conventions and be particularly careful not to delete or modify the bookmarks and tags that RAD-IT uses 
so that the template can still be used by RAD-IT. See introductory text in the template itself for more 
information. The template is the place to insert introductory and boilerplate text and images that provide a 
gentle introduction to the architecture details that will be inserted by RAD-IT. Including the content in the 
template will allow you to minimize manual effort in subsequent document creations as the architecture 
details change over time, but the introductory content stays the same. 
 
The Content Settings has a tab on the left for each area of RAD-IT that then would generate a section in 
the Word document. There are optional settings to decide what to include in each section. The user can 
also decide to include some information in the Appendix – for instance, some architectures may generate 
pages and pages of tables that may be best to put into an Appendix. 
 

 
 
Once setup is complete, select the Create button for either the Document body, the diagrams or both. Just 
as with the Web Pages generation, you may want to create the document body content in one step and the 
diagrams in another step. A large architecture may take a while to generate. Once it is complete, you can 
click View to launch Word to view the resulting file or start Word separately and open the document. 
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NOTE: if you choose to include interface diagrams in your document it will automatically perform a 
Batch generation of the diagrams and insert PNG formatted graphics into the document. If you clicked 
Apply Alias on the Flow Aliases screen then only the alias name will appear. 
 
RAD-IT Output Document Settings now support having multiple documents per RAD-IT file so you can 
have a document for your regional architecture as well as different documents for your project 
architectures.  If you do want to use multiple documents make sure you save the documents with unique 
names. 

Web Pages 

Web Pages General Information 
RAD-IT will automatically create a set of preformatted hypertext (web) pages that can be used to build a 
website to display a regional architecture. This hyperlinked set of web pages includes pages for each 
aspect of the regional ITS architecture that is defined in RAD-IT including Stakeholder information, an 
inventory of transportation systems, services, functional objects, interfaces, communications solutions 
information, and ITS project information. The user has the capability to customize the pages with their 
own agency logos, contact information, and can tailor the content of the pages to meet their needs. When 
hosted on a website these pages make the regional ITS architecture definition available to transportation 
professionals in an interactive, user friendly format. RAD-IT can only create web pages for a Regional 
architecture – not a project architecture. 
 

NOTE: If you are using a cloud-based or network based storage system like OneDrive or Drop 
Box that try to synchronize your local files over a network then you may get a message that you 
have a “Locked File Selected” and “The selected file appears to already be open in another 
application. Please close the other application so RAD-IT has exclusive access to the file.” If this 
happens, you can still close RAD-IT and your information is still stored. To avoid this message 
go into the settings for the file sharing program, e.g. Drop Box, and pause synchronization until 
you are done generating the web pages. 

 
 

Creating Web Pages 
The Web Pages window is arranged as follows:  

• Create – the top left area has 3 options to click to create varying levels of detail:  
o Top-Level Web pages 
o Detailed Web Pages 
o Diagrams 

 
This allows the user flexibility in managing how the web pages are built. Early in the life of a project you 
may not be ready to show all the details but you want to go ahead and develop the basic screens so your 
stakeholders can see what the end product will look like once the details are done. At this early stage they 
can still see the basic list of Stakeholders, Inventory, etc. Later, you can generate the Detailed Web Pages 
that pull more information out of the RAD-IT database, including the pages for each inventory element, 
services, and interfaces. Lastly, the Diagrams can be built that bring in all of the context and interface 
diagrams and attaches them to the proper place in the hypertext. 
 
It is recommended that the first time through the web page generation process, you should create only the 
Top-Level Web Pages to quickly generate pages that you can review. Make sure the look and feel is right, 
then go back and generate the Detailed pages, then go back and add the Diagrams. 



201 

 
NOTE: If you choose to include diagrams in your web pages it will automatically perform a Batch 
generation of the diagrams and insert PNG formatted graphics into the appropriate web pages.  If you 
clicked Apply Alias to any flows on the Flow Aliases screen then the alias will be used on the diagrams 
instead of the original flow name. 
 
Features on the Web Pages Window: 

• Status – below the Create area is a status box that tells you what process is being performed. 
This is helpful since it may take a while to generate the web pages for a typical architecture. 
This will let you know what pages are being built. 

• Progress – colors in the bar below the status window from left to right to represent the 
overall progress of the build operation. 

• Setup button – establishes the general settings and preferences for how and where the pages 
are built and what they will look like. 

• Create button – initiates the creation of the web pages, pulling in the necessary data from 
the RAD-IT database and putting them into the proper files based on the settings entered 
during Setup. 

• View button – launches the initial welcome page for your new architecture in your default 
web browser (e.g. Chrome, Microsoft Edge, Mozilla Firefox). 

• Close button – returns to the main RAD-IT window. 
 
 

Web Page Setup 
To start generating web pages, RAD-IT needs some basic information. You can configure RAD-IT to 
control the colors and fonts used, the nomenclature, the types of pages that are generated and the content 
to be included on each page, and more. Advanced users can use templates to augment the Hypertext 
Markup Language (HTML) that is included in each page and supply their own user defined pages.  
 
Click on Setup from the Web Pages window and a form opens with the following tabs: General, Content, 
Style, and File Locations.  
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Web Page Setup – General Tab 
The General Web Page Setup information tab is used to capture information that applies to all web pages. 
An essential piece of information is the folder where all the web pages and supporting files will be saved. 
Clicking on the Browse button will bring up a windows explorer window to find and select the folder to 
use. If the folder is not empty, RAD-IT will determine that a new subfolder should be created to keep 
everything organized. In that case a popup window will appear once the user hits Apply. 
 
The Web Site Title will be included at the top of every web page. In general, users will probably want to 
enter the name of their region, e.g. “Marinara County” in our example; but it could be anything.  
 
NOTE – the title is limited to 40 characters to ensure it fits best in most web browsers. 
 
The Extension pulldown allows the user to pick either htm or html or type another extension to use. The 
default htm is almost always going to work but some web server environments require a certain extension 
which can be selected/entered here. 
 
The Web Site Contact Information area allows the user to include a Name, email address, and phone 
number that will appear at the bottom of the main web page. This may be important – perhaps putting the 
name and contact information for the maintainer of the architecture or a contact for the web administrator 
for the agency. 
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Web Page Setup – Content Tab 
The Content tab of the Setup Window allows the user to select the web pages to be included (defaults to 
all). Selecting one of the pages on the left, brings up the information for that page on the right. For 
instance, by selecting Scope, you can confirm the scope as entered on the Start tab in RAD-IT and check 
off the various features to include on the Scope page: Architecture description, geographic scope, etc. 
 

 
 
Just as on the Inventory and other RAD-IT screens if the user wants to add a page to be generated with 
the website, click on the All Web Pages tab and use the check boxes to include other pages and hit apply. 
Once the user has selected a page on the left, its attributes can be modified on the right.  
 
Web Page Setup – Content Tab Attributes: 

• Order: changing this will reorder the listing of the pages on the main menu panel for the 
architecture pages. For example, if you wanted Stakeholders to come after Inventory you would 
change Stakeholders to “4” and Inventory to “3” – hitting Apply each time. 

• Menu name: allows the user to change the name that appears on the main menu panel for the 
architecture pages. For example, changing “Roles and Responsibilities” to “R&Rs”. 

• Page Title: changes the title that appears at the top of that page. 
• Overview: is the text that appears at the top of the page. 
• Use Template box: allows the user to direct RAD-IT to ignore this text box and pull the 

information from the html files that can be edited separately. The File Locations tab would be 
used to specify the Template files and where they are located.  

• Options: depending on the page there may be options to include extra data either in tables or 
diagrams on this page and you can check or uncheck the options and hit Apply. 
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User Defined Web Pages? 
The user can also select “New” to create a custom web page for the project. For example, you could 
create a “Documents” page that includes links to all your architecture documents. In most cases, when 
you are creating a user defined page, you will want to use a template page to define the HTML for the 
new web page. Alternatively, you can enter all of the HTML right in the Overview text box.  
 
User defined pages may also reference an external page that is not created by RAD-IT. In this case, the 
user would select the “External” page type and then specify the URL that will be used to access the page. 
The user must enter a complete valid URL (e.g., http://www.YourAgencyName.xxx).  
 
 

Web Page Setup – Style Tab 
The Style tab of the Setup Window allows the user to specify the colors of the background, text, and other 
features pertaining to the look-and-feel of the web pages.  
 
The Select Web Page Area shows what the basic web page will look like based on the colors, graphics, 
and fonts selected on the rest of the tab. To change the color of the web page banner, start by clicking on 
the top bar of the Web Page area on the left of the window then click the colored box next to Background 
and a pop-up screen will appear to change the color. Similarly with the Text color and borders. To change 
other areas of the screen like the menu bar, click on the menu area on the left side and then change the 
background and text colors on the right. 
 
Use the check box beside Use Background Graphic to include or exclude a background image that 
appears in the upper left of the banner/main page. The default image that is provided with RAD-IT is a 
RAD-IT Icon, but this image should be replaced with a more relevant image by most users. You can find 
where this image is stored using the File Locations tab. The graphic extension pull-down allows the user 
to change the graphic file format to png, gif, or jpg. Note that png and gif file formats can have a 
transparent background which will allow the background color to show through the transparent area of the 
image. The options at the bottom allow the user to select how large the web pages should be in terms of 
pixels – 800 being the default but 1024 and 1280 are also available. The font family can be changed as 
well. Arial/Helvetica is the default and should be left as is for most applications. 
 

Web Page Setup – File Locations Tab 
The 4th tab is the File Locations Tab and is generally for reference purposes except a web administrator 
may want to know where the files are located to be able to make specific changes for the environment. 
This tab shows where on the computer the web pages, templates, style sheets, and images are stored. 
When you select one of the files, RAD-IT provides a description of the file and the file location. The 
templates, images, and style sheet may all be edited to customize the web pages that RAD-IT produces.  
 
You can select “Restore Default” to restore the selected file to the default RAD-IT content. Before 
overwriting the existing file, RAD-IT will confirm that you want to overwrite his file with the default file. 
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Additional Topics 
This section discusses some advanced topics that cut across how RAD-IT is used and how to construct 
and maintain a regional ITS architecture. 
 

Relationships between Elements, Stakeholders, and Tabbed Windows 
The following discussion involves associations (relationships) between elements and between elements 
and stakeholders, and concerns the relationships between the tabbed windows in RAD-IT. In other words, 
changes made on the “Inventory” tab may or may not be reflected after a “Build” on the “Interfaces” tab 
or on the diagrams. An example follows. 
 
On the diagrams, the upper, grayed portion of each box displays the stakeholder name, and the lower part 
of the box indicates the element name associated with that stakeholder. 
 
For example, a user creates two Toll Collection elements associated with a single stakeholder. These 
elements both use the Payment Administration Center physical object from ARC-IT. Because the 
underlying Physical Architecture includes a terminator called “Other Payment Administration”, the two 
toll elements will be connected to each other. In previous versions of Turbo and prior to Version 4.0 of 
the National ITS Architecture (April, 2003), they could have been connected by creating a user defined 
flow between these two elements. If these elements were traffic management elements (centers), however, 
they would be connected to each other because of the underlying ARC-IT Physical View (“Other Traffic 
Management” is a terminator, and there is a physical flow that connects the TMC to “Other Traffic 
Management”). 
 
If you then generate a Traffic Management Center (element) on the “Inventory” tab (using the same or a 
different stakeholder as the two toll elements), then associates this with the Payment Administration and 
Traffic Management Center Physical Objects and selects the “Regional Traffic Control” service package 
(on the “Services” tab), the new traffic element will be connected to each of the two original toll elements 
after building the architecture. This also occurs because of the underlying physical connections in ARC-
IT. 
 
If you then remove the Payment Administration Center subsystem from the associations for the traffic 
element on the “Inventory” tab, re-building the architecture will make no difference to the “Interfaces” 
tab or the “Interconnect” diagram. Payment Administration information flows remain connected to this 
traffic element and are not removed by re-building. You must go to the “Interfaces” tab and uncheck the 
“Include” box so that these flows are no longer connected to the traffic element in the current Project or 
Regional Architecture. This also changes the status of these flows to “Not Applicable”. Then, the 
“Interconnect” diagram will no longer connect the traffic element to the two toll elements. 
 
 

Extending the Architecture 
See the “Add Physical Objects” and “Add Flows” sections under Architecture Tools above but here are 
some other thoughts concerning extending the ARC-IT physical view. 
 

General Comments on User Defined Extensions in General 
An item that cannot be represented by an ARC-IT physical object or information flow may be included in 
the Regional or Project Architecture as a “user defined physical object” or “user defined flow”. Any 



206 

element not associated with an ARC-IT physical object can be associated with a user defined physical 
object in the Regional or Project Inventory. As an example, this feature can be used for unique items, 
such as “red-light cameras” or “flood control”, which are not ARC-IT physical objects. 
 
There are two types of locally defined items: 

• “User defined physical object” - with characteristics similar to an ARC-IT subsystem or 
terminator, these have flows associated with them and may be mapped to any element in the 
architecture. 

• “User defined flow” - with characteristics similar to an ARC-IT flow. A user defined flow must 
be hooked to the architecture by establishing relationships with other elements and physical 
objects within the architecture. The user defined entity may be defined first, then the flow that 
references it.  

 
GUIDELINE:  A user defined flow may be connected to a user defined Physical Object or to an ARC-IT 
Physical Object (subsystem or terminator). Their names must, however, be distinct and separate from 
ARC-IT names. 
 
GUIDELINE:  User defined Physical Objects and flows may be added to an architecture at any time 
before or during the customization process, while on any tab. However, in order to see the user defined 
flows on the Interfaces tab, a “Build” must be done to add them to the architecture. These extensions may 
then be reassigned or modified on the Interfaces tab.  
 
Remember that when creating locally or user defined objects and flows that this information is not 
mapped to any standards. This mapping may be required and will be a manual process of defining 
customized standards and mappings to the user defined flows. This process of defining custom standards 
along with other communications profiles is done in SET-IT. 
 
 

Connecting the Local Physical Object to the Architecture 
If adding a locally defined Physical Object to the Regional or Project Architecture (for example, a “flood 
monitoring” element, or “snowplows and maintenance vehicles”), you may do this in various ways. First, 
look at the “Inventory” tab to display a list of all existing Physical Objects in the architecture. This list 
also includes user defined objects that have already been created. Pick a name not on the list to call the 
new user defined Physical Objects. Then, define this Physical Object in one of several ways: 
 

1. If some of the data elements for the new system element exist in ARC-IT, you may connect to 
these subsystems, terminators, and information flows for this capability from ARC-IT. Do a 
“Build” in order for the new user defined Physical Objects and flows to appear during the 
customization step. This allows for reuse of ARC-IT flows. You may also add additional user 
defined Physical Objects and flows that are not in ARC-IT during this step. 

2. OR, you may add an ARC-IT service package, then select certain flows that apply to the new 
capability, and add the additional user defined Physical Objects and flows that are not in ARC-IT. 
Do a “Build” in order for the new user defined Physical Objects and flows to appear during the 
customization step. The tool allows a user defined flow to connect to an ARC-IT 
source/destination Physical Object (subsystem, terminator). However, an ARC-IT flow cannot be 
used in a way that is inconsistent with the Architecture.  

3. OR, If there are no data elements within ARC-IT that match the functions of the new capability or 
user service, you may add all the data elements for the new capability, connect them to user 
defined Physical Objects and flows, then “Build” and “Customize” on the “Interfaces” tab. 
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It is your responsibility to ensure that new locally defined physical objects (similar to ARC-IT subsystem 
and terminator physical objects) and user defined flows (similar to ARC-IT flows) do not conflict with the 
existing ARC-IT physical objects and information flows. 
 
 

Iterations through the RAD-IT Tool 
Certain steps during the architecture creation process do not have to be done in any order. For example, 
you may re-enter the Inventory Generation step (“Inventory” tab) at any time during the process after 
creating the initial element inventory.  
 
Where applicable, the tool will allow iterations in the process of defining a Regional or Project 
Architecture. You may create an inventory of elements associated with subsystems and terminators, map 
to service packages, and create an initial list of information flows (through the “Build” step). You may 
then reassign an element to a new subsystem (“Inventory” tab), terminator (“Inventory” tab), or service 
package (“Services” tab), select other service packages (“Services” tab), select new information flows 
(“Interfaces” tab), or de-select information flows (“Interfaces” tab) from his Regional or Project 
Architecture. 
 
Where applicable, i.e., where process steps are sequential, if a previous step has not been completed, the 
tool will not allow you to continue until it has completed successfully. This does not apply to the iterative 
steps in the process. In most cases, a “Build” must be done before any outputs can be generated (tables or 
diagrams). If there is no data for an output table or diagram, then a popup window will appear saying this. 
The steps below must be completed before data may be available for these outputs. If a “Build” has not 
been done, there is no data available for the “Interfaces” window, and this table will be blank. The tool 
finds all situations possible to prevent an empty window from appearing, or from allowing you to attempt 
an option that must be preceded by some other option. 
 
The following is a list of processes or steps in RAD-IT and what prerequisite processes or steps (if any) 
are associated with them: 
 

1. You can characterize service packages before selecting an element inventory (characterizing 
subsystems and terminators) in the Regional or Project Architecture. Service packages may be 
selected. However, elements must exist in order to associate the service packages to elements, so 
after entering new elements on the “Inventory” tab, you must return to the “Services” tab to 
associate the elements to the selected service packages. 

2. You will be able to return to the “Inventory” and “Services” tabs and remove service package 
associations (i.e., disassociate them from the architecture) if you have only previewed the 
uncustomized architecture in the “Build” step (before answering “Yes” to the final question about 
adding the flows to the architecture and to the “Interfaces” tab). After completing the “Build”, if a 
service package association is removed from the architecture, the associated interconnects and 
flows must be deselected manually on the “Interfaces” tab. “Build” is an additive function - it 
does not remove anything from previous builds or customization. 

3. The customization step for the architecture cannot be executed before subsystems or terminators 
(or service packages) have been characterized from ARC-IT. There will be no source or 
destination elements, and no information flows defined between them. 

4. Once you enter the “Interfaces” tab and begins to customize the architecture, you may return to 
the “Services” tab to change service package associations, or you may return to the “Inventory” 
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tab to change element/stakeholder mappings. A new “Build” will pick up any new element and 
flow selections, but not change his customization. 

5. The “Extend” step to add user defined physical objects or flows to the architecture cannot be 
executed before subsystems, terminators, or service packages have been characterized from ARC-
IT. 

6. The “Extend” step for the architecture can be executed before or after the customization step. If 
after, then a “Build” should be done before “Customize” on the “Interfaces” tab to pick up any 
new user defined flows. 

7. The “Merge” step (i.e., the “Project to Region” option on the “Start” tab) can be executed once a 
Project Architecture has been defined in the open database file (“Build” the project before 
“Merging” it into the Regional Architecture). This step may be used to initially define a Regional 
Architecture from an existing Project Architecture. To do this, simply create an empty Regional 
Architecture and return to the Project Architecture that is to be merged. 

8. The “Standards Activities” output table for the architecture cannot be generated before 
subsystems, terminators, or service packages have been characterized from ARC-IT, and a 
“Build” has been completed (answer “Yes” to the last question about completing the “Build”). 

9. The “Standards Activities” report for the Regional Architecture can be executed before or after 
the customization step. 

10. The “Interconnect” Diagram for the architecture cannot be generated before subsystems, 
terminators, and service packages have been characterized from ARC-IT. Information flows are 
required from the Service Package analysis to generate the “Interconnect” Diagram. 

11. The “Interconnect” Diagram for the architecture can be generated before the customization or 
extend steps. 

12. The “Flow” Diagram for the architecture cannot be generated before subsystems, terminators, and 
service packages have been characterized from ARC-IT. Information flows are required from the 
Service Package analysis to generate the “Flow” Diagram. 

13. The “Flow” Diagram for the Architecture can be generated before the customization or extend 
steps. 

14. The “Project Inventory based on a Regional Architecture - Element Inventory” step cannot be 
executed before a Regional Architecture has been defined. The Regional Architecture may or 
may not include a Project Architecture. 

15. The “Extend the Project Architecture to include additional parts of an existing Regional 
Architecture” step for the Project Architecture cannot be executed before subsystems, 
terminators, or information flows have been selected from an existing Regional Architecture. 

16. The “Extend beyond the Regional Architecture” step for the Project Architecture cannot be 
executed before subsystems, terminators, or information flows have been selected from an 
existing Regional Architecture.  

17. The customization step for the Project Architecture cannot be executed before subsystems, 
terminators, or service packages have been characterized from ARC-IT or selected from an 
existing Regional Architecture. 

18. The “Extend” step for the Project Architecture cannot be executed before subsystems, 
terminators, or service packages have been characterized from ARC-IT or selected from an 
existing Regional Architecture. 

19. The “Standards Activities” report for the Project Architecture cannot be created if no information 
flows have been identified from ARC-IT or selected from an existing Regional Architecture. 

20. The “Interconnect” Diagram for the Project Architecture cannot be generated before subsystems, 
terminators, and service packages have been characterized from ARC-IT or selected from an 
existing Regional Architecture. Information flows are required from the Service Package analysis 
to generate the “Interconnect” Diagram. 

21. The “Flow” Diagram for the Project Architecture cannot be generated before subsystems, 
terminators, and service packages have been characterized from ARC-IT or selected from an 
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existing Regional Architecture. Information flows are required from the Service Package analysis 
to generate the “Flow” Diagram. 

22. The additional RAD-IT tabs that bring the architecture in line with the CFR 940 and FTA Policy 
on ITS Architectures and Standards may be populated at any point during development of a 
Regional or Project Architecture. These functions include: 

• Defining the operational concept for the architecture, i.e., adding role and responsibility 
areas to the architecture based on service package choices. 

• Assigning functional objects to all elements in the architecture based on service package 
selections. 

• Selecting the ITS standards used in the architecture. 
• Defining a list of agreements between stakeholders for the architecture. 

 

Managing Subsystem Permutations 
When an uncustomized architecture is initially generated in RAD-IT, it is possible for all valid [source 
element / information flow / destination element] triplets for that architecture to be created. These triplets 
include all possible permutations of source/destination pairs based on ARC-IT and will typically number 
in the thousands for an actual Regional Architecture. Many of these triplets will not be selected in the 
final customized architecture. The task of “deselecting” possibly thousands of these irrelevant triplets is 
very time consuming. 
 
The RAD-IT tool will identify and remove many of these extraneous permutations of subsystem 
interfaces. However, the software does not have enough information to generate a perfectly tailored 
architecture based on the Physical Object and service package mappings that you generate. Some must be 
removed manually. 
 
Extraneous permutations are defined as sets of interfaces that do not have the same stakeholder. Some of 
the interfaces defined by the architecture rarely span multiple stakeholders. For example, the Traffic 
Management Subsystem to Roadway Subsystem interface normally represents intra-agency 
communications. This class of interfaces has been identified as having “product interoperability” in ARC-
IT. For these interfaces, RAD-IT must only select triplets by default that represent communications 
between elements that are owned or operated by the same stakeholder.  
 
Some connections are resolved by the tool, where others may be impossible to resolve and will have to be 
done manually. The tool will assist you to the extent possible with resolving permutations. You may also 
view the list of subsystems, terminators, and information flows on the “Interfaces” tab to determine which 
were included because of the permutation problem and should be deleted. 
 
You may display a permutation report that lists the permutations that were created during the initial data 
entry. This is actually a portion of the regional and project output tables on the “Output => Tables” 
pulldown menu (“Regional Architecture”, “Project Architecture”, and “Additional Integration Options” 
reports for both the Regional and Project Architectures). [A “Build” may be required before generating 
these reports.] 
 
You must then do a “Build” and customize the architecture on the “Interfaces” tab. On the “Interfaces” 
window, you will be asked for element name with the option to look at “All”. “All” will include a 
“Connect” and an architecture “Flows” view for all interconnections between elements, and all 
information flows in the architecture. All subsystems may be connected to all subsystems through the 
source and destination elements and flows listed. This must be corrected on this screen. Interconnects 
may be defined at the element level, e.g., TMC to RS connections.  
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On the “Interfaces” tab, it is recommended that you look at the “Connect” view first and remove 
extraneous permutations there before examining the architecture “Flows” view and deciding which 
information flows should be removed. However, you may look at the “Flows” view first then continue 
with the “Connect” view. You will be able to move from interconnect to flow or from flow to 
interconnect views during the customization process. 
 
You generate an uncustomized architecture when the system inventory and service package mappings 
have been completed to your satisfaction. This is the only time that the permutation filters will be applied. 
Because this generation process is somewhat different between Regional and Project Architectures, the 
permutation requirements are addressed differently by the tool in the two cases.  
 

Regional Architecture Permutations 
As the final step in the uncustomized Regional Architecture generation process in the “Build” step, the 
tool will attempt to deselect all flows that connect different stakeholders on the identified interfaces. This 
process does not deselect an information flow if it has been manually selected or customized already. In 
the general case, this should never occur since this query will be run as part of the uncustomized 
architecture generation process. 
 

Project Architecture Permutations 
In the uncustomized Project Architecture generation process in the “Build” step, the valid triplets are 
added to the Project Architecture by the tool. Invalid permutations are identified exactly as they were 
before, and the entries are deleted from the Project Architecture by the tool. Also, there is no need to 
“deselect” the flows in the Regional Architecture since these flags are not set by default when a new 
uncustomized Project Architecture is generated. In this case, a delete query is executed by the tool that 
will delete the references to “stakeholder spanning” flows in the Project Architecture.  
 
 

Working with Large Architectures 
The following are a few general guidelines for developing large architectures. See the Architecture Use 
tab of the ARC-IT website for more information about how to develop a Regional Architecture. 
Depending on the amount of space, running speed, and other parameters of your machine, VERY large 
architectures may begin to degrade the system performance. There are also maintenance issues with 
large architectures – a region will spend many weeks customizing a very large architecture on the 
Interfaces tab. There are ways to minimize the time spent on this tab. 
 
1. The following describes several ways to deal with architectures of many hundreds of interconnects 

and thousands of information flows.  
 

The Problem: Large architectures (e.g., including more than 50,000 information flows) are very 
cumbersome to work with in RAD-IT. Even simple manipulations on the Interfaces tab (e.g., 
switching from “Connect” to “Flows” view) cause substantial delays. Performance issues occur 
during the “Build” and “Customize” steps, and when generating the reports and diagrams. For 
instance, the “Standards (Interface)” output table may take 20 minutes to generate, and consist of 
hundreds of pages. The “Interconnect” and “Flow” Diagrams would be difficult to generate without 
problems. The scale of architectures of this size makes them unmanageable. If you only spend 10 
seconds reviewing each flow, one person month would be spent on the Interfaces tab to review and 
tailor an architecture of 50,000 flows.  
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Suggested Solution #1: The RAD-IT Architect should look for ways to reduce inventory/architecture 
size by developing general elements that represent many similar local systems. For example, rather 
than enumerating the 30 local city police and fire dispatch operations in a region, one or two elements 
can be identified that represent (or combine) all 30. The same may be done for an architecture that 
includes 20 different municipal traffic centers – they can be combined into one or two elements 
depending on how unique each one is. You really do not want to create a region with a table of 
60,000 flows that must be maintained! Diagrams must be filtered to avoid problems building and 
displaying the diagram.  
 
GUIDELINE: When working with a large architecture (over 10,000 flows), general elements should 
be developed in the inventory that represent large numbers of centers or systems, such as a single 
element that combines several Traffic Management Centers. 

 
Try to keep inventories less than 100 elements and know there will be trouble if the inventory 
exceeds 150 elements. This is an easy rule of thumb to apply but you also have to look at the mix of 
elements that are being added (e.g., try not to add more than one roadway element per center). 
Architectures that exceed 150 elements and 10,000 flows will be difficult to maintain, not easily 
understood by the average stakeholder, and impossible to plan with.  
 
Suggested Solution #2: An addition recommendation is to develop large Regional Architectures using 
center subsystems only. These are the primary connections of interest at a regional level. Vehicle, 
field, or traveler elements will mostly be connected to a center that has control over them. With 
regard to focusing on Center to Center interfaces, there are tools in the National ITS Architecture that 
help with this focus, since these also tend to be the “regional interoperability” interfaces in the 
architecture. There are filters to filter out certain types of interconnects, for example, only view center 
to center interfaces and filter out the rest. The regional interoperability class of interfaces also 
includes other interfaces with regional scope, such as the signal priority/preemption interfaces that are 
also good topics for inclusion in the Regional Architecture. Diagrams must be filtered to avoid 
problems building and displaying the diagram.  
 
Suggested Solution #3: Large Regional Architectures could be developed using a hierarchical multi-
tiered approach similar to the regional and statewide architecture discussion above. 
 

2. There are also limits to the number of flows that can be represented in and out of an element box on 
the “Flow” Diagram (a large “Interconnect” Diagram can present the same problem). In some cases, 
the element box expands to include all flow connections (typically at the middle of the diagram, 
where the boxes with the most connections reside). In other cases (typically at the edge of the 
diagram), the boxes do not expand and flows may be dropped, or attached to a single line. One limit 
to the number of information flows seems to be around 87 flows between elements.  
When these problems begin to occur during the plotting (generation) of large interconnect or flow 
diagrams, a message will appear warning the operator that the diagram may contain overflow errors. 
The user may either continue to plot the diagram, or abort. 
 
Suggested Workaround #1: If your “Interconnect” or “Flow” Diagram runs into a plotting or 
connection limit, you should break up the diagram into two or more diagrams using the element 
selection and/or filtering options. 
 
Suggested Workaround #2: For correcting the plotting problem of a very large diagram: If there is a 
display problem on the diagram screen and many letters seem to be run together (e.g., flow names 
appear to overlap), the diagram may be saved to a file and imported into Microsoft PowerPoint. In 
PowerPoint, select the diagram and “ungroup” it. The font problem should fix itself. The font can be 
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resized for better readability. Be aware that when importing the diagram into PowerPoint, there may 
be certain lines that must be redrawn or moved, if the diagram in RAD-IT contained many plotting 
problems. When the diagram is ungrouped in PowerPoint, some additional lines may appear that 
should be deleted near the element boxes. The architecture flow names may also appear with boxes 
around them when printed in black and white. These are some of the issues to be aware of when 
converting your RAD-IT diagrams into PowerPoint. It may be a lot of work to correct the converted 
diagram. First, try to filter out elements or flows, or select fewer elements and their connections prior 
to generating the diagram in RAD-IT. If this does not work, PowerPoint or Visio may be an option. It 
is suggested that you wait to spend the time editing the drawing on the final deliverable product so 
you do not find yourself having to throw away your work. 
 

3. When working with large architectures, do not define elements for personnel and system operators 
since there is no standard for them (example: TMC to Traffic Operations Personnel).  
 

4. Also, do not define a description field containing single or double quotes since certain export 
facilities (from the RAD-IT reports) or editors may misinterpret these characters.  

 
5. One other item to be aware of when working with large architectures is the size of the temporary file 

called “<archname+date+timestamp>.radit” that is built by RAD-IT when working with a Project or 
Regional Architecture grows while working on the architecture. The user file may be compressed by 
saving the file. However, the only way to compress the temporary file is to exit and re-enter RAD-IT. 
When a “File => Save” is done, this temporary file is NOT restored to a small size. The size of the 
temporary file is a function of the number of flows in the architecture. There may not be enough 
space in your machine to handle a “Save” of this file. If a message appears saying “Save failed”, you 
must compress this file by closing RAD-IT, opening the “<archname+date+timestamp>.radit” file in 
Microsoft Access and using the “Tools => Database Utilities => Compact & Repair Database” 
option. This will not be possible if Access is not available on your PC.  

 
For this reason, we have the following guideline:  
 
GUIDELINE: When working with a large architecture, you should Save and Save Often, AND exit 
and re-enter RAD-IT (suggestion – every half hour). This will ensure that the temporary file that is 
generated during RAD-IT sessions stays at a manageable size. 
 

How do I know if I have the current version? 
Go up to the menubar and click “File” and then “About”. There you will see a window showing the 
versions of RAD-IT and the underlying databases that is being used from ARC-IT to build your regional 
and project architecture. It should match the version listed on the ARC-IT website (http://www.arc-it.net/) 
under the Architecture Resources / Tools page and it includes the contents of the README file listing 
any version specific information to consider. 
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